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Module 1 - Intro 

Video: Welcome and Overview 

Cindy: Hi there. Welcome to Microsoft Word 2016. My name is Cindy and I’m going to help 

walk you through these series of videos as you go through this Microsoft Word 2016 course. I 

wanted to take a few moments and just introduce myself and tell you a little bit about what to 

expect as you go through these videos. 

My background is that I’ve been a Microsoft Office trainer for probably almost 15 years now and 

I’ve taught everything all the way back to Office 97, I believe. So I’ve got a lot of experience in 

teaching this and I think you’re really going to like this new version of Microsoft Word. 

So just so you’ll know what to expect as you go through. We’re going to start at the very 

beginning. I’m not going to start over anyone’s head. So if you do have a little bit of experience 

then hopefully this will tell you why some of the options are set the way they are and especially 

if you’re self-taught a lot of times you don’t know the things that you don’t know. So it’s very 

helpful to walk through a course like this if you can. We’re going to be going through and I’m 

going to show you how to create documents. You’re going to learn how to save them. You’re 

going to learn how to edit documents. You’re going to do all kinds of things as far as document 

are concerned. And I’m also going to show you how to work with templates and put some 

graphics in your documents and those types of things. So we’ve got a lot we’re actually going to 

cover in here. Go ahead and get a pen and paper, just kind of sit back and walk through these 

videos.  

As you go through each one there’s going to be a practice exercise at the end. And also a little 

quick Q&A just to make sure you’re okay with the big concepts. Once you get through with 

those just go ahead and move on to the next video and take your time. If you need to review one 

feel free. 

The really cool thing about learning Microsoft Word techniques is that when you move on to 

Excel or other programs on your computer you’ll already know how to do some of these 

different things that we’re going to be talking about. So go ahead and sit back like I said and let’s 

walk through this together. And I will see you shortly. 
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Video: What’s New in Word 2016 

Cindy: Welcome to the second section of Module 1 where I want to go through and talk to you 

about what’s new in Word 2016.  

Now obviously if you’ve never used Word before then it’s all going to be new to you. But if you 

have used Word in the past then you’ll want to know what some of the new options are. So let 

me show you a few of those right now. 

One of the first things you’re going to notice in all of the Microsoft Office products is they have 

this little option called Tell Me and you can see right here when I click that I can tell Word what 

it is that I’m trying to do. So let’s say that I’d like to insert a picture but I don’t have a clue where 

to go. I’m going to type in Insert Picture and it’s going to come up with all of the options related 

to pictures right here and I can click on the particular one that I’d like to work with. So in this 

particular case I clicked on Insert Picture and it’s taken me to where my files are on my computer 

so I could search for that picture and choose that file. So I’m going to go ahead and close that. So 

that’s one that a lot of people like. 

Also the Sharing is a lot better in Office 2016 now. Right up here on the top right you’re going to 

see the Share option here. And what this allows you to do is if you wanted to go ahead and store 

your document online at OneDrive or if you have a SharePoint server then you can share it with 

all your colleagues or other people that you’d like to see the file and be able to work on it at the 

same time with you. The way this works is that you can see each other’s changes to the 

document as they actually happen, which is really kind of cool. After you save the document 

online you just click Share to generate a link or an email invitation. When your other teammates 

open the document and agree to automatically share changes you’ll see their work in real time. 

So you can go ahead and do that and then you’ll hit Save to the Cloud, that’s how you’d actually 

upload it and then that’s out there on OneDrive. And by the way you do have to have a OneDrive 

account or if you’re using Office 365 then that would work perfect for you. So let me go ahead 

and close that window right now. 

Another thing you’re going to find is that if you have a word you’ve typed in, you’ve got 

something called Smart Lookup. Let me just type some word in here. Let’s say Exciting. Now if 

I go ahead and select the word, which we’ll be talking about how to do that later, and I just right 

click on it you’ll notice the Smart Lookup. And what that’s going to do is it’s powered by Bing 

and it brings research directly into your Word 2016 document. So when you select a word like 

this or phrase if you needed to then you can right click like I did, choose the Smart Lookup and 

the Insights pane will open with definitions. So when I click on that here’s your Insights pane 

over here on the right. So these, like I said, are definitions, they’re Wiki articles, or talk related 

searches from the web. So it’s going to use Bing for its search. And this is really cool because 

you can see adjectives for Exciting and can see, if you scroll down here, Wikipedia and like I 

said, there’s the Web Search as well. So if you wanted to go to one of these websites you could 

do that. So let me close that and let’s talk about something else that’s new. 
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If you happen to work a lot with math equations then this has gotten much easier than it used to 

be. Now what you can do is you can go up to this Insert tab at the top here and all the way to the 

right here you’re going to see Equation. And you’ll notice that if you click the down arrow there 

you’re going to see Ink Equation down at the bottom. Now what happens here is that if you want 

to include some sort of complex math equation in your document you can actually do it here. If 

you have a touchscreen device you can use your finger or if a stylus you want to use that or you 

can just write it by hand and Word will convert it to text. If you don’t have a touch device you 

can use a mouse to write as well. You can also edit, select and correct what you’ve already 

written as you go along. Excel has this feature as well. So just kind of know that. I’m going to go 

ahead and cancel that right now and let’s see what else is new here. 

Alright a couple more things I’ll just mention. You’ve got improved version history here. What’s 

really cool about his is if you have a document and you’d saved it before and now you go and 

make some changes to it, you can actually go up to the File tab right here and see History which 

is grayed out because in this particular one I don’t have any history but if I did I’d be able to see 

a whole list of all the changes that I had made. So that’s really cool.  

And then the last thing I want to mention is a little bit about the sharing. We did talk earlier 

about using the Share button right up here. But just remember that if you wanted to share your 

document with others on SharePoint, on OneDrive then you can actually do that and you can also 

send a PDF copy as well as an email attachment and it goes directly from Word. So just so you’ll 

know that you have the ability to send it that way.  

And then also you have faster Shape formatting. So if you’ve used the shapes before in 

PowerPoint or even Excel or Word then you’ve got lots of shapes in the Shapes gallery and 

there’s a whole new collection of preset fills as far as theme colors and that way you can quickly 

get the look that you want.  

So those are just some of the new things that are new to Office 2016, in particular Word some of 

them. So why don’t we go ahead and wrap up this video and then go ahead and get you started 

on the next one. So I will see you over in section 3. 
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Video: Overview of MS Word Screen 

Cindy: Okay welcome back. We’re in module 1 and we’re all the way down to section 3 where I 

want to take a few minutes and go over the screen itself with you so that when we do start 

working in module 2, which is the Getting Started module, you’ll know what you’re actually 

looking at and kind of where to go for different things. So let me go ahead and flip over to a 

blank document in Microsoft Word and we’ll get started with that. 

Let’s start at the very top and work our way down.  

The first thing I want you to notice is this bar that goes all the way across at the top which you’ll 

have in any program. And it’s actually called your Title Bar. Your title bar always tells you the 

name of the file that you’re working in and the name of the program you happen to be working 

in. Now in Word your generic files that you start creating are called Documents. You’ll see that 

once we save this a little bit later and give it a name this will change to whatever name we give 

the file. Let me just tell you a little bit about compatibility mode as well. 

If you’re going to sharing this document with people who have an earlier version of Word or 

maybe they work outside of your organization and you don’t even know if they use Word then 

you might want to leave it in compatibility mode. And this way other people who are editing 

parts of the document that may or may not have some of the same types of things we have in this 

version won’t have any issues. And let me give you a good example.  

In the last two versions we have a new font called Calibri right here. Well previous to that the 

font was Times New Roman. We didn’t have Calibri. So sometimes people couldn’t see the text 

if we had used the new font or they might have other issues with the file. So as long as you leave 

it in this compatibility mode then you’ll be good to go. And that option is under the Options for 

Word, which we’ll get to in another module when we go through that. So just know what 

compatibility mode is. 

Now I want you to notice on the left side of your title bar you have your Quick Access Toolbar. 

You have several buttons that are here automatically but you can actually edit these. Here is your 

Undo. You’ll notice that I can’t use it right now because I haven’t done anything. But as soon as 

I do one thing I’ll be able to access this. Undo will be your best friend. If you make a mistake 

just undo it. Here’s your Redo. So if you go back too many when you’re undoing you can redo 

and bring them back.  

Here’s your Email button. Now let me tell you what’s really, really nice about the Email button, 

which has been here by the way since the beginning of time and a lot of people didn’t realize 

that. But normally if I’m going to email something and by the way it only works with Outlook. 

Okay? But let’s say that I’m going to create this file and I want to attach it to an email and send it 

to someone. Normally you would create the file. You would go through the whole save process, 

close the file, you’d flip over and open Outlook, create a new message, attach the file. You can 

see there’s a lot of steps there. With this it lets you just click on this button. You will be inside of 

Outlook automatically in a message and your file will already be attached. All you’d have to do 

is address it and send it on.  
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Here’s a quick way to print your document. And here’s a quick way to save it. Now you can edit 

these buttons if you want. You’ll notice that when I click this down arrow that I’ve got all these 

other options that I can add or if I don’t want one that’s there I can just uncheck it. So those are 

just quick buttons that you would use on a regular basis. That’s all that is. 

Now the next thing I want to point out are your tabs that you have across the top. You have File, 

Home, Insert, all the way across. And you’ll notice when you click on any tab that you have a 

ribbon below. So the terminology is tabs, ribbons, and these are buttons on the ribbon. So you’ll 

get familiar with where different buttons are as you start working.  

Now you’ll notice when you’re looking at your ribbon that you have groups of buttons. For 

example this is the Font grouping, this one is the Paragraph grouping and so forth. Some groups, 

not all, have a little arrow on the bottom right. And if you click the little arrow like I’m doing 

here you’ll get some additional choices related to that particular grouping. So you just close with 

the X at the top right if you don’t want that window.  

Now let’s go down and look at this. Right here you have what looks like an L, but these are 

actually your tabs. Later you’ll learn how to set tabs. But notice if I just click here that it’ll rotate 

through the different tabs that are available. But you’ll see there are several different ones. And 

again you’ll learn how to set those later. 

You should have a ruler across the top and a ruler on the left side of your page. You’ll notice that 

where the ruler is gray that’s an area that if you were typing you couldn’t really type there 

because that’s what we call the Header area. So right here, see that one at the very top there? 

That indicates you have a one inch margin from the top of the page down. I can double click in 

that area and now I’m typing in my header. But normally just typing on the page you’re not 

going to be able to type above where the white is on the ruler. You’ll also have the same thing up 

here. See how there’s a gray part of the ruler here? And then way over here as well? That’s going 

to be the edge of your margins there where the gray in the ruler is. Notice your ruler will go to 6-

1/2 inches here and like I said you have a one inch margin at the top down. 

Also notice these. These are your indents. And you’ve got one over here and so we’ll learn how 

to use those a little bit later as well. 

You might notice that when I’m pointing my mouse under the ruler and above the page I have 

these double white arrows. And when I double click I’ll hide or show the white space. And the 

white space is basically the margin area. So see how I hide or show it when I double click? 

That’s all that is. 

You also have a scrollbar on the right. And if you don’t see your scrollbar when you’re working 

it’s because you’re not clicked in your page. So sometimes it disappears unless it thinks you 

really need it.  

Now if you look down at the bottom left of your page notice it says Page 1 of 1, 0 words, all the 

way across. That’s going to be what we call your Status Bar. It’s letting me know that I’m on 

page one and I only have one page. Also I have zero words. So you can see that. 
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Now all the way on the right hand side you have three different what we call views. You have 

Read Mode which I’ll click on that. And Read Mode looks just like this. If you had text in here 

you’d just be able to read it and not do a whole lot more with it. So I’m going to go ahead and go 

down to the bottom and I’ll click the middle one which is Print Layout and that’s the one that 

normally you’re working in. And also I just want to point out the Web Layout View. If you 

happen to be setting up something that you’re going to be putting on the web for some reason 

you’ll want to do it in the Web Layout View. If you know anything about HTML language, 

that’s Hyper Text Markup Language, the computer can’t read internet language and vice versa. 

So you need to put it in a language it can actually read and that’s what HTML is. So try to do 

those types of things in this particular view. 

Now the last thing I’ll point out at the bottom is your Zoom. So notice that I can slide the slider 

in or out to zoom in or out in my document.  

So that’s going to go ahead and wrap up this particular section of your overview of Microsoft 

Word and the screen itself. I do have one more thing I want to talk to you about in this module 

and that’s the Backstage View. So why don’t you go ahead and look at section 4 real quick and 

I’ll head right over with you. 
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Video: Backstage View 

Cindy: Before we actually wrap up module 1 I wanted to take a few moments in this fourth 

section and talk to you about the Backstage View. You’re going to see that all of the Microsoft 

Office products have the Backstage View and I wanted you to be familiar with what it is when 

we start actually using that terminology or having to use it.  

Like I mentioned, if you’re working in any of the Microsoft Office products you’re going to have 

a tab called File and when you click on it this takes you into what we call the Backstage View. 

And so this is going to have all of your options like your New, if you wanted to open a file you’d 

come here, here’s your save options we’re going to talk about in module 2. Notice the History. If 

I had actually saved this already and I made a change to it I can go see the different versions. 

Here’s where I’m going to print the file. I can share the file with others. I can export this or close 

it. Now you’re also going to have a few of these options down here, like the word Options, for 

example. These are all the options in Word. And then there’s Account. Some of these others you 

may or may not have, just depending on if you have different add-ins loaded. 

Now notice the info part in the middle here. I wanted you to be familiar with the compatibility 

mode that I mentioned because what the Compatibility Mode option here is going to allow you to 

do is if you’re working in a file that was created in Office 2003 or prior then you would need to 

actually enable some of the newer functions or features that Word has. And you can do that just 

by saying Convert right here.  

You can protect the document, which is something we’ll discuss way down in a later module. 

You can also inspect the document before you publish it just to make sure that it has things in it 

like the properties for the document, the authors name and things like that. Here’s the Properties 

over here I’ll mention in a second.  

And also just notice the Manage Document. So if you have a document or you want to recover 

one that hasn’t been saved yet you can go in and look at the Manage Document options.  

Here’s the Property options over on the right. And the properties are just features of this 

particular document. You can see it hasn’t been saved yet. You can see how many pages and 

words are here. If you had any editing you can see how many minutes it takes to edit this. If you 

had any titles, tags or comments they’d be listed here. You can see the creation date, when it was 

printed, who the author is, all those types of things. So this is going to give you a lot of 

information about this particular document.  

So I just wanted you to be familiar with the Backstage View. When we use that terminology it 

basically means that when I hit this back arrow I can go back and if I hit File that’s going to take 

me back into the Backstage View. So I’m going to hit the back arrow and that’s going to take me 

back. 

So that’s going to go ahead and wrap up module 1 here. I want you to go ahead and move over to 

module 2 where I’m going to get you started with some typing and have you create a new blank 
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document so we can do some things with it. So I will see you over in module 2 and we’re going 

to really get going with this. 
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Module 2 – Getting Started with Word 

Video: Creating a New Blank Document 

Cindy: Hey. Welcome back. We are now working in module 2 and this is the Getting Started 

with Word module. Now we’re in the first section and I want to show you how to create a new 

blank document and get some text typed in and then we can work with that text. So let me go 

ahead and I’m going to double click on Microsoft Word and show you what it looks like when 

you first open it up. 

Here we go inside of Word. I’ve just double clicked to open it and this is the first screen that I 

get. What you’ll notice is that on the left it will show any recently used documents, but on the 

right is where you go to create your new document. So here’s where you create a new blank one.  

Before we click on that I want to mention that you’ve got these other templates that if you 

wanted to start with one of these you could. Basically a template is just a Word document that’s 

already created and you can type over it or edit it any way you’d like. So you’ll notice there’s a 

calendar here, for example. There is a cover letter for a resume. Here’s a resume. Here’s an event 

menu. You can see several different things. An invoice, for example, some thank you cards, a 

brochure. But if you don’t like any of these and you want to start with a template then just go to 

the web and just do a search for Microsoft Word templates and see if you can find one you like 

and just use that one. That’s a lot easier sometimes than starting from scratch. But we’re actually 

going to double click on the blank document and start ours from the very beginning. 

We’re in a blank document now and I want to go ahead and start typing here just to show you 

some things that Microsoft Word will do for you. One thing to keep in mind when you’re typing 

is that this is not a typewriter. So when you’re typing wherever you see your insertion point or 

you might call it the cursor blinking the text will always come out to the left of that. When 

you’re typing and you get all the way to the right margin don’t hit the Enter key. Just let the text 

wrap to the next line automatically. If you want it to move to the next line that’s when you’d hit 

the Enter key.  

Now a couple things that Word will do for you. It will capitalize the beginning of a sentence. 

Now normally if you’re going to capitalize a word or a letter, for example, you’re going to hold 

the Shift key and hit that letter. But let’s just say I type the small letter here, like in the word 

Now. As soon as I hit the Spacebar it’s going to give me a capital N and that’s because Microsoft 

Word will automatically capitalize the beginning of a sentence. What it sees as the beginning of 

a sentence is the fact that I started next to the margin. And also if it sees a period and a space the 

next word will automatically get a capital letter. So just remember that.  

When you’re typing if you get something underlined in red it’s a spelling error. And it really just 

means it’s not in the computer’s dictionary. So sometimes your name may come up as being 

misspelled and it’s really not. If you get some green underlined that’s a grammatical error. Also 

sometimes you’re going to see words that it will spell correctly for you. Let me finish typing this 

and I’ll show you some of these. Now is the time. Notice I’m spelling Time, T-I-M-M-E. As 
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soon as I hit that Spacebar did you see that it corrected the word for me? That’s because it’s part 

of a feature called AutoCorrect that we’ll talk about a little bit later. It’s got some words already 

in there that are commonly misspelled. 

Now is the time for all good men to come to the aid of their country. Now I did a couple of 

things here that I wanted to point out. First of all, I misspelled this word Good. Now I left out an 

O there. Now you would think the Grammar Check would pick that up and it doesn’t. You would 

also think that Spell Check might pick it up but it doesn’t because Spell Check, this word is not 

misspelled. God is an actual word. So notice I’m going to click there and actually insert that 

extra O. So I’m going to manually change it. Here notice I’ve got the blue underline. In older 

versions the Grammar Check was green and now it’s blue. So just kind of know that. I put two 

spaces between Men and To so it considers it grammatically incorrect. Now notice that I can just 

right click anywhere where that blue underline is and what will happen is that if the word that 

I’m trying to spell is on the list or if it sees the way I should be spelling this it’s going to go 

ahead and give me that as a suggestion and I’m going to choose it with my left mouse button. 

And you can see that it fixed it for me. 

Now let me go ahead and fix another word where I’m going to misspell it. What if I take this 

word To and I just totally spell it wrong? Let’s put a G there. Notice again there is some 

underlining there. Again in previous versions it was red. You’ll notice now that this one is blue. I 

can just right click on that word again and it will give me a choice it thinks I’m trying to spell 

and I can choose it with the left button. Now sometimes the choice you want is not on the list, so 

just kind of know that, and that’s when you’ll have to manually make some of those changes. 

Now notice if I click at the end of the line now with my mouse and hit the Enter key that’s going 

to take me down to the next line below.  

Now let’s say that I was working on this document and I was not finished but I realized I needed 

to create another new blank document right now. The way I would do that is I would go up to the 

File tab, I would choose the New option and here’s the same blank document or the templates 

and I’ll just choose Blank Document again and now you can see I’m on Document 2. The other 

one was Document 1. Now how do you get back and forth? You can actually point your mouse 

to the bottom of your screen and what’s going to happen is you’re going to see it pop up and 

show you all of the Word documents. And I don’t want to go all the way down there because I’ll 

actually show my task pane, but it would show you the two Word documents and then you would 

be able to choose the one you like. If you decide that you don’t want one of these documents just 

go to the top right and you can use the X to close it out. Be very careful because if you only have 

one document open and you do that you’ll actually close all of Microsoft Word. 

What we’re going to do now is I want to go ahead and move over into the second section where 

we’re going to set up another blank document and I’ll show you how to work with non-printing 

characters and line spacing basics. 
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Video: Working with Non-Printing Characters and Line Spacing Basics 

Cindy: Hey there. Welcome back. We’re in module 2 which is the Getting Started with Word 

module and we’re now on section 2 where I want to show you how to work with non-printing 

characters and some line spacing basics. 

Just so you’ll know what non-printing characters are, there are certain characters like spaces and 

the Enter key and the Tab key that you would like to see those when you’re typing for various 

reasons. And you can. So let me show you how that would work. 

I’m back in my document here and I’m going to set up a professional looking letter. And let’s 

say the first thing I want to type is the date. So let’s say that the date happens to be April and it 

happens to be the 14th. Notice the yellow box that appeared right above April. If that is what I 

want I’m going to hit the Enter key and it will fill it in for me. If that was not the date I wanted I 

would just keep on typing and it would go away. Now I’m going to go ahead and hit the Enter 

key because I’d like to go down to the next line. If you need two spaces in there you’d want to 

hit the Enter key again.  

Now I want to say this is to someone and so I’m going to type it like this and notice I’m going to 

hit the Tab key. What Tab does is stops you at the half inch mark on your ruler. The reason you 

want to do that is because if I just type the To and I went space, space, space, space, space and 

then I came down and did the next line, let me finish this one real quick. Let’s say this is to Jim 

and I’m going to say it’s from me. But if I had used the spaces here and the spaces here then Jim 

and Cindy would never line up and look professional. Sometimes they’ll look close but you’ll 

print it out and they’re really off. And the reason for that is because each character of the 

alphabet is a different width. So remember that when you hit the Tab key on the keyboard you’ll 

stop at the half inch mark on the ruler. You’ll learn later how to set custom tabs so you can have 

it stop wherever you like when you hit that Tab key.  

So I’m going to enter a couple more times and start my document. Now I’m going to scroll down 

just a little bit so we can see the whole thing. So I’m going to say Call Mr. Kelly to check your 

calendar order, period. The one you wanted is out of stock and will not be available until next 

week. Did you see how the text just automatically wrapped there? And I’m going to say If you 

have any questions, questions, call me at 614-555-1212. And then I’ll go ahead and just drop 

down a couple of lines and put my name in there. Now you notice I have a misspelled word right 

here so I’m just going to go ahead and put my Y in there and that’ll fix it for me. Now it might 

look okay but sometimes what happens as you’re typing and you look and you say, “I’m not sure 

if I have two or three spaces there. Let me check that out.” Let me show you how to use non-

printing characters. 

If you’re on your Home tab you’re going to see right here it looks like a backwards P and if you 

point to it it says Show or Hide. I’m just going to turn that on. You just turn those on or off. 

Notice what you’ll see here. Every time you see this that is a paragraph marker. It indicates the 

end of a paragraph. Microsoft Word will consider this a paragraph. It will consider this a 

paragraph and so on and so forth down the line. These also represent every time you’ve hit the 
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Enter key on the keyboard. So if you needed to see how many blank lines were between a couple 

of paragraphs turn it on and check it out.  

Another neat little trick that happens. Sometimes you will print a one page document and a 

second blank page comes out. And the reason for that is notice that after my name I’ve got an 

Enter. But I could have lots of these in there. It could be I sat on the keyboard. Who knows? But 

if I have enough of those to force it to a second page you’ll get a second blank page. Just start 

deleting some of these. You can actually just click in front of one and just start hitting Delete 

until you get back up to one page.  

Now the other thing you’re going to see here is you’ll see a dot between the words. So normally 

if you have two spaces then it’s going to actually tell you that it’s a grammatical error. If you 

have three it doesn’t. Now it doesn’t tell you that right after the period like in this case. But 

normally if you’re typing your sentence and you see two it’ll give you a grammatical error like 

that.  

If I wanted to actually go ahead and any of the stuff or delete it I can. See also here’s the Tab 

right here. We talked about that’s shown by an arrow.  

Now it may look like things are double spaced in this particular document and they’re not. Let 

me show you what’s going on in any new blank document when you first start typing.  

I’m going to do what’s called Selecting. I’m going to hold down Control and hit the letter A to 

select my entire document. That way whatever I do next it will affect everything I have selected. 

We’re going to talk a lot more about selecting a little bit later but for now Control-A will select 

everything.  

Now I want to show you right up here under the Paragraph grouping. Do you see this one right 

here? This is your Line Spacing. What you don’t see is that this is set on 1.15 automatically. So 

if you set it on 1 you’ll see it changes it a little bit. That gives you single space, true single space. 

The other big one I want you to notice is this. Do you see how it says Remove Space After the 

Paragraph? What happens is in Microsoft Word there is a feature that will actually add some 

additional space after the Enter key and there is some there. That's why you have the option to 

remove. And by the way do you notice that when I just move my mouse over one of these 

choices it shows me what it’s going to look like if I choose that choice? I’m going to remove 

space after and this is actually what my document would look like. Let me turn off these non-

printing characters. See? So what I can actually see now is that I probably want a blank space 

between this line and this line. So I’m going to click at the end of the word Week and I’m going 

to hit the Enter key to get that extra space in there. 

So you do want to turn these on so you can see what you’ve done. And notice these are called 

Non-Printing because they’re never going to print. So just know that you can work with them on 

or off. I usually turn them on when I want to see what I’ve done and then I’ll turn them back off, 

but that’s really up to you. And remember the line spacing. You want it on single space and if it 

says Remove that means there is extra space to remove. So just know that. 
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Now we’re going to go on in a later video and talk about all the line spacing options but I wanted 

you to know that for now just so that you can get your letter looking the way you want so you 

can get it out.  

So that’s how you work with the non-printing characters and the line spacing, the real basic 

options. What I want to do now is go ahead and wrap up this video and let’s go over to section 3 

and talk about saving this. 
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Video: Saving a Document 

Cindy: Alright. We are in module 2, which is Getting Started with Word, and this is actually 

section 3 where I want to talk to you a little bit about saving your documents. If you have a 

document you’ve already created you don’t actually have to save it if it’s a one-time thing. You 

can actually print it out if you want and then close it. But if you want to be able to open it in the 

future you need to save it. So I want to go through the whole saving procedure with you so you’ll 

know what the different options are as far as saving your document. 

One of the first things I noticed when I flipped over to my file here is that I’ve misspelled the 

word Stock. It’s actually the word Sock currently. I’m going to click between the S and the O 

and put my T in there. There, that makes me feel a little bit better. 

As far as saving goes how do you know if this file has been saved before? Well your first clue is 

when you look up here at your title bar it says Document 1 currently and that tells me that I 

haven’t yet saved it and given it a name.  

So there’s a couple of ways I can get to the Save window. I can use this button here which means 

Save. I can also click my File tab and use Save or Save As. Now let’s talk briefly about the 

difference in these two. 

If this file has never been saved then any of those three options I just mentioned to you will 

automatically take you to the Save As window. When you’re in the Save As window you’re 

going to have to tell it two things. What would you like to name the file? And where would you 

like to store it? If you’ve already saved the file once and you’ve added something to it then Save 

would actually allow you just to update the file. Notice that right now no matter which of the 

three I pick I’ll go to Save As. I’ll choose Save just to show you. And see how it took me to the 

Save As window?  

Now I have a couple of choices here. I can save my file to OneDrive. And remember that means 

that if you have an account with Microsoft OneDrive already which is free then you can upload 

this and that way you can access it from anywhere you’d like as long as you have internet access. 

You can also share this file with others that way. You can save to this PC, you can add a place or 

browse. Most of the time you’re going to use browse. So I’m going to click on Browse. And this 

actually takes me to the actual Save As window. Here’s where I’m going to name the file right 

here. Notice it pulled in the first line of what I typed thinking I want to call it April 14th, and I 

don’t. So I can type over that whatever I want. Notice the dot-DOCX. I do not have to type that 

in. Word will assign that for me automatically. I’m going to go ahead and call this My 1st 

Memo. 

Now something else I want you to notice down here. It’s automatically going to save it as a 

Word Document, a dot-DOCX. But I want you to be aware of some of these other choices down 

here. You can also save this as a Word 97-2003 document. Why might you want to do that? You 

don’t always know when you share this file with others if they use Word at all or if they have an 

older version. And if you save it this way then you won’t have to worry about can they open it 

and see all the options in there. Another choice might be that you save this as a PDF file. So that 
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way if you wanted to send this to someone they wouldn’t be able to edit the file unless they have 

specific software to do that. Some other options just to notice. I can also go down here and save 

this as a webpage if I’d like, as a plain text file, and you can see these other choices. So just kind 

of know there are other Save As types available. 

The other thing I want you to notice is where would you like to save the file? So you’ve got all 

these different places. If I scroll down this list a little bit I want you to notice that I have places 

when I click on Computer on the left here. What that allows me to do is when I click on 

Computer I can see all the different places I could save to. Maybe to a flash drive if I had one, a 

CD-ROM, different places. I’ll go ahead and put mine in My Documents here. And then I’ll just 

go ahead and save it. And now you’ll see that if I look at my title bar the title of my document is 

My 1st Memo.  

That’s a quick way for you to save your document. Now remember if you make a change to your 

document, even if you just add a space, then Word thinks you’ve changed it and you may want to 

save it. If you do want to save it on your own you can go ahead and hit Save here or the File-

Save I showed you. Also if you try to close the file then it would pop up and say, “You’ve made 

some changes. Would you like to save it?” And then you would need to say Yes at that point in 

order to keep your changes. I’d just wanted you to be familiar with the different ways to save this 

particular document. 

So what we’re going to do now is we’re going to go ahead and close it so I can show you when 

we move over to section 4 how to open the document. A quick way to close is go to File and 

down here to Close and then that’s going to take you to a gray screen. So I will see you over in 

section 4. 
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Video: Opening a Document 

Cindy: We are working our way down through module 2, which is the Getting Started with 

Word module, and we’re all the way down on section 4 now where we’re going to real quick talk 

about opening a document. 

We talked about saving a document in the previous section and really opening is just the opposite 

of saving. We’re just going to go and tell it to look in a certain place and to open a certain file 

that we’ve already names. So let’s go ahead and do that real quick. 

When you’re ready to open a file you’re just going to click on the File tab and now you’re in the 

Open window. Now here you can open and look in one of these places for your file. The only 

thing you didn’t have when you saved with the recent option that you see here. If you had any 

recently opened documents you would see them listed and you can just double click to go to 

them. 

Now I’m going to go down to Browse and I’m going to look in Documents again. And there 

you’ll see My 1st Memo. So I’ll just double click and open it up and there it is.  

If you want to open a second file you can. You don’t have to close the first one and then open the 

second one. You can have multiple files open at the same time. I’m going to go back to the File 

tab, I’m going to go back to Open, I’m going to Browse again, and this time I’ve created a folder 

in My Documents called My Practice Documents and I’m going to double click and just look at 

this for a second. 

When you’re looking at a list of your files you’ll see that they’re in alphabetical order and that’s 

fine if you know what the name of the file is, but sometimes you forget or maybe it’s been a 

while since you worked on it. You do have a couple of options as far as how you view the list of 

files.  

So right up here you can view these as extra large icons if you want, you can see them as large 

icons, medium icons, or small. Most of the time it’s set on the List option automatically. Now 

underneath list you’re going to see a Details option and this will show you again all of your files 

in alphabetical order but now you’ll see information about the file. When it was last modified, 

the type of file that it is, the size of file. Your other options here are to see these as tiles or to see 

these as content. So most of the time you’ll probably look at this as the list or details.  

Now I want in this particular case to open a file called Navigate because we’re going to be using 

that when we talk about navigating in the next section here. So let me go ahead and open it up 

and there it is. And now you actually have two files open at the same time. 

When you have multiple files open you can actually switch back and forth between those files. 

Notice under the View tab you have the Switch Windows option. This is a listing of all the files 

you have open in Microsoft Word. So I’m going to click on My 1st Memo and see how it takes 

me back? Or I can switch back to Navigate if I like.  
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I can also view these two files side by side. That’s this option here. And when I click on it notice 

I can see Navigate on the left and I can see My 1st Memo on the right. I can actually drag things 

back and forth or I can copy and paste back and forth, things like that. But if you want to work in 

one file again just maximize that particular file.  

Now notice you can also work with the Split option. Now when I turn on the Split here’s what it 

does. Wherever I’m clicked it’s going to insert a split. This is the same file. It’s just I can look at 

any part at the top that I’d like and down at the bottom if I click I can go down to this at any part 

that I want. So it’s the same file but it allows me to see something on page one and page six at 

the same time if that’s what I need to do. To remove the split you just click on Remove Split. 

The Arrange All is going to let you see all of your windows one on top of another like this. To 

me it’s easier to see them side by side but that’s really your choice. So I’ll go ahead and 

maximize that again.  

So that gives you a little bit of insight on how to work with multiple files when you have them 

open. So what I’d like to now is go ahead and wrap up this fourth section and go over to section 

5 and talk about how do you navigate when you have some of these larger files like this. 
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Video: Navigating in a Document 

Cindy: Welcome back. We’re in module 2 and we’re all the way down to section 5, Navigating 

in a Document. So what I’d like to do now is show you a file that has multiple pages and show 

you some quick ways to move around when you’re working with any document. 

We’re working in this file called Navigate and if you look at the bottom right hand side of your 

screen it says you’re on page one and you have three pages. There’s also 842 words. Some quick 

ways to just move around. 

Most people are familiar with their scrollbar on the right hand side and that’s obviously a quick 

way to go up and down your page if you need to. But what if you have thousands of pages in 

your document? Then you might want some other ways to move around. And so that’s what we 

want to talk about here. 

First of all just kind of notice that wherever your mouse is clicked remember that’s where you’re 

going to be typing. So a couple of keys you can use on the keyboard to help you move around. 

First of all the Home key is going to take you to the beginning of the line you’re clicked on. 

That’s the Home key on your keyboard. The End key is going to take you the end of the line 

you’re clicked on. So that’s a quick way to go to the beginning or end of that line. Now let’s say 

this time you hold Control and you hit Home or End. Control-Home is the very top of the 

document, the top of page one. Control-End is the bottom of page three. Control-Home is the top 

of one and End is the end of bottom of page three.  

Also if you’re holding the Control key and you hit your arrow key that goes to the right notice 

you go one word at a time, whereas if you’re holding Control and you hit the left arrow you go 

one word at a time to the left. So you can go right or left that way as well. Up and down if you’re 

holding Control you’ll go one paragraph at a time up or down. 

Those are some ways you can quickly move around in your document. 

Now what I want to do now is in the next section it kind of goes right along with this. That’s 

going to be your Go To, your Find, and Replace. So let’s go ahead and move over there and then 

I’ll show you how those work. 
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Video: Go To, Find, and Replace Options 

Cindy: Hey there. Welcome back. It’s Cindy again. We are in module 2 which is the Getting 

Started with Word module and we’re all the way down to section 6, Go To, Find, and Replace 

Options.  

Now sometimes when you’re working with especially larger files you might need a quick way to 

go to page 900 for some reason or a quick way to replace several words in that document. So let 

me just talk to you a little bit about how to use the Go To, Find, and Replace options in Word. 

When you’re working in your file and you want to use the Find, Go To, or Replace options you 

might want to think about starting at the very top of the document because all of these searches 

will start from wherever your mouse is clicked. Now I want to show you a basic Find just to start 

with. 

I’m on the Home tab and I’m going to go all the way to the right and you’ll see Find here. Now I 

could just click the Find but if I click the down arrow I get a couple of choices. Let me start with 

Find. 

So let’s say that I’m looking for a particular word and let’s say that I’m looking for the word 

Firm. I can just type in the word Firm and when I hit the Enter key notice that it finds all the 

instances of the word Firm and it selects them and puts in yellow here for me. So that’s a quick 

way if you’re just trying to get it to find some words for you. But let me do this. I’m going to go 

ahead and close that navigation on the left there and I’ll make sure I’m clicked at the top again.  

Sometimes you know you’ve got a certain paragraph in here and you can scroll all day long and 

you just miss it. So if I use the Advanced Find right up here this is going to allow me to put in 

specific words I’m looking for and it will find them one at a time. So let me move this out of the 

way. Let’s say that I’m looking for the word Properties. Now I’m going to go ahead and hit this 

Find Next and you’ll see that it stopped on the first instance of Properties that it came to. If that’s 

not the instance I want I’m going to hit Find Next again and notice it found the next one. And so 

on and so forth. So that’s a good way to have it search and just look for them one at a time for 

you. 

I did want to mention over here where you see this More, if you just click on that there’s some 

additional choices you can tell it to use in the search. For example, this Match Case, if I check it 

it has to find the word Properties with a capital P because that’s the way I typed it in. Otherwise 

if I leave it unchecked it doesn’t matter if it’s a capital or a small P. Find Whole Words Only. If I 

had the word He typed up here it would find He’s or any word with He in there. So if you’re 

looking for a specific word without the S at the end and that sort of thing check Find Whole 

Words Only.  

Wild Cards. Let me give you some examples of Wild Cards. A star is a great example. What if I 

had the letter S typed up here and I typed this with a star? That would tell me to find any word 

that starts with an S no matter what it ends with. And you can used wild cards at the beginning, 

at the end or you can have text in between either one. If I have this that means the word can start 
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with anything and it has to end with an S. So that’s one example. Another example might be 

what if I have let’s say the letter A and I put two question marks? That means the word has to 

start with an A and it can only have three characters total in the word. So that’s a couple of 

examples of wild cards. You may not use them a lot but just know they’re there. 

Sounds Like, if I typed Try up here it would find Shy, Try, Thy. And then Find All Word Forms 

would find Flown, Flew, Flies, any form of that word. You can do a lot of other things with 

Search. You can have it search for specific formats and things like that. But for now I’m going to 

hit this Less and kind of fold the window back up. 

The next thing you’ll see is the Replace. Now let me go back and click at the top here. If you 

notice this company is called Burke Properties. And their name is listed several times in this 

particular document. What if they’re changing their name and it’s now going to be Smith 

Properties? So the way this would work is I would type the word Burke and then I would type 

the word I want to replace Burke with which is Smith in this case. Now notice I can replace them 

one at a time, which I’ll say Replace, and notice it replaced Smith right there. Now it went on 

and found the next one. So if I just go ahead and say Replace All notice how it tells me it made 

nine replacements. And if I look down this list look at all of these. Smith Properties, Smith 

Properties, Smith Properties, all the way down the list. So that’s a quick way if you wanted to 

just change a word you know is in here several times.  

Now one more tab I want to look at and that’s the Go To. So let me go back up to the top here. 

Go To is going to allow you to go to different things that you might have in your document. Now 

you probably know what a page is. We have three pages in our document. So if I put a 3 over 

here and I hit the Go To I’ll go to the top of page 3. Or if I put a 1 I’ll go to the top of page 1.  

You may not know some of these other things. A Section. We are going to talk about sectioning 

later. But just to briefly tell you, any time you’d like to see something different in one part of 

your document than in another you can create what we call Section Breaks. An example might 

be you want different margins in one part of your document than in another. You can go to 

whatever section you need to. If you know which line you want to go to you can type in here that 

line number. Bookmarks. You have the ability to mark certain sections in your document or 

certain words and then you can quickly go to them. And you would use those for different 

reasons. In the back of any book you will have a Table of Contents. And that table of contents 

will tell you Printing is on page 6 and page 57. Well how did it know that? Because someone 

bookmarked the word Print and it went and pulled that information. So that’s a super advanced 

feature of Word when you can create a table of contents like that. Comments. You have the 

ability to create comments and put those in your document. And then you have Footnotes and 

Endnotes. Remember that footnotes go at the bottom of the page and endnotes go at the bottom 

of the document. There’s also some things in here like different fields or tables or graphics and a 

lot of these are very advanced functions but you can tell Word that you want to go to any of 

these. So that’s how your Find, Replace and Go To work.  

I want to go ahead and talk to you now a little bit about how to edit a document and then we’ll 

wrap up this particular module. Let me go ahead and see you over in section 7. 
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Video: Editing a Document 

Cindy: Welcome back. We’re in module 2, Getting Started with Word, and we’re all the way 

down to section 7 where we’re going to briefly talk about editing a document. 

You’ve already seen us edit the document a couple of different ways. In the previous section 

when we had actually looked at the Replace option we had replaced all of the Burke’s with the 

word Smith. So that was one way to edit. But there’s a lot of times when you just need to type 

some text in the middle of the existing text.  

Let’s say I want to do this. Smith Properties was founded as and I want to add some text after 

this word As. Notice I’m going to click the mouse there because the text will come out to the left 

of the insertion point that you see or the cursor. So I’m going to say Smith Properties was 

founded as a new company and I’m going to take out that comma. Now remember that if you hit 

Delete on the keyboard you delete anything to the right of the insertion point. Backspace will 

delete anything to the left. Let’s say you backspace and you got rid of a couple of these letters 

and you really didn’t mean to. Use your Undo. If I just hit Undo it will keep undoing the last 

thing that I did. Also with Undo there’s a down arrow to the right of it. This will show 

everything you’ve done since you last opened the file here. So you can undo from any point up. 

That’s one way to go ahead and edit your document.  

You can also just go through and search like we did and find specific words and replace like we 

talked about. Just remember those are ways to edit. 

Once you’ve edited the document you will want to hit the Save button or you can go File-Save, 

either one, and that way you’ll update and keep all of your changes. That’s really all there is to 

editing a document. 

Well, we’ve gone all the way through module 2 here and I think you have a good knowledge of 

how to get started with Word. So I’ve got a practice exercise I’m going to have you do over in 

section 8. So why don’t you flip over there and I will meet you shortly. 
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Video: Module 2 Practice Exercise 

Cindy: Alright we’re back. We’ve made it all the way to the end of module 2, which is the 

Getting Started with Word module, and this is section 8, Module 2 Practice Exercise. Let me tell 

you what I’d like you to do for me. 

I want you to go ahead and open a practice file called Practice Module 2. At the top of the 

document you’re going to see an address block that says Name, Address, City, State, Zip. Go 

ahead and change all of that to your name, your address, your city, state, zip. In the Salutation 

Line go ahead and replace the word Name with your first name.  

The next thing we’re going to do is we’re going to change all the instances of the word Burke to 

the word Holden. So the company’s changed their name from Burke Properties to Holden 

Properties and you’re going to replace those all at once. 

Change the name Heather LaPierre at the bottom of the document to your name.  

When you’ve finished with all of that just save the file as My Practice Module 2. Remember if 

you just hit Save you’re going to save over the original. So I want you to end up with the original 

and a new one.  

And when you’re through with that go ahead and close the file.  

You’ve done a great job. That was awesome.  

Now we’re ready to move over to module 3 where we’re really going to get into some of this 

formatting. We’re going to be talking about character formatting in module 3. So I will see you 

shortly. 
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Module 3 – Character Formatting 

Video: AutoCorrect Options 

Cindy: Hi there. It’s Cindy. We are down to module 3 and this is the module where we’re going 

to talk about Character Formatting.  

Basically what this means is that when you have letters or numbers you’ll want to change the 

original way that they look. So text, for example, is normally black and it’s a certain size and a 

certain font. You’ll want to change those and that’s called Formatting. You’re going to see that 

when we get to module 4 that’s where we’ll talk about formatting that paragraphs take on. But 

for now we’re going to talk about character formatting. 

Now this is section 1 and I want to start this module with talking to you a little bit about the 

AutoCorrect feature and some of the options available with it. So let me go ahead and flip over 

to a blank document and I’ll show you what I’m talking about. 

There are certain things that are part of what we call the AutoCorrect feature and let me show 

you what a few of those things are. One of the most common things is that there are certain 

words that if you misspell them it will spell them correctly for you. The word The is a great 

example. If I spell it T-E-H and watch when I hit the Spacebar it spells it correctly for me. Can is 

another one. A-C-N. If I spell it that way it’ll spell it correctly. That’s because when I show you 

the AutoCorrect feature in a few minutes you’ll see that if it’s a commonly misspelled word 

there’s a list of those in here and if it’s in that list it’ll change it for you.  

Here’s a couple of other things. Fractions. If I type ½, for example, notice how when I space it 

looks like ½ or ¼. Fractions are another part of AutoCorrect. How about an ordinal? Do you 

know what an ordinal is? An ordinal is the word 1st, like this. When you space the S-T becomes 

superscript is what they call that. 2nd, that’s another good example. Also hyperlinks. So if you 

typed any email address or any website what’ll happen is once you get that email address or the 

website types and you space it’ll become a hyperlink automatically. That means that I can take 

my mouse and see how when I point to the word it says Control-Click to follow the link. That 

means if I hold the Control key and I click I’ll actually go to that particular website because it’s a 

hyperlink.  

So I’m going to go ahead and delete some of this stuff. By the way, Control and the letter A will 

select everything and then I’ll just hit Delete on the keyboard. We’re going to be looking at 

selecting text in the next section. So just know for now Control-A selects everything. 

Here’s some other things that are part of AutoCorrect. If I type three dashes from my keyboard 

like this and I hit the Enter key notice it gives me a straight line all the way across. So if I need 

several of those I can do that several different times and I have several lines. And what’s really 

cool about this is you can type on these lines. See that? Otherwise if you had types the dash like 

a lot of people do, the dashes just move over and it’s a big mess. So I’m going to go ahead and 

select all that and delete it. And here’s how you type bold lines. You’re going to do underscores. 

Hold Shift, hit three dashes, let go of Shift, and Enter. And now you have a bold line.  
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Now there are some other lines you can put in here as well. If you look at the numbers across the 

top of your keyboard all the symbols aren’t going to work but a lot of them will. So like if I’m 

holding Shift and hitting the pound symbol, which is over the number three, and I hit the Enter 

key notice I get this particular line or border as it’s called. Another one are the stars. If I’m 

holding Shift and the 8 has a star above it, if I do three of them notice I’m going to get this 

particular one. So that’s kind of cool how that works. You can just have some really just neat 

effects within your document. Now let me go ahead and delete all of this. 

I want to take you in and show you where the AutoCorrect features are and how you can make 

use of some of this.  

If you click on the File tab and go down to Options. Under the Proofing on the left you’re going 

to see AutoCorrect Options right here. Now when I click on this what you’re going to notice is 

that here is some things that are checked automatically. That means Word will do these things 

automatically for you. For example, I am famous for typing two capital letters at the beginning of 

a word. Microsoft Word will make the second letter lowercase. Also it will capitalize the first 

letter of a sentence for you. And we talked about that way back in module 1. Both of these will 

have exceptions and that’s what this is. So what you’ll see under Exceptions are this is a whole 

list of words you can type with a period and a space and the next word will not get a capital 

letter. If you needed to add one you would type it here and hit the word Add. Also the tab that 

says Initial Caps. There are some times words you want to type that have two capital letters at 

the beginning, like IDs is a prime example. But if you find one you want to add type it here and 

hit Add. Okay. You’ll also see that when we start working with tables in a later module it will 

capitalize the first letter of anything in a table cell. Days of the week automatically get a capital 

letter and also notice Correct accidental uses of the Caps Lock key. If you’ve got the Caps Lock 

key turned off it’ll flip it for you. 

Down at the bottom it looks like a list of symbols. You’ve probably seen people type the smiley 

faces in emails and things. This is how they type it and then on the right is how it appears. But if 

you keep coming down the list you can see it’s a list of commonly misspelled words. The 

misspellings on the left, the correct spelling on the right. So if you type any word this way it will 

appear the way you see it on the right.  

Here’s a couple of ways you can make really good use of this feature. You may have some 

words that you consistently misspell wrong and you spell it wrong the same way every time. Go 

ahead and type in your misspelling on the left and your correct spelling on the right. You can 

also do things like this. If you have to type your name a lot at the bottom of a letter put in your 

initials. Let’s say your initials are S-H. Over here type out your full name just like you want it to 

appear. And so you’ll hit Add. Don’t get too hung up on these initials. You don’t need periods, 

capital letters, any of that stuff. So I’m going to click OK all the way out and show you that 

when I type S-H and I space it puts in the whole name. So that’s a great way to use the 

AutoCorrect feature.  

I’m going to go back to File and click on Options again and when I go to Proofing and back to 

AutoCorrect notice that if I want to take my initials out I’m just going to type it on the left and it 
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will appear in the list here and I can just hit Delete this way. So that’s a great way to go ahead 

and make use of that AutoCorrect feature.  

Now I wanted to show you a couple of other quick things. Notice this AutoFormat As You Type. 

A couple of things I mentioned to you when we were typing in that blank document. I had 

mentioned the fractions. We had typed ½, ¼. I didn’t mention this top one. What Straight Quotes 

means is when you type quotation marks they have straight lines versus smart quotes have little 

curly-cues on the end. Bold and Internet with real formatting. That one is not on here and you 

may not ever use it but if you wanted a word to be bold automatically you just type a star, 

whatever the word is and a star and that word will be bold. Here’s your Internet and network 

pass with hyperlinks. That’s when I showed you how to type in the website and it would 

automatically make it a hyperlink. Here’s your Ordinals we talked about. And I was showing you 

also those dashes that would give you the straight lines. That’s this one. If you happen to try 

some of those things I talked about and they don’t work for some reason check and see if they’re 

turned on in here.  

That’s really the big things I wanted to tell you real quick about AutoCorrect. I’m going to go 

ahead and click OK there. Just know you have AutoCorrect as an option. You’ll see a lot of them 

happen automatically. And then I want to take you over now to section 2 and really start talking 

about selecting text. 
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Video: Selecting Text 

Cindy: Welcome back. We’re in module 3 and we’re talking about character formatting in this 

particular module. Now we’re down on section 2 where I want to talk to you a little bit about 

selecting text. You may have seen text before this highlighted. Well we actually call it selecting. 

Why would you want to select text? Well we have a little saying that goes like this. If you want 

to effect it you’ve got to select it. So think about this. What if you have a document and you’ve 

got one word in the document that you want to make a bold? How would it know which word to 

make bold unless you had it selected? So what we’re going to do is go through several different 

selecting techniques that will help you out and if you don’t remember them all that’s certainly 

okay. Just pick out two or three that’ll really be helpful to you and then that way it’ll make life a 

lot easier as you go along. So let me go ahead and flip over to the exercise and I’ll show you how 

to select your text. 

Before I get started let me just mention that I’ve made a list of all these selecting techniques for 

you. Just look for it wherever you see the Q&A and then you can actually print that out if you’d 

like and follow along. Or if you want to just keep it for reference that’s fine too. 

Let me address the most common selecting technique and that is clicking wherever you want to 

start your selection and dragging across the text like this. That is certainly okay to do. But a lot 

of time what happens is you get an extra word or you didn’t get everything you wanted and so 

it’s not always the best way to select your text. Just so you’ll know, whenever you have text 

selected you’re going to see this appear as well and that’s just a quick way to get to some 

formatting options that we’re going to be talking about a little bit later. Notice they’re here but 

they’re also way up here. This can be turned off in the Options, just so you’ll know. Deselecting 

means clicking away from your selection. And notice it’s not selected anymore.  

The next one I want to mention is selecting one word. To select one word find the word you’d 

like to select and double click in the middle of it. That’s all you have to do. And that word is now 

selected. I’ll deselect that one. 

Another one that’s very helpful is selecting a sentence. Now remember a sentence ends with a 

period. So I’m going to go down here and get this one. I’m going to hold the Control key and 

click anywhere in that sentence one time and notice that sentence is now selected. Be careful 

when you see a sentence like this because this says the goal of Burke Properties, Inc., well 

there’s a period there so that’s not really a sentence. But if I hold Control it’s going to stop there 

because it sees the period at the end.  

Let’s talk about selecting a line. If you put your mouse all the way to the left in the margin area 

this area is called the Selection Bar. If your mouse is in the selection bar it will look like this 

arrow versus how it looks like an I if you’re not in the selection bar. But if you’re in the selection 

bar and you point to the line you want and click one time it selects the whole line. And if you 

need multiple lines click and drag straight down. That is a way to select a paragraph. 
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Some other ways to select paragraphs would be if you’re in that selection bar you can double 

click and you’ll select the paragraph. Or if you’re in the middle of the paragraph tripe click, three 

times, and that’s another way to select a paragraph. So whatever works for you. 

How about this one? I’d like to select from one point to another and it’s not necessarily a 

sentence or a paragraph. It’s just one point to another. Click where you’d like to start, hold the 

Shift key and click where you’d like to end. Shift always selects between two points. Click 

where you want to start, hold Shift and click where you’d like to end.  

By the way, what if you needed to add this word Friends? You forgot it. All you have to do is 

hold the Shift key and hit your right arrow and see how you add to your existing selection? Or 

the left arrow key on the keyboard will take away from your selection. Up and down will get 

another paragraph at a time.  

What if you needed multiple areas selected that aren’t adjacent to each other? All you’re going to 

do is hold the Control key. So I’m going to select the first area, I’m going to hold Control and I’ll 

go grab a second area there and I can grab a third one is I want. But as long as I’m holding 

Control I can select multiple areas.  

The last one I want to mention is selecting your whole entire document and we’ve already talked 

about this one. But if you hold down the Control key and hit the letter A that will select 

everything. That’s your Control-A, Select All. Notice also another way to select everything is 

right up here you’ll Select and it says Select All and that’s under the Home tab.  

So just know there’s multiple ways to select your text and whatever works for you is going to be 

fine. Remember if you want to effect it you’ve got to select it. So make that a habit to select in 

any program that you work in.  

Now that we’ve got that down pat let’s go ahead and start with cut, copy and paste over in 

section 3. 
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Video: Cut, Copy & Paste 

Cindy: Hey there. Welcome back to module 3 where we’re talking about character formatting. 

This is section 3 where I want to go through the cut, copy and paste options with you. Now you 

may have done cut, copy and paste a million times before but there’s something in the Microsoft 

Office products that a lot of people aren’t familiar with and I want to show you why you have a 

little advantage if you’re doing this in a Microsoft Office product. 

Cut, copy and paste actually has four steps and when you learn the four steps you’ll realize that 

it’s going to work the exact same in any program in your computer. Just follow the steps in order 

and you’ll do it perfectly every single time. Here’s the four steps. 

The first thing you’re going to do is you’re actually going to select the information you want to 

cut or copy and the next thing is you’re going to want to choose cut or copy. Now let’s talk about 

the difference. If you cut something you’re actually removing it from where it is and you’re 

going to be able to put it somewhere else. When you do this the information is going to go to a 

holding place in your computer called the Clipboard. There is one clipboard for the whole 

computer, not one per program. Your clipboard you’re going to see is going to hold 24 separate 

items. So I’ll show you how to turn it on once I go through these steps here so you can see how it 

works.  

Step three, you’re going to click the mouse anywhere in the computer you want to put your 

selection. It does not say you have to put it here in Word and it does not say you have to put it in 

this particular document. It could be a website you’re creating or if you wanted to put it over in 

an email. But wherever you click the mouse in the computer that’s where you’re going to be able 

to paste it in. And the last thing is your paste.  

Let me just mention the clipboard real quick. Over here if your Clipboard grouping. Here is a 

way to access your cut, copy and paste options. I want you to notice there’s an arrow on the 

bottom right of Clipboard. This is the actual clipboard itself that you’re going to see. Your 

clipboard will hold 24 separate items. So you’ll actually be able to collect multiple items and 

then paste in the ones you want. 

Remember step four said to paste? Well if you right click and paste or use this paste you’ll 

always paste the last thing that you put on the clipboard. If you’re trying to paste something 

specific from the clipboard paste it by clicking on that particular selection from the clipboard 

here. Now let me just say that only the Microsoft Office products have the ability to turn on this 

clipboard and pick and choose what you’d like to pull in. So if you’re working in some other 

program in your computer you can do cut, copy and paste but you can only paste one thing at a 

time. 

Let’s go ahead and do this exercise so you can see how the four steps work. 

We’ve got two paragraphs here. We’ve got Thank you for inquiring about a Burke listing and 

Also by realizing our goal right here. And I’d like to switch these. The first thing I’m going to do 

is select the information I want to cut or copy. So you can see that I’ve got this selected and I’m 
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going to actually cut because I want to remove it from where it is. Now to cut I can right click 

anywhere in the highlighted area and notice that my option is here or I showed you earlier you 

can cut right up here. Either one is going to work fine. I’ll go ahead and choose Cut. Notice it’s 

gone from my document but it’s on the clipboard. Now even if you’re not showing the clipboard 

it’s still there.  

So step three is I’m going to click my mouse where I want to put it. I’m going to put it 

underneath Dear Mrs. Lee right here. And notice that I can right click and I can paste or I can go 

up here and paste, either one. Now remember what I said a few moments ago that if you right 

click and paste it’s always going to let you paste the last thing you put on the clipboard. If I want 

something specific I’m going to click on it from the clipboard like I’m doing right now. And see 

how it just appeared? So just remember that you can always paste from the clipboard or by right 

clicking and choosing Paste. 

I want to show you one other thing that you could have done in a situation like this. Sometimes 

you’re going to hear some terminology like Move. People say, “I’m going to move that 

selection.” This is what they’re talking about. If I had this selected I could just click right in the 

highlighted area and drag up to where I’d like to drop it off and there it is. And that’s the same 

end result as cut and paste. Notice it did not go on the clipboard when you do that. So if you 

don’t have a need for it to go on the clipboard that’s fine. The trick for copy, just so you’ll know, 

is as long as you’re holding the Control key and you do the exact same thing, so I’m going to go 

ahead and make sure I have this selected, I’m going to hold Control, click anywhere in my 

selection and notice when I drag down, I’ll just go way down to the bottom here, that when I let 

go that’s where it’s going to be. So just know that those are options as well. 

That’s how you cut, copy and paste. Now that you have that down pat let’s go over to section 4 

and really get going on some of these character formatting options. 
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Video: Character Formatting Options 

Cindy: Welcome back. We’re working in module 3 and we’re talking about character formatting 

in this particular module. This is section 4 where I really want to get into some of those character 

formatting options with you. 

We’re here in our exercise and you’ll notice that when you look through here there’s a title at the 

top, there’s a couple of little subtitles, Buying a Home, Selling a Home, but nothing really stands 

out from anything else here. That’s because when you first type in your text in Microsoft Word 

you’re going to have black text, it’s all going to line up on the left hand side. It’s all the same 

size. When you start changing the original characteristics that’s called Formatting and that’s 

what we’re going to do. We’re going to make some of these things stand out a little bit. 

Let’s start with our title. I’m going to go ahead and select the title here. And let’s start with your 

font grouping right here. The first thing you’ll notice here where it says Times New Roman in 

this case, this is what we call your Font list. And fonts are just different ways the letters look. 

You’ll notice that if you move your mouse over the different fonts, you don’t even have to click, 

it’ll show you a preview of what it’s going to look like if you pick that particular option. You 

have tons of them here. So make sure you pick something that you like. If you choose something 

and later you decide you want to change it you can always change it. So I’m going to go back up 

here. I happen to like this Algerian.  

The default font, by the way, meaning the one that’s there usually automatically when you start 

typing is called Calibri.  

The next thing you’ll see here is where this 12 is. That’s going to be the size of your text. That’s 

your font size. When we talk about fonts we’re referring to point size. So 12 stands for 12 points. 

You’ll notice this list goes all the way down and it stops at 72. A little piece of trivia. 72 points is 

equivalent to one printed inch. What if you want a number that’s not on this list? All you do is 

type it up here, so as long as this is selected, you can type any number you want. Let’s say I put 

200 and you hit the Enter key, look how big that is, but it gives you what you want. Let’s say you 

want a half size, 15.5 and Enter. Now I have that size. So you don’t have to stick with exactly 

what’s on the list.  

Something else that happens often is you pick something from the list and it’s too big and then 

you pick something else and it’s too small and you don’t get the exact size you’re looking for. 

These two A’s that you see right here will increase or decrease your font by one size on that list. 

So that’s really helpful.  

Here where you have the large A and the small A, this is where you can change the case of your 

letters. Sentence case means the first letter is capital and everything else is a small letter. 

Lowercase is all lowercase. Uppercase is all uppercase. Capitalize Each Word, that’s where each 

word, the beginning letter, will have a capital letter. And then Toggle, if you’ve ever had the 

Caps Lock key on you can flip the case of each of the letters. So just know that’s all available. 
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On the bottom line you have B for Bold, you have I for Italics and U for Underline. So you can 

see that you can turn any of these on or off that you like. Notice with the underline there’s an 

arrow so you have different choices as far as how you want your underline to look as well.  

The next one is your Strikethrough. You would use that a lot if you work with contracts, for 

example, and you need to change the contract. You wouldn’t actually delete the old information. 

You would actually strikethrough the old information and put the new information to the right.  

These two X’s that you see right here, these are actually called Subscript and this one’s called 

Superscript. Subscript if you think about H2O where the 2 is below the H and the O, that’s a 

good example of subscript. And superscript like you see here, a good example of that would be if 

you think about MattelTM toys where they put that little trademark, the TM up at the end of the 

text there. That would be superscript. 

Alright a couple of these we’re going to skip over. We’re going to go over to this one here and 

this is your font color. So the text can look any way you like. Let me go back and take the 

strikethrough off. Here you go. So I could have any color I like for my text. I can also create my 

own color. So if I don’t see a color I like in this color palette, see where it says More Colors? I 

can click on that and pick from the standard color palette or come to Custom and create my own 

color by dragging through the color palette. Wherever this arrow happens to be that’s going to be 

the new color you create. 

Now this one here is your highlighting tool. So if you think about when you actually print out a 

piece of paper and you grab your yellow highlighter and you highlight something, that’s what 

this is. And I can highlight in any color that I would like.  

If you’re looking for an option and you don’t see it here there might be more options when you 

click this arrow on the bottom right. So let’s click there and see if we see anything new. Here’s 

our font. So we could do that from the ribbon. Here’s our bold and italics, our font sizes. Nothing 

new yet. Font color, underline style. So we saw that when we actually clicked on underline there 

were different styles we could choose. If you’ve chosen an underline style you can then pick an 

underline color. So that’s something we did not have the option to do earlier.  

Down at the bottom I have some checkboxes. We’ve seen strikethrough. We have not seen 

double strikethrough. That’s not a button that was on our ribbon there. Here’s super and 

subscript. Over on the right we have Capital letters but they’re Small. We’ve got All Caps which 

are just all capital letters regular size and then Hidden Text. And let me show you what hidden 

text is. I’m going to check Hidden and click OK. If you notice your title’s hidden. Now what’s 

the point of this? Hidden text becomes part of your non-printing characters. So that means the 

only way you’d ever see it is to turn on your non-printing characters, like this. Why would you 

want that? Well here’s a couple of good reasons.  

One time I was working on some materials and with permission I was able to go to some 

different websites and get some different information and copy it. I wanted to actually know on 

each page where I got that information from. I wanted the web address in the footer. Well I 

obviously didn’t want the students to see that so I actually put the website in the footer and I 
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made it hidden. And that way I know it’s there but you don’t. So that’s a really good example of 

it. And you can find your own examples for that as well. 

So I’m going to select it again. I’ll turn these off. I’m going to go ahead and select it again. And 

by the way, even though I don’t see it here it’s still there. Okay? So I’m going to go ahead and 

select it this way just so you can see what I’m doing. I’m going to uncheck Hidden.  

Now a couple of more things before I get out of this window. I just want you to notice this Set as 

Default. A very common thing that people say to me is, “I’d like to start typing a new blank 

document and have it start typing in a specific font or a specific size.” Well if you change any 

settings here and you Set as Default then that’s going to be the new settings when you create a 

new blank document.  

I’m going to go ahead and take off my underline color here. I’ll just make it white again and I’ll 

pick out my underline style and I’ll click OK. And now let me turn these off and you can see that 

your title is here again. Now if you ever wanted to take the highlighting off just select it and 

remember here’s your highlighting tool. Just say No Color. That’s how your character formatting 

options are going to work.  

What I’d like to do now is I want to go ahead and real quick talk to you in section 5 about how 

the Format Painter works because you’ll want to copy this formatting sometime to other areas of 

your document. I’ll see you shortly. 
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Video: Format Painter 

Cindy: Okay we’re in module 3 where we’re talking about character formatting and we’re all the 

way down on section 5 where I want to talk to you real quick about the Format Painter.  

Format Painter is going to be one of your best friends in any program that you work in because 

it’s going to allow you to copy the formatting, not the text or the numbers. So let me show you 

how this works. 

When we were in section 4 we had gone through and talked about some of the character 

formatting options and we actually played with our title a little bit. If I wanted to actually make 

Who We Are look just like my title as far as the formatting I don’t really remember everything I 

picked. I might could go through and try to replicate it but it’s much easier just to copy the 

formatting from the title to our subtitle. So let me show you how that’s going to work. 

I’m going to select the title and I’m going to use this button here that says Format Painter. And 

notice when I do that that now my mouse has a little paintbrush attached to it. So be careful 

where you click because where you click that’s where it’s going to copy it to. So all I’m going to 

do is get out in the left and I’m going to select Who We Are and you’ll see a copy of the format 

exactly. Isn’t that cool?  

Now I’d like to do the same thing with Buying a Home, Selling a Home because those are little 

subtopics as well. I’m going to go back and select Who We Are. I’m going to turn on the Format 

Painter and I’m going to click on Buying a Home. Now here’s the thing. Did you notice that it’s 

now turned off? Once I pasted my formatting in then I have to go through and go through the 

whole process again. Here’s a little trick that will help you out. So I’m going to scroll down a 

little bit. When you’re first turning on the Format Painter double click it and that way it will stay 

on until you turn it off. See? And all you’d have to do to turn it off is either hit Escape on your 

keyboard or you can go back and click on Format Painter. 

You’re going to love Format Painter. Just remember that it’s there and the double clicking is 

going to make it stay on until you turn it off.  

Let’s go ahead and head over to section 6 and talk a little bit about working with numbers. 
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Video: Working with Numbers 

Cindy: We are working in module 3 and we’re talking about character formatting in this module. 

We’re all the way down to section 6 where we’re going to talk about a little bit about working 

with numbers. You’re going to have times when you have different lists that you’d like to 

number and sometimes you want a number 1, 2, 3, sometimes you’d like to number using the 

alphabet. There’s different ways you can number. You’ll also be able to number paragraphs. So 

let me show you a little bit about how numbering works. 

I’m here in a blank document and what I’d like to do is go ahead and create a list so that I can 

number the list. I’ll start with Allen, Bob, Carol, and Doug. Now I’m going to go ahead and 

select my list and what I’d like to do is come up to the Numbering button which is under this 

Paragraph grouping. You can see the Numbering button right here. And I’ll just click on it and 

you’ll see now that my list is numbered. If I click after the last name and I hit the Enter key 

notice I get the next number in the list. And as long as I’m typing something next to it then I’m 

going to keep getting the next number.  

Let’s say I’m on number 7 here and I decide I don’t want this number 7. I can do a couple of 

things. I can use the Backspace key on my keyboard or I can go up and turn off the Numbering 

button. I did not have to create the list first. I could have actually turned on the numbers before I 

ever started and then it would work the exact same way.  

I’m going to go ahead and select my list again, and by the way when you select your list you’ll 

notice that it doesn’t select the actual number on the left. That’s okay. It knows whatever you do 

that it’s going to affect the numbers and not the text next to it. There’s going to be times when 

you want to number based on the alphabet. Maybe you want ABC’s or maybe you want Roman 

Numerals, 1st, 2nd. There’s different ways you can format the numbers. You’re going to find 

those formats back under your Numbering button there’s an arrow to the right. First you’ll see a 

list of the recently used number formats at the top. So if you needed to access one of those again 

you could. And then you’ll see the Numbering Library. The first option in the numbering library 

is None. That’s how you’d actually turn off the numbers. But notice here’s some other choices I 

could choose. Here’s my ABC if I want, here’s my Roman Numerals. Let’s say I go with ABC 

for now and you can see now that they’re numbered with the alphabet.  

Let me show you a couple of other options you’ve got with numbering. At the bottom of this list 

just notice the Change List Level. We’re actually going to look at that when we get over to 

section 8 because that’s where you work with outlining. Let me go ahead and click on Define 

New Number Format. 

Here’s the current number style you’re using and you can see a preview of it right here. If you 

want to choose another number style you can choose from the dropdown list. And some of these 

are new. They were not under the library that you were looking at earlier. So here you can see 

01, 02, 1st, 2nd.  

Let’s say you want to change your font. These are all of your font options. So you could have 

bold if you wanted or if you wanted a larger size or red numbers, for example. All those same 

http://www.simonsezit.com/


Learn Word 2016 

© Copyright 2008-2017 Simon Sez IT, LLC. All Rights Reserved. 
 

options we looked at for fonts you can do with the actual numbers themselves. You’ll notice 

when I click OK now I have red letters over here or numbers as you want to call them.  

Let me go back into Define New Number Format and just mention this alignment. Your options 

are Left, Centered or Right. Notice if you have Left chosen that your numbering system is to the 

left of your actual text. If you choose Center it’s still on the left but it’s in the center of that 

space. And then you’ve got the option to put it right.  

Another option that you have under the numbering is to set the numbering value. What if you 

have a list but you don’t want to start with A? I can put any number that I like in there. Let’s say 

I put J in there and click OK. And notice now my list starts with J. And that would be the same 

thing with numbers. If you 10 it would start with 10.  

One more option under the Set Numbering Value, Continue from previous list. Here’s what this 

means. If I have a list already here and then let’s say I put a paragraph of information and start 

the list again underneath that paragraph. I can say Continue from the previous list and what it 

will do instead of starting with O it’ll start with P way down here. So it’ll continue from the 

previous list, however you had it numbered.  

Those are just some of your options you have with your numbering. I mentioned that you could 

also number paragraphs of information. So let me show you how that’s going to work. I’m going 

to go ahead and flip over to my Burke Flyer and show you with that exercise. 

Back in Burke Flyer we had several little topics here where we had a couple of different 

paragraphs, like this one here, Buying a Home. Remember that Word considers a paragraph 

anywhere there’s a paragraph marker at the end. You’ve hit the Enter key. Let’s say that I 

wanted to number these three right here. I would do the exact same way. I would select them, go 

up to my Numbers, and now they’re numbered.  

You can also number paragraphs. If you look down here at this one where it says We’re Growing 

there’s three paragraphs here. What if I selected those and turned on the numbers? Notice it 

didn’t number this line number two and this line number three and that’s because it’s looking 

again for the Enter key or that paragraph marker at the end. So just know that you can number 

paragraphs as well. I’m going to turn that one off. 

That’s how your numbering works. I want to go ahead and show you how bullets work as well 

because they’re just like numbers except they’re little pictures. So I’ll join you over in section 7. 
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Video: Working with Bullets 

Cindy: Hey there. We’re back. We’re still in module 3 where we’re talking about character 

formatting. We just got through talking about how to work with numbers. I want to show you 

now how to work with bullets.  

Here’s the list we were working in earlier where we had numbered the list but I want to go ahead 

and change these all to bullets. So I’m going to go ahead and select all of these and next to your 

Numbering button is your Bullets button. Normally the very first time you use the Bullet option 

you’re going to get these round black circles like you see here. If you want to change that there’s 

an arrow to the right of it where you can pick from the recently used bullets or you can look 

through the Bullet Library. Notice in the Bullet Library you’ve got None again. So that’s how 

you would take the bullets off. And these are the last few that were used in your computer. If you 

really want to go and see where all the bullets are you’ve got some options down at the bottom 

here. Let’s go down to the Define New Bullet Option. 

You have a couple of options as far as choosing bullets and you can actually choose them from 

the Symbol or the Picture option that you see here. I’m going to start with Symbol.  

This is a list of all the symbols that you could use. Notice use the scrollbar on the right to go look 

at all the symbols. But also notice the different font lists. You’ve got tons of them here. And your 

actual bullets can come from any of these lists. Most of the neat little pictures are going to be 

under the Webdings but again you could pick from any of these. So you can see all the neat little 

pictures you have here. I’m going to scroll down and I’m going to find this kitty cat. And I’m 

going to click on that and click OK. And when I click OK out of it notice now I have kitty cats 

for my bullets.  

I’m going to go back into the Bullets for a moment. So you can work with the symbols. You can 

also work with the Picture option. Under the Picture option you have the ability, if you want, to 

find a file that’s already on your computer and use that as your bullets or you can do a Bing 

image search. So if I wanted to I could go out and say Pictures of dogs and I’m going to get a ton 

of different pictures of dogs. But if I find one I like that might be a good bullet I can use that. 

Let’s say, for example, I use this one here and I choose Insert. And now when I click OK that 

picture I just looked up on the internet is now my bullet.  

I’m going to go back into the Bullets here and the next thing I want to mention is the fact that 

when you’re using a symbol or a picture sometimes you can change the font. So let’s say I 

change this back to some symbol. I’ll go back to my Webdings. And let’s say that Wingding so 

I’m going to go to Webdings. It has neatest pictures. This time I’ll just use this one here. It looks 

like a boom box. And I’ll click OK. I want to change the font for this. So I want to make it a little 

bit larger and I want to change the color. Now when I click OK and click all the way out I have a 

new bullet and it’s a lot larger now and also it’s blue. 

Those are some of the quick things you can do with your bullets. I did want to mention one more 

just quick, odd thing. You might have seen something like this before. I’m going to come down 

and say, “Our telephone number is”. And you’ve probably seen people put a picture of a 
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telephone right here. They’re going to use the same list you’d look at with bullets except they’re 

going to insert it as a symbol. Here’s how you do that.  

Under the Insert tab you’re going to notice all the way to the right it says Symbol. And notice the 

first few are the ones that we just used. I can go down to the More Symbols and notice this is the 

exact same list of fonts. If I go to Webdings again where I am I can pick any of these same ones 

we’re already familiar with and I can use that as my actual symbol. So I know there’s sort of a 

telephone in here. This one here. I’m going to click Insert and notice now if I just move this out 

of the way I have one instead of a list of bullets. This is treated as a font. So if I select it then I 

can change the color, I can change the size, any of that stuff.  

Notice a couple of other things in here. You can add this to you AutoCorrect and you can also 

create a shortcut key. That’s all there is to working with bullets and in this case symbols as well. 

We’ve got one more section in this particular module, Creating an Outline. So I want to go over 

that with you because we’re going to use numbers and/or bullets to do that as well. So I’ll see 

you over in the section 8. 
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Video: Creating an Outline 

Cindy: Alright we’re down to the last section of module 3. This is going to be section 8 where 

we’re going to talk about creating an outline. An outline will allow you to show the order of 

importance or the hierarchy within your document if you have different topics. So you may want 

to use bullets to create that outline or you may want to use a numbering system. Let me show 

you how an outline is going to work. 

I’ve got my list of names again and I’d like to actually turn these into an outline. I’d like to have 

each of these names as a first level in my outline and then say something about each person as a 

second level. I’m going to go ahead and turn the numbers on. Now notice if I’m clicked after the 

first name in my list and I hit the Enter key I’ll get number two, and notice everything else 

shifted down. But I really want to have a second level so I can say something about Allen. What 

I’m going to do is hit the Tab key.  

Some terms to get familiar with. When you go from a first to a second level or second to third, so 

you go down in levels, then that’s called Demoting. If you go up in levels that’s called 

promoting. You always use Tab to demote and Shift-Tab to promote. Now that I have my A here 

I can say something about Allen. I can say he was voted top employee in 2015. Notice if I Enter I 

stay on the same level. He was also voted top employee in 2014. Again I’m going to enter I have 

number C. now I’d like to make this a first level again so I’m going to hold the Shift-Tab and 

that’s going to go back to the left. So Tab goes to the right and demotes, Shift-Tab goes to the 

left and promotes. If I don’t want this 2, for example, I’m just going to backspace over it and I’ll 

get back up to where my insertion point is behind the 2014 like this. So again I can do the same 

thing with Bob. If I hit the Enter key first and then tab over I can say something about Bob if I 

like. 

Let me show you how this is going to work when you already have paragraphs in place. Let me 

flip over to our Burke Flyer. I’ll just switch windows here.  

Let’s say that we have this Who We Are, Buying a Home, Selling, those are more like our first 

levels that we’ll have and then we can have second levels underneath. I’m just going to select 

from Who We Are and I’m going to select all the way down to the end of We’re Growing here. 

Now I want to turn this into an outline. Instead of turning on the numbers like I did notice the 

next button over is your Multilevel List. It lets you create an outline. I’m just going to click on it. 

Again here’s the current list which would have a number as the first level and a letter as a second 

level. You can see that all the way down. Here’s where I turn it off in the List Library and then 

here’s some additional choices I could pick from. I’ll just stick currently with the one we’ve got 

and now you’ll see that it’s all numbers. It doesn’t recognize that this should be little A because 

it’s all on the same level. So I’m just going to click there and hit the Tab key. See that? And if I 

come down underneath Buying a Home I can make each one of these a second level. See that? 

Same thing with Selling a Home. I had three different ways to sell a home and then one under 

We’re Growing. So you can always use that to create an outline as well. It’s not going to make 

this line B and this one C because there’s no Enter key. The Enter key is at the end of this word 

Deserve here.  
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Now let’s say that you didn’t want to use this numbering system. Maybe you’d like to use 

something different. You just saw under the Multilevel List that you had several you could pick 

from, including bullets. So let me go ahead and show you how to actually change the number 

format for these different levels.  

First let me mention the Change List Level. Whichever level I click on it’s going to change all of 

the levels to that particular format. So if I chose this one, for example, they’re all on the same 

level now but they have the same format. So I really didn’t want that. I’m going to undo. What I 

can do is I can come down to where it says Define New Multilevel List. Here are where the nine 

levels are listed. And the way this works is whichever level you’re wanting to change you click 

on that level. Let’s say for level one I wanted to have Roman Numerals instead. This is the 

current format. So I can come down to the Number Style for this level and I’m going to pick the 

Roman Numerals. I’d also like to change the font size. I’d like to make it a different size. And 

I’d like to make it a different color. I’m going to click OK and I’m going to click OK out of it 

and now notice only level one has changed to the Roman Numerals.  

Now I’d like to change my second level. So I’m going to go back to the same place, Define New 

Multilevel List, I’m going to click on level two and change that style. I’ll just pick the small 

Roman Numerals. Notice some other options I have. I can include the level number from, level 

one if I want. I can also change the number alignment which we’ve talked about and that’s the 

left, centered or right over in the space over here. And also I can change the alignment and the 

text indenting which has to do with where the number is lined up in relation to the ruler and the 

text is lined up in relation to the ruler.  

I’m going to go ahead and click OK and now look at my second levels. So you see you can go 

through and change each level to make it look any way you’d like.  

That’s a quick overview of how the outlining is going to work. What I’d like to do now is we do 

have a practice exercise I’d like you to work on so I’m going to go ahead and meet you over in 

section 9 and I’ll show you what I want you to do there. That’ll wrap up module 3. 
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Video: Module 3 Practice Exercise 

Cindy: Well we’ve made it all the way down to the end of module 3. We’ve been talking about 

character formatting in this particular module so I wanted to make sure that you’re okay with 

everything we discussed before we go on into module 4 where we talk about paragraph 

formatting. So let’s go through this exercise real quick so you’ll know exactly what I want you to 

do for me.  

The first thing I want you to do is create a new blank document. Go ahead and make a list of the 

top ten things you want to accomplish this week. When you’re finished number that list. Now if 

you want to play around with some different numbering formats feel free but you need to know 

how to number a list. Once you know how to do that go ahead under each level one item as I call 

it and add a second level which talks about the first one. Remember this is where you’re going to 

use the outlining skills we discussed. You’re going to use the Tab key to demote and the Shift-

Tab to promote. And remember to always enter first before you use Tab or Shift-Tab to get those 

second and third levels.  

When you’re finished with that go ahead and go into the AutoCorrect options. Add an entry to 

the list so that you can type your initials in any document and your name will appear. Close the 

file when you’re done and you really don’t need to save it. Remember that when you put your 

initials in the AutoCorrect feature it’s in Word. It’s not in this file. So you’ll be able to use it in 

the file that I’m going to have you open next. 

Now I want you to open a file called Practice Presentation 3. Practice different selecting 

techniques that we discussed. And if you’ve forgotten some of those you should have a 

document attached here called Selecting Techniques that you can refer to just for a refresher. 

Next I want you to practice using cut and paste. So what you’re going to do here is you’ve got 

some text in the first paragraph. You can see that text here. And when I go to the next slide 

you’ll see the text in the last paragraph here. And I want you basically to switch those using cut 

and paste. 

At the very bottom of that document you’re going to see a name, Heather LaPierre. I want you to 

select it and then replace that name with your name. Type your initials, the ones you put in the 

AutoCorrect feature, and then your name will pop up.  

Go ahead and save and close this file when you’re done. And if you want to do a Save As use the 

file name My Practice Presentation 3. Once you get done that’s going to be it. 

Whew we did a lot of work in this particular module so you should feel good about yourself if 

you’ve gotten through this one. Let’s go ahead and head over to module 4 and we’re going to 

talk about paragraph formatting. 
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Module 4 – Paragraph Formatting 

Video: Alignment Options 

Cindy: Hi there. Welcome back. It’s Cindy again. We’re now in module 4 and this is where 

we’re going to talk about paragraph formatting. Now in module 3 we talked about character 

formatting and that’s where the individual letters or numbers were formatted. Now we’re going 

to talk about formatting the whole paragraphs take on like line spacing and denting, tabs, things 

like that. Let’s go ahead and get started with section 1 where I want to work with alignment 

options. 

We’re back in our Burke Flyer again and you’ll notice again there’s no formatting here and 

everything is what we call Left Aligned. So you can see it lines up nice and neat on the left hand 

side but not on the right. And by the way, notice you won’t have any hyphenated words at the 

very end on the right unless you choose that option. It just normally if an entire word won’t fit on 

a line it take it to the next line.  

Let’s start with some basic alignment. I have this title and I’d like to center it. Under the 

Paragraph grouping here’s your Center button. Notice that’s going to put directly in the center of 

your document from left to right. I could also use Left Align if I want to move it back to the left. 

I’ll put it back in the center.  

This third one is what we call Right Aligned. Let’s say I take the whole document, I’ll use 

Control-A to select it, and I choose Right Align. Notice everything lines up nice and neat on the 

right but not on the left.  

This last one I want to show you is Justify and that’s basically where you have like block style 

writing. So you’ll notice when you look at Justify it’s nice and neat on the left and nice and neat 

on the right. What it actually does is puts a little more space between some of the words. So you 

can kind of look right here and you can see there’s a little more space than normal. But that’s 

what Justify is, when it all lines up nice and neat. So sometimes you’ll want to take your whole 

document and align it and other times, like now, if I want it to be justified but the title needs to 

be centered I select just the title and center that. 

That’s how your alignments going to work.  

Let’s go ahead and take a peek at how the line spacing options work because you’ll use 

alignment when you’re working with line spacing as well. 
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Video: Line Spacing Options 

Cindy: We’re still working in module 4 which is the Paragraph Formatting module and we’re 

now on section 2 where I want to discuss line spacing options with you. There’s going to be 

times when you want to have more or less space between the lines. So let’s go ahead and talk 

about how that works. 

One of the things that we’ve already noticed is that when we start typing in a blank document the 

spacing is not exactly single space. Let me go ahead and put a few things in here. Let’s go ahead 

and put in Draft Report. And I want you to notice that when I hit the Enter key it looks like it’s 

double spacing. Now the reason that they’ve done this with Word 2007 and higher is because in 

the older versions what most people would do is they would hit the Enter key twice to get that 

extra space in there. And now you don’t have to do that. They kind of built that in for you. 

You’ll notice that when you have line spacing it’s going to be set at 1.15. Now here’s how we 

know what it’s currently set at.  

When I go to the Home tab here’s the Line Spacing option right here. It’s usually set on 1.15. 

you’ll see a checkbox to the left of whatever setting it’s currently on. Also notice because it says 

Remove Space After that’s how you know there is extra space when you hit the Enter key there. 

So those two options are set automatically when you start typing in a new blank document.  

Now I want to flip over to our Burke Flyer we’ve been working with. So let me go back to the 

View tab and I’ll go back to Switch Windows, Burke Flyer. Let’s check out this document. So if 

I’m clicked anywhere in a paragraph and I go back to Home the line spacing now is set at single 

spacing. And notice there is no space after the Enter key. These are your different choices. When 

it says 1.15 that’s actually a 15% increase. So it’s not 1.5. It’s just an extra 15% greater than 

single spacing. That actually makes it a little bit easier to read.  

You’ll notice that if you’re clicked in a paragraph then whatever you do will affect that one 

paragraph only. See that? If I have the whole document selected then whatever I do is going to 

affect the whole document.  

So here’s 1.15. It makes it a little bit easier to read. 2.0 will be great if you needed to put some 

notes in between, especially if you’re going to have handouts for your audience. And you can see 

it just gets a little bit more spacing as you go down. 

You have this option called Line Spacing here I’d like to look at and a couple of things in here. 

First of all under General here’s your alignment where you have your left, centered, right, and 

justify just like we had up here. Also if you’re working with outlines you can work with 

whichever level you happen to be working on. We’re going to be talking about indenting in the 

next section. So let’s look down here at Spacing.  

You have the ability to add some extra space before or after the Enter key. When it’s set on 1.15 

there was extra space after the Enter key. You probably don’t want to have space before and after 

because then you really double up on your space in there. It looks really wide. Over here is 

where I can say that I want to use single space, 1.5 which is 1-1/2 lines or double. I can also say 
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At Least, Exactly or Multiply. So if I wanted exactly let’s 13 points I can type it over here like 

this and I’ll have exactly 13 points when I hit the Enter key each time. So just kind of notice that 

those are some of your line spacing choices there. There’s also a Preview at the bottom but it’s a 

little easier to preview it out here. 

If you have options you want to set as default, so sometimes people will ask me, “How do I set it 

back on single space and if I wanted to put it back on just 1.0 spacing? How do I do that?” Well 

you would choose those options and hit Set as Default and that way when you create a new blank 

document it would have those choices for you already. 

That’s how your line spacing is going to work right there. Pretty easy to work with. 

Let’s go ahead and move over into the next section and we’ll talk about working with indents. 
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Video: Working with Indents 

Cindy: Welcome back to module 4 where we’re going through and talking about all the different 

options as far as formatting your paragraphs. This is section 3 where I want to talk to you a little 

bit about working with indents. 

There are going to be times when you want to indent the left side of a paragraph. Normally you’d 

hit the Tab key to do that but notice that that will actually only indent the first line and only 

indents it at the half inch mark. You’re going to want to indent the whole thing or maybe you 

want to indent both sides. So let me show you how the indents work. 

Normally if you were in a paragraph and you wanted to indent the first line you would just hit 

the Tab key on your keyboard. That’s certainly okay to do. Tab stops at every half inch on the 

ruler. So if you look at your ruler you’ve got this top indent here called a First line indent and 

you’ve indented the first line at the half inch mark. That’s not going to help very much if you 

wanted to indent this line at ¾ of an inch or it’s not going to help you if you wanted to indent the 

whole left side of that paragraph. So that’s where the indents are going to come into play. Here’s 

how they work.  

The top one, the arrow that points down is called a first line indent. It will indent the first line of 

every paragraph you have selected. So let me show you how that works. I’m going to select these 

top two paragraphs and I’m just going to pull this over to ¾ of an inch like this and now both 

paragraphs the first line only is indented at ¾ of an inch. Alright let me undo that one. 

The next one I want to show you is the arrow that points up right here. That’s called a Hanging 

Indent. That means that the first line is going to stay and everything else is going to be indented. 

So I’m going to grab that one. Notice I’m not going to grab the square on the bottom because the 

square on the bottom will move them both. But see how the first line stayed and everything else 

is indented now? Can you think of a good example of a hanging indent? How about numbers? I 

don’t know if you noticed but when we typed in numbers that created a hanging indent. Let me 

show you that real quick. 

I’m going to go to File and create a new blank document for a second. We had typed in four first 

names earlier. We had Allen, Bob, Carol, and Doug. Now if I select these and I turn on the 

numbers look at your indents up here. The way they work with numbers is the first one controls 

the number and this one actually controls the text next to the number. So if I decided that I 

needed more space between the number and the text I would grab the one that points up and drag 

over. See that? Or if I decided the number should be closer to the left margin I can drag back 

over like this. So it works the same way with numbers. Let me flip back over to where we were, 

our Burke Flyer. 

Now the little box on the bottom is going to move them both. So if I click the box and move it 

over, see how they’re both moving? I’m going to go ahead and undo that and put these back 

together. Let’s say I wanted to indent the whole left margin of both of these paragraphs. As long 

as I grab this little box on the bottom, notice I’m indenting the whole left margin there.  
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There’s also an indent over on the right. So if you wanted to pull this in you’ll see that you can 

now make a paragraph or two actually stand out a little bit because you’ve changed the margins 

for those two paragraphs only. Notice it didn’t affect any of the other areas of my document.  

So that’s a quick overview of how the indents work. I’m going to go ahead and undo this. And 

the next thing I want to talk to you about are working with your tabs. So let’s move over to 

section 4 and I will see you shortly. 
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Video: Working with Tabs 

Cindy: We are working in module 4. We’re talking about paragraph formatting and we’re all the 

way down to section 4 where we’re going to talk a little bit about working with tabs.  

Microsoft Word has this great feature called Tabs which allow you when you hit the Tab key to 

override that normal half inch. It’s also going to allow you to set different types of tabs and 

leaders and things like that. So let me show you how the tabs work. 

There are actually five different tabs and they each work a little different. Before we go through 

each one let me just show you a little bit about a scenario that you might have a reason to use tab 

for. 

Look down at the bottom here and you’ll see that it looks like I have nice, neat columns of 

names, addresses, amounts, and telephone numbers. But it’s really not columns because this was 

set up using tabs. I’m going to click inside any line here and when I do notice the tabs up on the 

ruler. See these? Also if I turn on the non-printing characters here I want you to see the tab 

indicator here. So that’s how you know this was set up with tabs.  

Now I want to go through each of the five with you so you can see how each one of these works.  

If you look at the top left here you’re going to see a little box with an L in it and those are your 

tabs. That L actually stands for a left aligned tab. If I click there I’ll get a centered tab, the next 

one is a right aligned, the next one is a decimal tab. And the decimal tab helps you line up 

decimal points. And the last one is a bar tab. If I click two more times I’m going to see two 

indents and then I’ll cycle back through my tabs. So let’s talk about each one and how they work. 

The first one is a left aligned tab. I’m going to set it on my ruler at 2 inches. Notice I just click 

there. If you click too high or too low it won’t set it. So just kind of know that. You’ll see it there 

once it’s set. The purpose of a tab is normally when I type something and I hit the Tab key I’m 

going to stop at the next half inch on the ruler. But I want it to override that. So notice I’m going 

to hit the Tab key and I stop directly under the tab that I set.  

Now let’s talk about the fact that it’s left aligned. I’ll just type a little bit of junk in here. I’m 

going to hit the Enter key and hit the Tab key. You have to tab to get to the tab. It’s not going to 

jump over there automatically. If you happen to forget and you type some text just click at the 

beginning of that text and tab over to it. This is called a Left Align Tab because you’ll see that 

everything is nice and neat on the left hand side and not on the right. So if you think about our 

addresses down at the bottom here, addresses are always nice and neat on the left but they’re not 

the same length. So that’s a good example of a left aligned tab. 

I’m going to leave this text and to delete the tab you’re going to click on the tab itself from the 

ruler and drag it under the ruler. Be careful because you could add an extra tab doing that that 

you didn’t mean to. You can always undo, by the way.  

The next tab is a center tab and this has nothing to do with centering on the page. It means that I 

want to center underneath wherever I place the tab. Let’s say I place it at 1-1/2 on the ruler or 
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close to it. Now that I’m here watch when I type it looks like there’s an invisible line and 

everything is centered. See that? Can you think of a good example for a center tab? What if you 

actually did have two real columns in Word and you wanted each column to have text that’s 

centered? That would be a good example of setting one in each column. Alright I’m going to 

delete this, get rid of my tab. 

Now the next one I want to show you is a right aligned tab. I’m going to place it as far as I can to 

the right and notice when I tab this time I’m going to tab all the way end of the ruler, under the 

tab. And notice that when I type I’m typing from right to left. A good example of this is if you 

look down here at our telephone numbers they’re nice and flush on the right hand side. See that? 

That’s because there’s a right aligned tab set there. Now let me go ahead and delete that and I’m 

going to delete this tab as well.  

The next one I want to show you is a decimal tab. Wherever you set the decimal tab you’re going 

to type in numbers with decimal points and it’s going to line up the decimal points for you. So 

it’s not necessarily money. It’s decimal points. They’re going to line up perfect every single time 

when you do this. Okay?  

Now the last one is what we call a Bar Tab and I’ll show you how that one works. It’s just a 

straight line over here. And let’s say I set it at 2-1/2 inches. Notice the vertical line here? So 

when I type my text and I hit the Enter key the line will expand. See that? Be careful because if 

you keep on typing it will let you type over the line. So a good example of this might be I see a 

lot of resumes that have on the left the dates, then they’ll have vertical line and on the right 

they’ll have information. So let me go ahead and delete this and then I’ll show you how I did that 

scenario down at the bottom. 

Alright so I’ve gotten rid of all my tabs and I’m all the way back to the left here. I know that I’d 

like to have four columns or so it looks like. The first one I won’t need a tab but I will need one 

to get over to the address. A left aligned tab is probably the best one for that because it’s going to 

line my addresses up nice and neat on the left hand side. I’m probably going to need one for the 

amount. So I’ll go find a decimal tab and I’ll set that one at 4 inches. And then one more. I want 

to set that telephone number column so it looks like it lines up nice and neat on the right hand 

side like that. So see how you can have multiple tabs?  

I’m going to go ahead and put in my headings. So I’m going to have Name and I’m going to tab 

over to the Address. I’m going to hit Tab again. I’m going to type in Amount. And one more 

time and it’s going to say Telephone. Now my next line I’m going to type in my names. So I’ve 

got Carol Davis. Carol’s address is 123 Oak Street. Her amount was $25.61 and her phone 

number had no area code. It was 555-8967. Enter. John Max. I’m going to tab over. He lives at 

456 Tree Lane South. His amount is $14.51 and the phone number is (843) 645-8976. And one 

more. I have Douglas Hennis, 1256 Rivers Avenue, the amount is $5.50, phone number (704) 

698-3258. Now if something like this happens to you, let’s say I was here and I accidentally just 

hit Tab again and it looks all weird. Turn on your non-printing characters to see what you did. If 

you notice you have a tab right in front of the 3258. So all you have to do is backspace over it 

and it’ll bring it back up where it needs to be. So don’t worry if it looks out of place. You can 
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always turn on your non-printing characters and check out what you’ve done. It looks like nice, 

neat columns. Right?  

Have you ever noticed especially in the front of a book, this is a good example, they’ll have the 

Table of Contents and the Table of Contents will have Carol Davis and this it goes dot, dot, dot, 

dot, dot all the way to the 123 Oak Street? Those dots are called Leaders. Leaders lead up to a 

tab. Let me show you how to set those. 

I’m going to select these three lines. Now the way you’re going to get into the actual options for 

the tabs, you can actually double click the ruler or if you click on the arrow next to the Paragraph 

grouping you’ll see Tabs right down here at the bottom. 

Here are the three tabs that I’ve set and you’ll notice that when I click on each one it tells me that 

the alignment in this case is left an there’s no leader. I have three choices when it comes to 

leaders. I can have dots, dashes or a straight line. I’ll choose number two and I’m going to Set. 

And you have to do that for each one. Now let me do this last one and set that one. Now I’m 

going to click OK and there’s your leaders. Even if I hit the Enter key and I typed a new name in, 

let’s say it was Tim Scott. Notice when I hit the Tab key there’s my leaders. It’s going to carry 

that forward.  

Let me mention one more thing. If you need to move a tab, let’s say that the Amount column I 

want to move it over for some reason. All I have to do is select the lines that use the tab. That’s 

very important because if you don’t it’s only going to affect the line you’re clicked on. And I can 

click the tab and move it wherever I’d like it to be. That way I have more room to put in my 

address. So that’s how tabs work.  

What I’d like to do now is go ahead and move over into the next section and we’re going to talk 

quickly about styles before we wrap up this module. I’ll see you shortly. 
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Video: Module 4 Practice Exercise 

Cindy: We’re in module 4 and we’ve been talking about paragraph formatting in this particular 

module. We’re all the way down now to the practice exercise and I just wanted to get you to do a 

few things for me before we move on.  

We talked a lot in this particular module about working with spacing. We talked about line 

spacing, indenting. We talked about tabs, alignment options. So let’s see how much of this you 

can remember. 

The first thing I want you to do for me is open the file called Module 4 Practice. Go ahead and 

change the line spacing for the entire document to single space. I don’t want any space after the 

Enter key as well so you’ll have to take out that extra space after the line spacing option.  

The next thing is we’re going to center the title on the page. Then I’m going to have you take the 

first paragraph and we’re going to indent both margins. So on the left I want it to be indented at 

¾ of an inch which is 0.75 and on the right let’s go over to 5.25. So that makes it ¾ on both 

sides.  

The next thing we’re going to do is you’ve got a date at the top there and I want to move it over 

to the right. First though I want you to put a right aligned tab at 6 inches, then click in front of 

the date and tab over. And that’s actually line it up all the way on the right.  

And that’s it. If you can do that you’re good to go. Go ahead and save the file and close it for me. 

Great job as always.  

So what we’re going to do now is we’re going to go ahead and go over into module 5 and talk a 

little bit about managing lists. 
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Module 5 – Managing Lists 

Video: Sorting a List 

Cindy: Hey there. It’s Cindy again. We’re down to module 5 now where we’re going to talk in 

this particular module about managing different lists that you have in Microsoft Word. So very 

similar to how Excel works you have the ability to take any list you have and actually sort that 

list and then you can also format it any way you like as well. So let me go ahead and show you a 

list that I have set up and I’ll show you how to sort that list. 

Okay you’ll see here that I have a list of names. I’ve got first and last names. And they’re in no 

particular order. I’d like to have Word go ahead and sort these by last name. Now I need to make 

sure before I do this that it’s properly set up and properly formatted. What I mean by that is 

we’re going to have to tell Word how I’ve separated each of these names. And in this case I’ve 

used the Enter key. So I’ll turn on my non-printing characters so you can see that. See the Enter 

key at the end? Now I could tell Word that I want these separated by a tab or any other special 

character but this is how mine are separated. 

I could actually have these set up as bulleted items or as a numerical list and it would still sort 

them. So just know that.  

The first thing you’re going to do if you want to sort the list is select the list and if you’re under 

the Home tab under this Paragraph grouping you’ll see this A to Z. That’s you Sort button. 

You’re going to be able to sort your text three different ways. And what I mean by that is I could 

say something like Sort by Last Name if the last names are the same sort the first names and then 

maybe sort by middle initial. That’s why you have three options here. And you may not use all of 

those but you do have the ability to do that.  

The first thing you want to do is go down to the Options at the bottom and tell Word how your 

text is separated. You notice ours was separated with a space between Carol and Smith. 

Normally when you first come into this window it’s usually set on this Tabs options 

automatically. So what you want to do is if it’s not a tab or a comma click where it says Other, 

delete whatever is in there and just type a space. Also if you want your sort to be case sensitive 

you need to check this, but that’s not the case right now. I’ll go ahead and click OK.  

Now the first thing I want to do is sort this by last name. So I’ve clicked the down arrow and 

what I’m trying to do is tell it by the second word. So last name is the second word that I have in 

my example. I’m also going to be sorting it by text. It recognizes this is text. But I could be 

sorting numbers or dates as well. And I’m sorting these ascending. I’m just going to click OK 

and now look. They’re sorted by last name.  

You’ll notice I have two Harold’s here as far as the first names are concerned and they happen to 

be sorted alphabetically by last name. Just to show you though, if I go back in here, if I wanted to 

sort any first names that were the same I could say sort on word one now. I don’t have a need to 

do that in this particular case but I could. So this would sort the last names and if the last names 

were the same it would sort the first names. That’s how that sorting is going to work. 
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I’m going to go ahead and click OK there. Now let me flip over to an actual file that has a list in 

it so you can see another example of this. I’m going to go up to View and I’ll just switch 

windows here and go to this file I have called Burke Edit.  

Now I’ve just gone down to the second page and you can see they have a list of different ways 

they can help you sell your house. So I’m going to go ahead and sort this list and this time I want 

to sort it by the first word, by the first letter here. If I go ahead and turn on my non-printing 

characters for a moment you’ll see that I have the set up where I have a space between my words 

and an Enter key at the end. I’ll go ahead and tell it to sort. I’m going to check the options and 

make, oh see how it’s on Tabs automatically? So I’m going to make sure this has a space. I’ll go 

ahead and click OK there. And this time I want to sort by word one and I’m going to click OK. 

And now you can see that it’s sorted by the first letter of the first word. So you can always sort a 

list of any kind just like you’ve seen me do here.  

What I want to do now is talk to you a little bit over in section 2 about some formatting of those 

lists that you’ve sorted. 
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Module 6 – Tables 

Video: Working with Tables 

Cindy: Hey there. Welcome back. It’s Cindy again. We are in Microsoft Word 2016 and we’re 

now on module 6 where we’re going to talk a little bit about tables. This is section 1 where I 

wanted to introduce you to a table and show you a little bit about how to work with a table. 

Any time you have data that you’d like to summarize into columns or into rows then you can 

actually create a table and put the data in the table. So let me show you what a table looks like. 

Here’s a really good example of a table that has multiple columns and multiple rows. You’ll 

notice that in this particular table there are several columns. And columns go up and down, rows 

go across. Each column in this case has a label at the top so you’ll know what type of data is 

below it. And we actually call that whole first row there the Header Row. Sometimes you 

actually have row headers as well. So if you wanted the first column each row to tell you what 

the row meant across you could have row labels as well. But this one does not have those. 

When you’re clicked inside of a table anywhere you’re going to see a little box appear on the top 

left. And if you click on it that is a way to select the table. It’s also a way to move the table. You 

can have tables in documents that already have data and you may want to move it around and 

have the text wrap around the table. That’s certainly something you can do.  

You’ll notice that when you’re clicked in a table and you just hit the Tab key on the keyboard 

you’ll move to the next what we call Cell to the right. And you’ll keep going down to the next 

row each time you get to the end. Be very careful because if you’re in the last cell in the last row 

and you hit the Tab key you’ll get an additional row. Now that’s great if you need an additional 

row, but if you don’t need it just go ahead and hit Undo and that way you can get rid of it. You 

can also click anywhere you’d like to be and that way you can just type information wherever 

you happen to want to put the information.  

You’re also going to see as we go through that you can write formulas in your tables. There’s 

actually a formula right here that calculates the totals. And that’s something else I’m going to be 

showing you how to do. 

So that’s a quick overview on working a little bit with tables. What I’d like to do now is go over 

into section 2 and show you how to create a table. 
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Video: Creating a Table 

Cindy: Hey there. Welcome back. It’s Cindy again. We are in module 6 of Microsoft Word 2016 

and we’re talking about tables in this particular module. Now this is section 2 where I want to 

show you actually how to create a table because there’s a couple of different ways to do it. So let 

me show you how to get started creating a table. 

There are four different ways to insert a table. The first way is if you click on the Insert tab 

you’re going to see the Table option and then you’re going to see a grid right here that indicates 

how many columns and rows you’ll be inserting into your table. Notice if you drag across five 

and down three that means you’re going to have five columns across and three rows down. 

You’re just going to click and then there’s your table.  

A few things I want you to notice about the table. You’ll notice that you have borders around 

each cell. These will print. You can actually remove them, you can actually edit them, format 

them any way you want. So we’ll be working with borders a little bit later. Also notice that you 

now have a Table Tools contextual tab.  

Under the Table Tools contextual tab you have a Design tab which is going to allow you to 

change some of the design elements about your table and then the Layout tab which has a lot of 

options as far as if you want to insert rows or columns, things like that. And we’ll be looking at a 

lot of these different options. 

Some other things to notice. There is actually a little box on the top left of your table. By 

clicking on that box that is a way to select the table. That way if you wanted to do something that 

affects the entire table then you could now do it since the whole thing is selected. Also these are 

floating tables. If you had some data in this particular document already you can grab this little 

box and drag it around and your text will actually wrap around the table.  

Something else to notice is this. When you insert a table like we did into a blank document 

there’s not even one blank row above the table if you wanted to put some text there. I wanted to 

show you how to fix that real quick. 

If you’re in the first cell and you’re in front of the first character of text then all you have to do is 

hit the Enter key and it will throw you up above your table so you can put some text out in your 

document. That’s not going to work anywhere else. Okay? So just know you have to be in front 

of the first character of text in the first cell and then you hit the Enter key.  

I want to go ahead and type some data in here. Typically your top row is what they call your 

header row. Headers just indicate what type of data happens to be below in those columns. So 

I’m going to put in the Date Order, the Item Name, we’ll say the Stock Number, we’ll say 

Quantity Ordered and the last one we’re going to say Amount Each. Notice I’m just hitting the 

Tab key to move back and forth between the cells. Shift-Tab is going to go to the left and Tab is 

going to go to the right. Let me go ahead and plug in some dates here. We’ll say this one is the 

12th. We’ll say Blue Buffalo Tags. Stock number we’ll say 2152, 15 ordered and these are $1.52 

each. One more line here. We’ll say this one is May the 1st of 2016. This is Pacific Purple Paint. 
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Did you notice in this particular case that the column wasn’t wide enough so the Paint went onto 

the next line? We’re going to talk a little bit about fixing things like that shortly. This number is 

going to be 8328. There’s two of these and they’re $17.98 each.  

You have the ability in a table to actually change the width of your columns and your rows that it 

automatically inserts. You might have noticed all of the columns are the exact same width. 

That’s why this one word wrapped. All I have to do to change the column width is place your 

mouse on the line that separates the columns and then you can start dragging left or right to 

change some of the widths. So if this one here wanted to be a little bit smaller I can do this, I can 

do something like this, and then that way Item Name happens to be a larger column. 

I want to talk to you a little bit now about how to add rows and columns to your table. So let’s go 

ahead and go over to section 3 and I will show you how to add columns and rows. 
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Video: Adding Rows and Columns to a Table 

Cindy: Hey, welcome back. This is Cindy again. We are in module 6 where we’re talking about 

tables and we’re all the way down to section 3 where I want to go through how to add rows and 

columns to your table. 

You have the ability in any table to add additional rows or additional columns anywhere in the 

table. One of the things you’ll need to know is before you start adding rows or columns here’s 

how you’re going to select within a table.  

If you put your mouse above any column notice that there’s a down arrow right above that 

column. And when you click you’ll select the column. If you need multiple columns then all you 

have to do is go ahead and click and drag across like this and you’ll get multiple columns. But 

you’ve got to have that black down arrow that you see.  

The way you’re going to select a row is get outside of your table in the selection bar and select a 

row. And the way you know you have an entire row selected is right here on the end you have 

something called an End of Row Marker. Let me show you what those look like. I’m going to 

turn on my non-printing characters for a moment and you’ll see at the end of each cell is an end 

of cell marker and at the end of the row is an end of row marker. And that’s important that you 

recognize because if you just drag across your cells like this that’s not an entire row. That’s five 

cells. Just be aware of that. Let me go ahead and turn those back off again. 

Let’s say that I’d like to add a column to the right of this table so it’ll be on the end. Where 

would the column go because remember when you put in the table to begin with each margin the 

table meets on each margin? It’s actually going to make a few of the columns a little bit smaller 

when we do this and we may have to resize them. Here’s how this is going to work. 

I’m going to select the last column and you’ll notice a couple of things I can do. You’ll notice 

that right here is an Insert option and I can actually insert my column to the right of the one I 

have selected. I also want you to know that if you right click in the highlighted area you can 

insert and this gives you a choice to insert your column to the left or to the right. And one more 

way to do this, if you’re under the Layout tab, you’re under the Table Tools contextual tab and 

the Layout tab here you can actually insert your column here where it says Insert Left or Insert 

Right. In this case we’re trying to put one to the right of the one we have selected. So I’m just 

going to choose Insert Right and there it is. Notice how it made this column a little bit smaller so 

now this is word wrapping. You can kind of see that Item Name is a little bit smaller, but I do 

have my last column. I’d like to call this one Total. And in a little while we’ll do some 

calculations where we can have it total across for us. 

Let’s add a row. I’d like to put a row between the first and second one that I have here so I’m 

going to select the bottom row and I’m going to go back up here where it says Insert and I’m 

going to insert a row above the one I have selected. And now there’s my new row. Let me go 

ahead and put some information in here. We’ll say this one is Corinthian Pink Paper. It’s number 

1586. There’s 56 of these at $2.98 apiece and then later we’ll calculate. So you can always put in 
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your columns to the right or left and your rows above or below. That’s actually how you’re going 

to put in your columns and rows. 

What I’d like to do now is go ahead and talk to you a little bit about how to format your table so 

that your header row stands out and some other things in here. So I will see you shortly. 
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Video: Formatting Table Data 

Cindy: Welcome back. We are working our way down our list here in module 6 which is the 

Tables module and we’re now on section 4 where I want to go through and show you how to 

format the data that you have in your table.  

I’m looking at my table and I see several things I’d like to change as far as the formatting is 

concerned. And the first thing I notice is that I’ve got a couple of my headers here that are word 

wrapping and I don’t like that. So I’m going to go ahead and make column one a little bit wider 

and I’ll come over and make Quantity Ordered a little bit wider as well. And then that way 

everything looks a little bit nicer.  

Now the next thing I’d like to do is I’d like my header row to stand out a little bit and I can do 

that by putting some formatting on the text, maybe centering the text, different color, things like 

that. Let me go ahead and start with I’d like to center it within each cell. So see how I selected 

the whole row and each one of these now is centered within the respective cells? I’m going to 

make these a little bit bolder as well and a little bit of a larger size. Now obviously when I do that 

then one of my columns is word wrapping again so I’m going to change that. 

Now sometimes this might happen. Do you notice how only one cell the border moved? That’s 

because only that cell was selected in this particular case. I’m going to hit Undo real quick and 

now what I want to show you is when I deselect I can now grab the border between the columns 

and move them. So I’m going to move and make Stock Number and Amount Each, I would like 

Amount Each to be all on the same row. So that means I’ve got to work with these a little bit and 

see if I can get some of these a little bit smaller. Now sometimes that involves making the text a 

tad smaller. So I think I’ll try that first. There yes it looks a lot nicer.  

I also want to change the font just so that it looks different. I’ll go up and pick Algerian. Now 

obviously when you pick a different font sometimes that that font is naturally larger or smaller 

than another. So in this case I’m pretty much stuck with leaving these like this unless I want to 

make them a smaller size.  

I’d also like to go ahead and center this information. So notice how I just put my mouse to the 

left of the first cell and I drag straight down to select those and I’m going to center those as well. 

I’m also going to center my quantity ordered and then let’s talk a little bit about Amount Each. 

I could center these and at first glance when I do this it might look okay. But one thing you’ll 

notice is the decimal points are not lined up. In order to line up the decimal points I’m going to 

set a decimal tab in that particular cell. Now before I do that I’m going to left align these again. It 

just seems to work best if they’re aligned to start with. Notice I still have them all selected. I’m 

going to make sure I have my Decimal tab up here, which I do. Now what I’m going to do is on 

the ruler I’m going to go ahead and click where I’d like the decimal points to line up. And now 

look. They line up perfectly. See that? I probably want to set a decimal tab over here as well 

even though I haven’t put any numbers in there yet. But I’m going to go ahead and do that. I’ll 

go ahead and make sure I have a decimal tab set there so that when I do plug them in it’s ready to 

go. Looking better already. 
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I’m going to go ahead and click on my Table Tools contextual tab and go to the Design. A 

couple of things I want to point out. You do have the ability to go ahead and display different 

information depending on which ones of these are checked. So these are called Table Style 

Options. If I want I can have special formatting on the last row, I can have special formatting on 

the first column, those are just some different options there.  

I’m going to select the table and I’m going to go over to the Table Styles. Here are some 

predefined styles I can pick from. Some of these have colors. You can see a lot of these have a 

header row that happens to be a darker color. Notice that every other row is a different color and 

that’s called Banded when you see that. So you’ll notice that one of your designs here under your 

Table Styles they all have what they call Banded Rows. You can also go down and modify one 

of the table styles if you like or you can create your own or clear what you have already, but I’ll 

stick with the one I have here.  

We’re going to talk about borders and shading here in the next little section so I’ll bypass that for 

now. And then quickly under the Layout tab I just want to point out a couple of quick things. Let 

me go ahead and select my table again. 

I want you to notice that you do have the ability to split the table if you wanted for some reason. 

Just to show you what it would look like and it really won’t make a lot of sense here but if I 

happen to be clicked on the second row down and I split the table, notice now the header is 

separated from the first row in my table. Okay I’ll just go ahead and undo that.  

Some of your other options that you have here I just wanted you to be aware of. When you’re 

under the Layout tab again here’s some options for deleting whatever you have selected. This 

could be the table, it could be a column if you have it selected, a row. Here’s how you insert your 

rows and your columns. You can insert your rows above or below the one you have selected, 

columns left or right. And just like we split the table you can split cells. So if you had a particular 

cell you wanted to split into maybe two cells you just select it and split them. And then of course 

you can merge them back together.  

Also you’ve got options for making your text fit within each of the cells. AutoFit is just going to 

allow your contents to automatically fit to the window or you can have a fixed column width if 

you want to go set that and set that stuff right here. And then you have Distribute Rows and 

Distribute Columns. What this will do is the rows or columns you have selected it will make 

them all even so they’re the exact same size.  

A couple of things under Alignment I just want you to be aware of. If you notice that whenever 

you’re clicked in a cell right now your text in my case happens to be at the top of the row and it 

happens to be in the center. But these options allow you to leave it at the top, move it left or 

right. You can actually put everything in the center. So if I went ahead and selected all three 

rows, for example, I’d just put them dead set in the center. You can see that. And then some 

options for putting them at the bottom.  

One other thing you’re going to be able to do is change the direction of the text. Sometimes if 

you don’t have a lot of text in your header row just for effect you might change the text direction 
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like this. And you can also set the internal margins within your cells and that’s going to let you 

go in and actually type in whatever you’d like the top, left, bottom, or right margins to be. You 

can also put some space in between your cells if that’s what you want to do.  

So you do have a lot of options available to you here when you’re working with your tables.  

What I’d like to do now is I want to show you a little bit about how the borders and the shading 

work within your tables. So let’s go ahead and go over to section 5 and I’ll show you how all that 

works. 
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Video: Borders & Shading 

Cindy: Hey. Welcome back. We’re still working in module 6. We’re all the way down now to 

section 5 where I want to talk to you a little bit about borders and shading. You probably noticed 

when we were working on the table that you had borders automatically. As soon as you inserted 

the table you have black borders that print. Well I told you that you have the option to take those 

off. You can actually add different borders if you’d like just to really enhance your tables. So let 

me show you a little bit about how borders and shading work. 

One of the things we talked about was when you first insert a table you automatically will have 

borders around that table. Borders do print. So if you don’t want them you can take them off, you 

can actually add different types of borders, different styles, colors, things like that. I’m going to 

select this table and I’m under the Table Tools contextual tab, the Design tab here. And you can 

see this is your Borders grouping. I’m going to start with this Borders button here.  

First of all you’ll notice that several of these look like they’re turned on. This will allow you to 

put a border around the bottom of your selection, the top, left, right. If you don’t want one of 

these you just click on it to turn it off. Here’s how you take the border totally off, no border. And 

if you do that you’ll notice now you have grey what they call Gridlines. Now gridlines do not 

print. They’re just there to show you the outlines of your cells. Just so you’ll know, if you don’t 

even want to see the gridlines then you can actually go and turn the view for those on or off 

under the same Borders button. See how it says View Gridlines here? Well if I click on that now 

they’re off. Now it looks like there’s nothing there but the table is still there. Your cells still work 

the same way. It just really would look like nice, neat columns of information versus a table. I’ll 

go ahead and put these back on.  

I’m going to choose the outside border option and I’d also like to view those gridlines so that I 

can work with them a little bit easier. I’ll go down here and choose View Gridlines. Do you 

notice when I chose Outside Border there’s only a border that will print on the outside of my 

table? Now I want to apply a border around my header only. So I’ll select the first line, go back 

to Design and I’m going to choose again Outside Border but this time it’ll be just for the header. 

So borders are only around your selection, not necessarily each cell in your selection. Notice on 

this list that you can also apply inside horizontal or inside vertical borders and then you’ve got 

some diagonal ones you can apply that go sideways like this and then you can also put in a 

horizontal line. So those are your basic border options. That’s kind of nice but did you notice we 

can’t really pick a color here or a style, so that’s where it really gets interesting.  

I’m going to go to the bottom of the list where it says Borders and Shading and click. Now you’ll 

notice that I have Border options, Page Border options and Shading options. So I’m going to start 

with the border options.  

Over here on the left you can quickly just choose a box if you like, you can choose All which 

just puts a line between each of your columns here or a grid. But here’s where I can choose a 

style for my border. I can pick a color for my border and also a width, which is like a thickness. 

What you have to do here is after you pick all these options go into the Preview area and click on 
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the borders you want to be that style and color. If you don’t do this and you just click OK 

nothing is going to happen. Notice that if I wanted to take a border off I just click Back on it and 

that way I can change it. So if I wanted the sides here to be different for some reason I can pick a 

different border totally, different colors, different width and then I can click on those and now 

you can see that all of the borders look a little different. Let me go ahead and click OK and now 

you’ll see that my header has this specific style of border.  

Now let’s say that I want to go ahead and apply something a little different to the bottom two 

rows here. I’ll just go back to Design and be really creative with this. Let’s say that I do want to 

have this particular one. See how the last style that you chose is here? So I don’t have to go back 

to Borders and all the way through that whole option if I don’t want to do that. So I can go ahead 

if I want and go ahead and choose this style. And there’s Border Styles here as well. So if you 

like some of these you can certainly choose those. So I’m going to go ahead and go back into this 

arrow which is another way to get back in here and I’m going to go ahead and apply the same 

style to all four for now. So you see how it’s based on your selection.  

Let’s talk a little bit about the shading. The shading is going to be the color or whatever you put 

inside of the background of your object. I’ll just go ahead and put some shading in the bottom 

two here. When I go back to Design, go back into the arrow again, the last tab over says Shading 

and this is where we apply a Fill. A fill is whatever is inside the background of your object. So 

let’s say that I decide I want to put a color in here. I’ll just do a light blue and I’ll go ahead and 

click OK and see what it looks like. Okay. Let me go ahead and apply a shading to my header 

here. I’ll go back to Design, back into the Borders and Shading and this time I’m going to pick a, 

I’m going to go to More Colors. I didn’t like any of those. And then let’s say that I choose one of 

these lighter options here and click OK.  

Now I want you to notice also that you can have a pattern. First of all the color that you chose 

right now it’s called Clear and you can see there’s a percentage. That means that the color I have 

I can make it a little bit lighter, a little bit darker by choosing one of these percentages. But if I 

keep going to the bottom of the list you’ll see there’s also some different pattern styles I can 

choose from. You can’t always read your text very well if you pick some of these. So you want 

to use some that maybe the spacing is a little different here. You can kind of see these. And then 

you can pick a color for the stripe, for the check, that sort of thing if you need to do that. Let’s 

see what this looks like. So you can kind of tell right there. I’ve got some stripes back there. I’ve 

got that lighter color and then I’ve got the color of those particular stripes. You can play with this 

all day long and come up with all kinds of scenarios.  

Now I want to show you one more quick thing because I mentioned that borders and shading 

aren’t just for tables. You can also use them for text. Let me flip over to another exercise we 

have and just show you real quick. 

This is Burke Edit and you’ll notice that they have a title and a subtitle here. And let’s say that 

I’d like to put these two in the center and I want to put a border and shading around those. I’ll 

just select those and I told you that under the Home tab these are borders and shading options 

here as well. I’m going to go ahead and choose the Border option. I’ll go down to Borders and 
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Shading and I’ll just pick a couple of different options in here. I’ll pick this. Let’s say I pick a 

different color. I’ll pick this green. And let’s say I put a little shading in here. We’ll put a lighter 

color if we can. And I’ll click OK. And now I’ll go ahead and center the text, maybe change the 

font, things like that that I might want, but what you notice is that you now have borders and 

shading around your text. So just remember that borders and shading work for text and it works 

for tables as well. It’s just your selection.  

One last thing we saw in the Borders and Shading option, we had Page Borders. I’m going to go 

back into this and go down to Borders and Shading. The middle tab said Page Border. Here’s 

where if you want to put a border around the entire page you’ve got the same options but now 

you also have Art available. So here’s where you’re going to have all kinds of artwork that you 

can apply to the border of your particular page. Now some of these look like little cute little 

graphics. At the bottom they have some that are a little more professional. So if you needed 

something that was just more of a line, you can see some of these. But let me just go ahead and 

pick something fun so you can see how it works. I’ll just go back and pick these balloons right 

here and I’ll click OK. And now you’ll see that’s the border around your page. So you’ve got 

options for putting borders around your information you have selected and around the page itself 

and that’s going to be on every page.  

So that’s going to wrap up your borders and shading. Just have a lot of fun with that, get really 

creative. Let’s go over into section 6 now and talk about sorting your information that you have 

in your tables.  
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Video: Sorting in a Table 

Cindy: Okay welcome back. We are in module 6 where we’re talking about tables. And we’re 

all the way down to section 6 where I want to show you how to sort the data that you have in a 

table. You’re going to be able to sort a couple of different ways. You’re going to be able to sort 

alphabetically or numerically. So let me just show you how to get in and start sorting that data. 

I’ve got this table here and I’m tracking information on different individuals. I’m tracking their 

first name, their last name, their company, address 1, city, state, and zip. You’re going to be able 

to sort three different ways. You’re going to be able to sort alphabetically, ascending or 

descending, you’re going to be able to sort numerically, that’s one to ten, ten to one, and also 

you’ll be able to sort by date, year, month and date if you have that information here. A couple of 

guidelines about making sure the table is set up correctly before you try to sort. And the first one 

is your header row at the top.  

Each one of these column headings tells me what’s in the column below. In order to get Word to 

automatically recognize it as your headers make sure you have one format that’s different from 

the data below. And what I mean by that is let’s say I click here anywhere in my header and I go 

back to Home for a moment you’ll see that it’s Times New Roman, size 12 and bold. Where 

anywhere below it is not bold. So as long as one formats different then it’s going to recognize it 

as your headers.  

When you’re sorting all you have to do is click in the column you’d like to sort by underneath 

the header row. So let’s say I want to sort by last name. Now before I sort this let’s just notice 

this first row. This is Anne Smolkovich, Shelburne Schools. It’s going to take everything in that 

row with it.  

I’m going to go to the Table Tools contextual tab, I’m going to click on the Layout Tab and then 

you’ll see here’s the Sort option right over here. And when I click on that notice it selects the 

table back here for me. That’s why you didn’t have to select it yourself.  

Here are the three different ways you can sort if you wanted to do it all at the same time. Right 

now we’re doing a single level sort. We’re going to sort by last name. Notice the down arrow 

which lists all my column headings. I’m going to sort by text and I’m also going to sort it 

ascending. So I’m going to click OK here and now you’ll see it’s sorted by last name. Now I’m 

going to scroll down. Let’s see if we can find Anne. There’s Anne right here. So notice there it 

is. Anne Smolkovich, Shelburne Schools. See how it took everything on that row with it? Okay 

I’m going to go back up to the top again.  

Let’s say this time I want to do a double sort. I’d like to sort by last name and then if the last 

names are the same sort the first names. In order to do a double sort you have to have repeated 

values in the previous column. Let’s see what this one looks like. I’ll go back to Sort. I’m just 

going to add a second sort to this and I decided I wanted first name as well. So I’m sorting by 

last name and then by first name and I’m going to click OK. Now if you notice the last names are 

still sorted alphabetical. But do the first names look like they have any particular kind of sort? 
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They don’t because there’s no repeated values for the last names. There’s no duplicate last names 

here. So in this particular case that wouldn’t work.  

Let me show you a different example. I usually start with the column that has the most duplicates 

and then work my way down. What if we said Sort by state and then we’ll sort by Last name and 

then first name. Let’s try that. I’m going to go up to Sort. I’m going to sort by state, then last 

name and then first name and let’s see what we get. So you can see there’s several states that are 

duplicates here. So going down the list here’s New York, for example, and there’s five New 

York’s. If I look at the five New York’s the last names are going to be alphabetical. But again 

there’s no duplicate last name so the first names aren’t going to be sorted.  

How about this? Let’s try state and then company and last name. So I’m going to go back to 

Sort. I’m going to try state, company and last name. Now looking back down the list we’ll look 

at New York again. You can see that we had five New York’s. So obviously that column is 

sorted. Now if you notice the companies are sorted. If you had duplicate companies here the last 

names would be sorted. So again it just goes back to you have to have duplicate items in the 

previous column in order to sort the next column. Just keep that in mind.  

That’s pretty much how your sorting is going to work.  

Let’s go ahead and wrap up this particular section and we’ll go over to section 7 and talk a little 

bit about drawing your own tables. 

  

http://www.simonsezit.com/


Learn Word 2016 

© Copyright 2008-2017 Simon Sez IT, LLC. All Rights Reserved. 
 

Video: Drawing a Table 

Cindy: Hey there. Welcome back. We’re still working in Word 2016. This is module 6 where 

we’re talking about tables.  

We’re down to section 7 now where I want to show you how to draw your own table because 

sometimes you’d like to create a table that doesn’t fit the normal columns and rows that you 

would have to tell it when you’re inserting a table. So I’ve got a good example pulled up of one 

that we’ll go ahead and do after I show you what it looks like here. 

Here’s a really good example of a table that doesn’t have traditional rows and columns. You’ll 

notice that on the right I have a larger column where I can actually put the picture. And over here 

it looks like I only have one cell here and then a larger one here. Now the way I did this was I 

actually drew the big outside box first and then I went back in and kind of filled in some of these 

borders like this one so I could make it look the way I wanted to. We’re going to do this exact 

same one. So I’m going to go ahead and delete the whole table and then I’ll put it back in and 

show you how I did it. I’m going to select the table and just right click and delete. 

If you’re under the Home tab and you go to the Paragraph grouping here’s your Borders option 

and you’ll notice there’s an option on the dropdown that says Draw Table. I could also access the 

same option from the Insert tab and there’s a Table option here. If I click the down arrow I can 

also draw the table right here. I’m going to go ahead and click on it and notice my mouse now 

looks like a pencil.  

Now I find this easiest to draw the big outside box first like this and then go back in and fill in 

the rows or columns the way I’d like them to look.  

Now the first thing I remembered that I wanted to do is put my picture here over here on the right 

so I’ll just draw it straight down like this so I’ll have a place over on the right to put this. Now 

over here I wanted to put my title that says Dream House and down here I’d like to put in the 

address and the price. I’m going to show you a couple of little things. I’m just going to do this 

and then we can tweak it the way we want. So you can see that I was able to draw the borders 

wherever I’d like them to actually show up. Once I get this done I can actually go back and click 

on the Draw Table option and that will actually turn my mouse back to a regular mouse so I can 

type in here.  

Let’s say that the first thing I want to do is I want to put in my title Dream Home. And we’ll go 

back and center and all that stuff here in a little bit. Here I’m going to put in the address and I’ll 

just hit the Enter key so I stay in that same cell. The address is 122 State Street. Let’s say that 

over here I want to put in the price. And let’s say the price is $455,000. And down here I’ll put 

some bulleted items. Now I copied these previously so I’ll just paste these in. Now if these 

weren’t bulleted when you typed them in originally, see how this bottom one is missing a bullet? 

Just go ahead and select it and go back to your Home tab and just choose your Bullets option. 

Now let me go ahead and center this so it looks a little bit nicer and I’ll make the font a little bit 

larger, that sort of thing. And let’s say that here I just center each of these within the respective 

cells.  
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Now if I didn’t want to show this middle border here what I can do is I can select these and I can 

go back and work with my Borders button. I can go in and say I don’t want any borders here. I 

might go back now and say give me a right and a left border. You can just play with this and 

have it look any way you like.  

Now let’s say that I do want a border on the bottom here just to give it a little bit of a good, nice 

look here. So I’ll go ahead and put a bottom one and a top one. Whoops. Let’s go ahead and put 

in a top and we’re going to put in a bottom as well. Let’s see what I have so far. It looks like I 

have a bottom. So let’s put in a top. Now we’re good. So see how it looks like there’s only one 

actual row there or cell but there’s really two?  

Now over here on the right I want to go ahead and put my picture in. So I’m basically going to 

go up to the Insert tab and I’m going to insert a picture that’s on my computer. So I’m going to 

use this one here, house number two and just plop it in. Now it’s really large so I’m basically 

going to size the picture. So I just grab the control handle in the top there and I’m just going to 

change the size of the picture a little bit. Now remember with your pictures that you have an 

option to do some text wrapping if you’d like. So we’ll talk about those in a later module. But 

let’s say that I want to move this picture down a little bit. Remember that I’ve got a Table Tools 

contextual tab here and I can use the Layout tab there to actually center this up and down if I’d 

like in my column. So see how easy that was? I can actually draw the big outside box first, go 

back and put in any borders that I like and then I can make it look any way that I’d like.  

So let’s go ahead and wrap up this particular section. And the next thing I want to do is take you 

over into the next section and we’re going to talk a little bit about converting existing data to a 

table. I’ll see you shortly. 
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Video: Converting Existing Data to a Table 

Cindy: Hey there. Welcome back. We’re still in module 6 where we’re talking about tables and 

we’re all the way down to section 8 where we’re going to talk about taking existing data that you 

might have and converting it into a table. As long as you have it set up properly and Word can 

actually tell where to actually convert one column to another or one row to another then you 

shouldn’t have any problems converting that information into a table. So let me give you a good 

example of how that works. 

This looks like some driving directions. Let’s see. Coming from the. Here’s how you’d get there 

coming from the north, here’s the south right here. It looks like here’s the east directions and 

west. You can see I had a hard time picking out the different directions there. If we convert this 

to a table I think it’d be much easier for us to read.  

Now the first thing I want to do is I want to see how my text is actually separated currently. I’m 

going to turn on the non-printing characters and you can see that my text is separated with it 

looks like a Tab key. There you go. And then over here you’ll see there’s an Enter key. So 

basically anywhere there’s a Tab key we’re going to be telling Word to go ahead and convert this 

to another column. Let me go ahead and turn that off and then I’ll select this and then we’re 

going to convert this.  

To do that we’re going to click on the Insert tab, we’re going down to Table and we’re going to 

choose Convert Text to Table. When this dialog box appears it’s going to ask you several things, 

like how many columns would you like, how many rows. Don’t worry about any of the stuff here 

at the top. Look at how your text is separated right here. Your choices are Paragraphs, Tabs, 

Commas, or Other. And obviously ours is separated with tabs so we’re going to click OK. And 

now my text has been converted to a table so it looks so much nicer. Look how I can pick out the 

different directions now.  

I still want to make a few changes to this though because it looks like I could actually make 

columns one and two a little bit smaller and that way, I don’t want anything to word wrap here. 

And that way then the third column over that says Route I can have a lot more room there. 

Now if I scroll down you’re going to notice that the last little paragraph is really something that 

just tells me a little bit about what to do when I get nearby and I don’t want this all in this first 

column. What I’m going to do is I’m going to select all three of these and I’m going to go ahead 

and right click in the highlighted area and merge these cells together so they’re all one. It looks a 

lot nicer like that doesn’t it? I think I also want to put this all in the center. So I’ll go ahead and 

go back to the Home tab and go ahead and center it. Much nicer.  

So you can see there how you can take existing text and actually convert it to a table and make it 

much easier to read. 

The next thing I want to talk to you about is how to work with what they call Quick Tables. So I 

will see you over in section 9. 
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Video: Quick Tables 

Cindy: Welcome back. We’re still working in Microsoft Word 2016 and we’re talking about 

tables in this module which is module 6. We’re all the way down now to section 9 where we’re 

going to talk a little bit about Quick Tables.  

If you have some tables that you use on a regular basis you can go ahead and insert what’s called 

a Quick Table and just edit the information that’s already in that particular table. They’re very 

similar to like a template, how that would work. You also have the ability if you’ve got your own 

tables you’ve created then you can add those to the list as well so you don’t have to retype them 

every single time you want to use that particular table. So let me show you how the Quick Tables 

feature in Word works. 

The way you’re going to insert a Quick Table is go to the Insert Tab, the Table button and then 

you’ll see Quick Tables at the bottom of the list. Here are several built in what they call Quick 

Tables or templates that are tables that you can work with. They’ve got a couple of calendars 

here. There’s one called Double Table. They’ve got a matrix, a tabular list and a couple that have 

subheads. Now if I wanted to use one of these, let’s just say I want use Calendar 3 here. I’ll just 

click on it and now I’ve got that calendar. Now when you put in any of these Quick Tables 

you’re going to be able to change any of the data in here. So if I like this calendar but it 

represents March, for example, I’m just going to select it, put in March and then I go and change 

all the numbers so they match under the correct days. Let me show you another one. Let me go 

ahead and delete this one. I’ll just select it and right click and delete the table. 

I’m going to go back to the same place under Table and let me just show you briefly what a 

tabular list looks like. That’s this one here. So again I can take out any of this default data. So 

let’s say instead of Item I want this to say Product. And maybe instead of Needed I say 

Available. Again I can just change any of the data that I like right there for this table.  

Now all of the things you already know about working with tables you’re going to be able to us 

in these Quick Tables. So if you wanted to work with your shading, for example, or maybe one 

of the table styles, then you can actually go ahead and pick a particular style that you might like. 

If you wanted to use any of the information under the Layout tab go ahead and use that as well 

because again this is just a table.  

Now something else that’s really cool that you’ll be able to do with this is if you have a table that 

you use on a regular basis you’ve created you can set it up so it shows up on that list when you 

go to the Quick Tables. Let me show you how that works.  

I’m going to go ahead and delete this table and if you remember we actually had a table we put 

in in a previous section with the tiny house and that was the one we drew. I’m going to go ahead 

and insert that one. This is a really good example of a table that we drew that we’re going to use 

over and over. So why have to keep redrawing the table if I can actually save it into the Quick 

Tables? So I’m going to select it, I’m going to go ahead and go back to the Quick Tables and 

you’ll see on the very bottom of the list it says Save Selection to Quick Tables Gallery. I’m 

going to click on that and then it brings up this screen here where I can actually name this if I’d 
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like. I’m going to leave Tiny House and there’s other information I could fill in. Like if I’d like it 

to have a description, if I want to put it in a category that I create. But I’m going to go ahead and 

click OK and let’s see if it’s in the list now. So we’ll delete this one. I’m going to go back to 

Table, back to Quick Tables and look at the bottom of this list and let’s see, and there it is. 

There’s our Tiny House. So I’m going to click on it to insert that table, change out the pictures, 

change out the text and I’m good to go. 

So that’s how you’re going to work with Quick Tables. 

What I’d like to do now is we have one more section in this particular module we need to work 

with and that’s going to be working with formulas in your tables. So let’s go ahead and flip over 

and I will see you shortly. 
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Video: Using Formulas in Tables 

Cindy: Welcome back to module 6 where we’ve been talking about tables and we’re all the way 

down on section 10 where I want to show you how to actually use formulas in your tables. 

If you’ve ever written formulas in Excel then you’ll know exactly what a formula is and that’s a 

mathematical calculation that you write if you wanted to add up some numbers or do any kind of 

math for you. So let me show you how to write formulas when you’re working in Word tables. 

I’ve got a table here that shows our top music categories. I’ve listed all the categories, what my 

instore sales were, my online sales and now I’d like to know my total sales over in this last 

column. Also down at the very bottom I’d like to get the total sales for both the instore and the 

online sales. What I’d like to do is go ahead and figure out the pop rock category first. 

I’m going to click on the Table Tools contextual tab, the Layout tab and go all the way to the 

right where it says Formula. Now here you see that Word gave me a formula automatically. So 

let me tell you how this formula is set up and what it’s actually saying. 

Any time you want Word to do the math in a table for you, you have to start with the equal sign. 

If you don’t do that it will not do the math. This word Sum is what we call a function. And a 

function is a word that tells it what to do. Sum means add. Just so you’ll know, there are over 

200 of these built in functions. What’s in parenthesis is exactly what we want it to add. And in 

this case it says everything to the left. Just so you’ll know, you’re not always adding. It could be 

you’re trying to figure out the average. It could be you’re trying to figure out some other 

information. So briefly let me just take this out and show you this paste function here.  

What if you were trying to average these two instead of adding them? Then you would choose 

Average here. You would make sure you write the word Left in here and start with the equal sign 

like I showed you a moment ago. So really it’s the exact same formula for adding except the 

word is different. There’s also some other functions here that you’ll learn about. If you ever take 

an Excel course you’ll see a lot of these you’ll be familiar with from that. But let me go ahead 

and take this out and I’m going to put the Sum back in there. 

Now the next thing I can tell it is the number format. If I’d like my answer to have a dollar sign 

or maybe just a comma where the thousands are I pick the particular format that I’d like. I’m 

picking this one because it matches the format of the current numbers that I have. Now I’m going 

to click OK and there’s my total. So I can keep doing this all the way down the list. I can go to 

Formula and this time notice it thinks I want to add what’s above it but I don’t. I want to add 

what’s to the left. So I’m going to go ahead and pick my format again and click OK. Let me go 

two more times. I’m going to go back to Formula. Again I want to add what’s to the left of where 

I’m clicked, not above. I’m going to pick this format, click OK and one more here. I’m going to 

go to Formula, I’m going to choose Left, pick the format that I like, and then I’m going to click 

OK.  

Now let’s add down. It’s really going to be the same thing except I’ll be adding anything above 

where I’m clicked. So I’ll go to Formula and notice it naturally says Above because it recognizes 
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I have numbers above. But I’ll go ahead and choose the correct format, click OK and then one 

more here. I want to add everything above where I am. I’m going to pick the format that I like 

and I’m going to click OK. 

Now when you get to this one you can really add everything above or to the left, either one 

because it’ll be the same answer. So I’ll go ahead and do one more where I add from above, pick 

the format and click OK. So you can see it’s pretty easy to have Word go ahead and add up these 

numbers for you. Now one thing you need to be cautious of. If you change any of these numbers 

it will not automatically update your answers. You’ll have to manually do this.  

Let’s say that over here my instore pop rock that number was really 3,660. So let’s say I just 

change that. I want you to notice the answer is 11,409 and when I leave the cell it’s still the same 

answer. It did not update. What you’re going to have to do is you’re going to have to actually 

click in that cell, go back to Formula and make sure that you have the correct formula and click 

OK and then you can see it’s updated. Now here’s the thing. I’m also using that number over 

here and down here aren’t I? So I’m going to have to make sure I go to each one of these, click 

in that formula and do the same thing. See I’ve upgraded that one and now I can update this one 

as well. So just know that you’re going to have to manually update it. 

That’s how you’re going to do formulas when you’re working in Word Tables.  

Here’s what I want you to do for me. We’re almost finished with module 6. All we have left is a 

quick little practice exercise. So why don’t you go ahead and go over to the practice exercise 

which is section 11 and I’ll show you what you need to do and then we’ll be done with module 6. 
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Video: Module 6 Practice Exercise 

Cindy: Hey there. Welcome back. We are getting ready to wrap up module 6 where we’ve been 

talking about tables. Now we’ve talked about every single thing you can think of as far as tables 

are concerned here in this module. So what I’d like to do is have you run through this real quick 

practice exercise where you’re going to put in a table and do a few things for me and then we’ll 

move on.  

The first thing I want you to do is you have a practice file called Module 6 Practice I want you to 

open and you’re just going to use this as your example to create your table. So on a blank 

document you’re going to insert a table with five columns and four rows. Type the data just like 

you see in the practice file there and then when you get it in there I’m going to have you insert a 

row above the row dated May the 10th. Add this data that you see here on that particular row.  

Now go ahead and format the table. Use one of the Table Styles and if you see any other 

formatting you’d like to do feel free to play with this. And once you’re comfortable with it go 

ahead and save and close the file for me.  

Great job as always! So why don’t we go ahead now and move over into module 7 and we’ll talk 

a little bit about working with Styles. 
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Module 7 – Styles 

Video: Working with Styles 

Cindy: Okay. We’re working in Microsoft Word 2016 and we’ve made it down to module 7 

now where we’re going to talk about Styles. This is section 1 where I want to show you how to 

work with styles. 

Now briefly just to tell you what a style is. A style is a group of formats put together and given a 

name so that you can pick them from a list and you won’t have to pick all those formats 

individually. So for example, if you have a title and you always pick four separate formats for 

that title you could keep doing that but you could also put those together and give them a name 

and then pick them from the Styles list any time you wanted to format that particular title. Let me 

show you how Styles work. 

You can see in this exercise we have a title, Driving Directions to Burke, but it doesn’t really 

stand out from anything else in this document. We’ve also got a couple of subtitles. We have 

Coming from the North right here. We’ve got Coming from the South, Coming from the East. 

Again they don’t really stand out from anything else in the document because all of the 

formatting is exactly alike. 

You already know that you can go through and manually pick individual formats if you wanted 

to. But what if every time you type a title you like to use a specific set of formats? Then you can 

save those formats together as a style. You give it a name and you tell it what formats belong to 

the style and then you can use it any time you like.  

You were always using the normal style when you type in Word. The normal style consists of 

you have black text, it’s left aligned, it’s Calibri, size 11. And you can tell that because right here 

where your Styles are the first one is Normal. Now these are some of the different styles that you 

could use. I’ll just pull down the scrollbar so you can see all of these. And you can see that as 

you point to one of these if you have your title selected you can actually just point and see what 

that style is going to look like if you choose it.  

Styles also help you create levels of importance within your document. Let me show you how to 

use these. 

I’ll start with my title and I’m going to choose Heading 1. You can see Heading 1 consists of 

Cambria, size 16. It looks like it’s left aligned and there might be some others that I’ll show you 

in a little while where to go and see all the formats that belong to the style. But let’s take these 

individual ones, Coming from the North, and we’ll make those Heading 2. You can see those are 

the same font but size 13, so they’re a little bit smaller. Coming from the South I’ll make 

Heading 2, Coming from the East and also Coming from the West. So now it stands out a little 

bit more than it did before.  

You also have the ability when you’re looking at the Styles list to clear the formatting. Basically 

wherever you have selected it will clear that formatting and everything there will revert back to 
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the normal style. Now notice you could also create your own style. And you’ll be able to also 

delete styles and edit styles. And that’s what I want to get into next. So let’s go ahead and go 

over to section 2 and I will talk to you a little bit about creating your own styles. 
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Video: Creating Styles 

Cindy: Hey there. Welcome back. We’re still working in Word 2016, in module 7 where we’re 

talking about styles. Now we’ve already talked about how to actually work with the existing 

styles that are here. So what I’d like to do now is talk to you a little bit in this second section 

about creating your own styles. 

There are a couple of different ways to actually create a style. The first way is what they call by 

example. And that’s where you select your text, you apply all the formatting you’d like to be a 

part of that style and then when you name your style it already knows which formats belong to 

that style. Let me show you how to do that right now. 

I’m going to go ahead and select our title and, yes, we already have Heading 1 applied but I’d 

like to add some additional formatting to this. Let’s say that I’d like to first of all center my title. 

I’d also like to change the font color. We’ll make it a little bit of a darker blue here. I’d also like 

it to be bold and I’d also like to change the size a little bit. And let’s just add a couple more 

things to this. Let’s add a border so it looks kind of neat here. So we’ll go down to Borders and 

Shading. We’ll last select this one. We’ll give our border a color and we’ll make it a little bit 

thicker and we’ll click OK. One more thing. Let’s put some shading inside of that. I’ll just go 

ahead and choose a light blue here. Based on all the formats I just chose I can go ahead and 

select this title and let me show you how to save this by example. 

I’m going to go ahead and use the scrollbar here where my Styles are and I’m going to choose 

Create a Style. Now here it asks you to give your style a name and you can actually call this 

anything you want. I’m just going to go ahead and call it My Title Style. That way we’ll know 

what it represents. Now here’s a preview of it right down here. And all I’m going to do is click 

OK and let’s see if it’s on our list now. And you can actually see it’s the first one right there. So 

I’m going to go ahead and scroll just to show you the whole thing. There you go.  

So let’s do this. Let’s say I make this normal. This is how it was when we first came in. and now 

I’m going to go back and click on My Title Style and there it is. So I can use this any time that I 

like.  

Just so you will know, when you create a style it’s only available in this document unless you tell 

it otherwise. And I’ll show you where that little option is here shortly. 

The second way you can create a style is where you go in, give it a name and you manually pick 

all of the options that you want. So let me show you how to do that as well. 

I’m going to go ahead and click the arrow that’s on the right of my Style grouping and here’s a 

list of your styles. Now real quick let me just show you that as you go down the list it’s going to 

show you all the formats that are part of that style. All the way down to the bottom a couple 

things to notice. There’s a little checkbox that says Show Preview. You just click on that if you 

want to see what that style will look like. Also notice a couple things. You have the ability here 

to create a new style. I’m going to go ahead and click on it and now it takes me to the Create new 

Style from Formatting window.  
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Now the first thing that we need to do is go ahead and give our style a name. So I’m going to call 

it My Subheading. And the next thing is the style type. Now because we’re clicked in a 

paragraph then it recognizes that. But notice this could be a character type, what they call a table 

type, a list type. But this is a paragraph. This style is based on My Title Style. So that means that 

I was clicked inside My Title Style when I decided to create this one. If you don’t want to 

actually change that one when you click OK at the bottom tell it No Style and then you’re 

creating a fresh one from scratch so to speak. Here is the style for the following paragraphs. That 

basically means every time you pick My Subheading what’s the following paragraph style going 

to be? And in this case we’ll just say Normal. Here are your formatting options that you’ll 

already be familiar with. So if you wanted to change the font you could, the size. Let’s say I 

make it a little bit smaller. Maybe I want it to be a little bit of a different color as well. Maybe I’ll 

give this purple color. And then of course if you want it left aligned or centered, any of the stuff 

that you see here you could certainly apply as well.  

Now down at the bottom I just want you to notice that this is the current formatting options that 

will be in this style. If you choose any additional ones from this Format button here you’ll see 

them in that little area as well. Anything that you see here can be part of your style. So all of 

your font options, paragraph options, tabs, borders. If you work with framing, if you work with 

shortcut keys, any of this stuff can become part of your style.  

Also notice a couple of these things back here. It’s going to automatically add the new style I’m 

creating to the Style gallery over here. And also you can have it automatically update if you’d 

like. And then I mentioned to you earlier that when you create a style it’s available in this 

document only. Here is the little option right here if you want to be able to create a new 

document and have this style available for that brand new document.  

So you just choose all of your options in here and then you click OK and now you have a new 

style. You can see that it’s here on your Styles list and it’s also over here. Now I’m going to go 

back and change my title to My Title and I’m going to change this one to My Subheading. There 

you go. And I could go down the list and change them all to My Subheading if I wanted to do 

that. So now you’ve seen two different ways to actually create a style. 

What I’d like to do now is go ahead and talk to you a little bit more about styles and I want to 

show you how to go in and edit some existing styles that you already have. I will see you over in 

section 3. 
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Video: Editing Styles 

Cindy: We are working in Microsoft Word 2016. We’re all the way down to module 7 where 

we’ve been talking about styles. We’re in section 3 now where I want to go through and show 

you how to edit some of those styles that you learned how to create in section 2. 

I’m going to go up and click this arrow on the right of my Font grouping because I want to look 

at the Styles again. Now I told you earlier that you can just point to any one of these styles and it 

will tell you all of the formats that make up this style. But in addition to that do you notice 

there’s an arrow on the bottom right? So if I click on that here’s some of my choices as far as 

editing my style.  

The first thing is if you want to update this style to match the selection. So what that means is 

let’s say that I happen to be clicked here, for example, and then I come over to my subheading 

here, click the arrow. I can update this to match the formatting that’s in this current selection. 

You can also click here to modify and this is the big area that I wanted to show you. 

When we created our style we did it in this window here. So if I want to make any changes to 

this I just come and make them right here. Let’s say that one of the changes we want to make is 

we don’t like this purple color we picked. We’d like to pick a matching blue color. So I’m 

actually going to come down and pick this blue and now you can see the preview of what it’s 

going to look like. Now I can make any other changes I like but I’m going to go ahead and click 

OK and now when I look at my subheading it has a different color. If I actually click the arrow 

again and go back to Modify you can see the existing color is that new blue that I chose. 

The other thing is, I don’t know if you can see this but back here on our document everywhere 

that My Subheading was being used automatically changed to that blue because it has new 

formatting.  

Let me go back here and click the arrow again. Here I can also select all the instances where I’ve 

used My Subheading and it says there’s five of them. So I’m going to choose that. So now 

whatever I do next will affect all five of those instances. Another choice I’m going to have is to 

clear the formatting of all five of those. If you clear the formatting then those areas you have 

selected revert back to the normal style automatically. Notice here you can also delete your 

subheading. So the same thing as clear. If I delete My Subheading I’m not deleting the text, only 

the formatting. So it will revert back to the normal style.  

Now the other thing I can do is just remove it from the Style gallery. That doesn’t delete it. That 

just removes it from here. So those are going to be your choices there as far as modifying or 

editing your styles. 

I also wanted to point out a couple of things at the bottom. There is a checkbox that says Disable 

Linked Styles. What that means is this. Let me take you back into My Subheading again and I’m 

going to go to Modify. One of the things I told you when you were creating styles is that if you 

have a style for following paragraph that links this style to the new style you created here. That’s 

a link style. So if you wanted to disable that then you just go ahead and check the box here and 
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it’s disabled. Let me cancel that. And we saw a couple of options at the bottom. The first one was 

the new style. The second one is called the Style Inspector. The Style Inspector will actually go 

through and double check that your styles don’t have any errors or things like that in them. And 

if it does it will tell you what those are.  

A couple more things you have the ability to do. You can also manage your styles from this little 

button here. This takes you all the way back to this window. Now the reason I wanted to show 

you this is because you now have some additional options. We already know how to use all of 

the options under Edit here. So under Recommend, this will go ahead and recommend which 

styles you might want to follow other styles and so forth. And you can actually move these up or 

down on the list. So if you want My Title Style to always be the number one style or the main 

style you can move it up in the list. 

The next tab over is the Restrict tab and you have the ability, if you want, that when a document 

is protected for formatting, for example, you can set it up so certain styles can be available to be 

edited or formatted when the document is protected. And then the last one is you can set defaults. 

So if you want to set particular defaults for this particular style you can do that here as well. 

There’s some options here. 

So I’m going to go ahead and cancel that but I just wanted you to know that those were available. 

And also notice the Options down here on the bottom of your Styles list. In here you can say 

Show the recommended styles, which is what’s on this list here. But you could also say Only 

show the ones in use, All the styles, and then you have some options down here about how the 

list is sorted as well. So take some time and go look through all those options because all of those 

pertain to the styles. 

That’s going to wrap up how styles work. So what I’d like to do now is take you over into 

section 4 which is the practice exercise and get you to do a couple things just to make sure 

you’re okay with how Styles work and then we’ll move on. 
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Video: Module 7 Practice Exercise 

Cindy: We’re almost done with module 7 where we’ve been talking about Styles and I wanted 

you to take a couple of minutes and go through the practice exercise just to make sure you know 

how to use and create and edit styles just like we talked about. So here’s what I want you to do 

for me. 

First I want you to open a practice file called Practice Styles. Select the title there and format it 

any way you like because you’re going to go ahead and create a style based on that. I want you 

to create one by example as we call it. That’s where you select your text and you go ahead and 

name your style based on that. You’re going to name it My Title Style.  

Next I’m going to have you create a new style from scratch using the Style gallery to do it. Name 

the style My Subheading Style and then make sure it’s available for all new documents before 

you go ahead and click OK. Go ahead and apply that new style to each subheading in the 

document and see how it looks. 

Go ahead and save the file when you’re done and that’s it. Great job! 

What I’m going to have you do now is let’s move over into module 8 and we’re going to talk a 

lot about different ways to control the page appearance. I’ll see you shortly. 
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Module 8 – Controlling Page Appearance 

Video: Working with Page Breaks 

Cindy: Hi. This is Cindy again. We are still working Microsoft Word 2016 and we’re now down 

to module 8 where we’re going to talk about different options to control the page appearance. 

We’re in section 1 right now and I want to talk to you a little bit about working with page breaks. 

There are two types of page breaks you can have in a document. First you can have what’s called 

a soft or automatic page break and those are ones that the computer automatically inserted. What 

happens is when you’re typing and you get to the bottom of a page if there’s no more room on 

that page to put more text Word will actually insert a page break for you. And here’s a great 

example of it right here. 

Notice how this one actually broke up my paragraph called Sales Associates and I may not want 

that. So that leads me to the second type of page break you can insert and those are ones that you 

have manually put in. So those are called hard or manual page breaks. Now here’s an example of 

one of those and I’ll scroll down here.  

Now when I turn on the non-printing characters you can see there’s a dotted line and it says Page 

Break. That’s a manual or a hard one. That’s one you inserted. Versus if I scroll back up and 

look you don’t see that here. So that’s an automatic one.  

Let me show you how to put in a page break.  

I’m going to click in front of the S in Sales Associates because I’d like to keep that paragraph 

together. Now you can always put less on a page but you can’t put more. So let me show you 

what I mean by that. I’d like to actually insert my page break right here where it says Sales 

Associates. So I’m going to go up to the Insert tab and here is Page Break. And now you see it 

inserted a page break and it moved all of Sales Associates down to the second page.  

To delete a page break click anywhere on the dotted line where it says Page Break and hit Delete 

on your keyboard. You can only delete ones that you manually inserted. You cannot delete ones 

the computer put in. You just have to adjust for those. Let me show you what I was talking about 

when I said you can’t put more text on a page. 

Let’s say that I want to put all of Sales Associates on the first page and I decide to click in front 

of Corporate and put it in there. Well what’s going to happen here is when I insert the page break 

then it’s going to actually give me another actual page in my document. So here’s what it did. I 

still have these two separated but it inserted a page break down here and then everything else 

went onto the next page. So that’s a good example of what I’m talking about. So let me delete 

that. So you can always put yours in and if you’re going to do that put them above not below 

where the automatic one happens to be. 

Another little trick is this. If you don’t want to use your tab Insert and then Page Break use 

Control-Enter. That’s a quick way to insert a page break. And then again to delete it click on the 

line and hit Delete on your keyboard. 
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If you start working with your page breaks you’re going to have to look at each one in your 

document because sometimes changing one could adjust the other pages in your document as 

well. So go ahead and just make sure you double check everything in your document before you 

go ahead and save it. 

That’s how page breaks work. They’re pretty easy. So why don’t we go into section 2 and I’m 

going to talk to you about another type of break you can have in your document called a Column 

Break.  
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Video: Working with Columns 

Cindy: Welcome back to Microsoft Word 2016. We are all the way down in module 8 where 

we’re talking about different ways to control the page appearance. Now we talked about working 

with page breaks in section 1 so now we’re in section 2 and I want to talk to you about working 

with column breaks. 

You have the ability within your document to add multiple columns. Now typically what 

happens in Word is you have one column to begin with and then you add additional columns as 

you need them. Let’s say that you wanted two columns in your document. Here’s how you would 

insert those. 

You’re going to go to the tab that says Layout and here it says Columns and notice that I can add 

several columns right here from the dropdown. I’ll go ahead and say I’d like to have two 

columns. Here’s how you know that you have multiple columns. If you look at the ruler there’s 

now a gray area right in here. That’s the line that separates the columns. So when you’re typing 

you’re going to be able to type to about right here and then it’ll start word wrapping. And then in 

this column you’ll be able to start right about here. 

So here’s what’s going to happen. You’re going to start typing and you’re going to have your 

text in here and notice that the text is going to start word wrapping just like I said a moment ago. 

All the way down. What’s going to happen is it’s going to fill up all of the first column and when 

it comes to the bottom of the page then it’ll wrap up to the top of the second column. So right 

now if I wanted to type something over in the second column I can’t do it. Sometimes what 

people will do is they’ll try to hit the hit Tab key to get over there and that doesn’t work. And 

also I can’t click over there. Now the reason for that is because just like pages you can’t type on 

a second page unless you insert a page break to create a second page. Well the same thing works 

here. You can’t type in another column even if you’ve put the column in unless you actually 

insert a column break which allows you to click over in that second column and manually type 

something. Here’s how you put in a column break. 

Make sure you’re clicked wherever you want the column break to be and then you’re going to go 

to Breaks right here. Now these are all the different types of breaks you can put in a document. 

While we’re here notice the Page Break option that we had done previously through the Insert 

tab. But here you’re going to see the Column Break. Now let me show you what a column break 

looks like if you have your non-printing characters turned on. It looks just like this. So anywhere 

you see a column break, any text to the right of it goes to the next column over. So you can’t 

really click down here and type any text after the column break. 

So now I can type anything I like over on this side. And if I want to go back to the other side I’m 

going to click before the column break, hit Enter a couple of times and type my text. So the 

column break is always at the end of the text that’s there. If you had a third column you would 

have to the same thing. You would click over in column two and wherever you wanted to insert 

the break you would do it the same way. Remember that was under the Layout tab, Breaks and 
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then you see Column Break right here. So let me go ahead and show you how to take an existing 

document and convert it to multiple columns as well.  

I’m back over in the Page Appearance document we’ve been working in and you can see it’s just 

one column. What I’m going to do is I’m going to go ahead go to the Layout tab, I’m going to go 

to columns and say I want two columns. And there you go. That’s all you have to do in an 

existing document. 

Now when I look down this document you’re going to notice a couple of things. It doesn’t look 

quite balanced and there’s not a balance option for columns in Word, just so you’ll know. But if 

you knew there was somewhere specific you wanted to put the page break, like let’s say for 

example right here, then you could click there and insert it and everything to the right of your 

insertion point in this case would move over to the second column. So just kind of know that you 

can do that as well. 

Now you do have some other options with columns I want to show you. So I’m going to go back 

to the Columns and click the dropdown and I’m going to go down here where it says More 

Columns. Here again is where I can specify I’d like three columns, I want to put a smaller 

column on the left, a larger column on the right. You can kind of see the little preview there. But 

right here where it says Width and Spacing, this is where you can specify for each column the 

exact number of inches you’d like the column width to be. Right now it’s checked here where it 

says Equal Column Width. If I uncheck that then I can type in either one of these to specify my 

column widths. Also I can change that spacing between the columns. If I need it smaller I can do 

that.  

I want you to start noticing that from now on we’ve got this Apply To option. Now currently it 

says apply these options to the whole document but I can say from this point forward if I want. 

One other option that’s here and that’s the Line Between option. That puts a line between your 

columns like you see here. So I’m going to go ahead and click OK and just show that to you. 

And there you go. So you can always work with columns. They’re pretty easy to do. Remember 

to insert those column breaks if you’d like to be able to click over in the next column to be able 

to type information. 

What I want to do now is go ahead and take you down to section 3 and we’ll talk about adding a 

watermark to our documents. 
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Video: Adding a Watermark 

Cindy: Hi. Welcome back. This is Cindy again. We are working in Word 2016. We’re in module 

8 right now. We’re talking about different options as far as controlling the appearance of the 

page. We’re all the way down on section 3 now where I wanted to show you how to add a 

watermark to a document. You’ve probably seen watermarks before. A lot of times they will say 

the word Confidential and they’re just gray and light in the background. Well you have the 

ability to add some of those predesigned ones or you can create your own. So let me show you 

how to add a watermark to your document. 

Adding a watermark to your document is fairly easy to do. All you’re going to do is click on the 

Design tab and then go all the way to the right where it says Watermark and click the down 

arrow. The first thing you’ll notice is they have a couple of predesigned ones that if you’d like to 

use one of these you can. So if I just click Confidential, for example, you can barely see it back 

there but that’s what a watermark is. But I want you to notice that you can also choose from 

some additional ones by going to Office.com and you can get there by clicking right here. You 

can also remove a watermark right down here. So if you wanted to take it off you just click 

Remove and you can see now that it’s gone.  

Now I want to show you how to add your own watermark because you’re going to want to put 

your own text and maybe a picture in the background. So right down here you’ll see it says 

Custom Watermark. 

Now the first thing you’ll notice is that it’s on No Watermark which is how you would take it 

off, but also you could have a picture as a watermark. If you choose that option you can select 

the picture that’s a file in your computer already and make it the watermark. You can also use 

text which is generally what people do. You’ll notice with the text option that you can choose the 

language you’d like and then the next option says Text and that’s where you take out whatever is 

in there and put your own text in. I’m going to put in the name of the company, Burke Properties. 

Then you can also choose a font and the size if you’d like and also a color. So if that gray’s a 

little too light for you go ahead and choose another color that you might like a little better. You 

can have the watermark go diagonal, which is going to be just like this, or horizontal which is 

going to go across this way. All you do is click Apply once you’ve made your choices and there 

it is. It’s a little bit darker because I chose that darker blue there. When you’re finished you just 

hit Close and now you have a watermark. That’s really all there is to adding those watermarks. 

I’m going to go ahead and wrap up this section now and let’s go ahead and go over to section 4 

and talk a little bit about applying page borders. 
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Video: Applying Page Borders 

Cindy: Hey there. Welcome back. We’re still working in Microsoft Word 2016. We’re all the 

way down to module 8 and we’re now in section 4. We’ve been talking in this particular module 

about controlling page appearance and we’re going to talk in this section about applying borders 

to your pages. 

Borders really enhance the look of your document. You can actually have some professional 

looking borders and you can also have some really neat looking fancy-type borders using some 

artwork. So let me show you how to apply borders. 

You’re going to click on the Design tab and you’re going all the way to the right where you see 

Page Borders. You might be familiar with this screen because when we talked about the Borders 

and Shading in a previous module we were on these two tabs here. The middle tab here is where 

you apply the page borders.  

On the left you have different settings. So you could have a box, for example, which is just a box 

around your page, one that has a shadow, one that has a three-dimensional effect. Then you can 

choose a style. So instead of just a straight line you might want one of these other styles that you 

see listed here. You can then pick a color if you’d like and then a width which is like a thickness. 

You can see a little preview that all four borders are going to have this particular style, color and 

width that I chose. If you don’t want your border to look the same on all four sides notice how 

you can just click to deselect a border and then if you wanted to apply a different one you could 

certainly do that. You could go and maybe pick a different color or something like that.  

Let me go ahead and click OK and see what this looks like. And there’s your border. Now it’s 

going to be around all the pages in your document. So just remember that.  

Now I’m going to go back to Page Borders and I want you to notice that you now have Artwork 

down here at the bottom. So you’ll notice that when you first click the down arrow you’re going 

to see cupcakes and you’re going to see lightning bolts and balloons, just all kinds of borders and 

I’ll just click a few to show you what they look like. But you can also make this a little more 

professional if you need to. As you scroll down the list you’ll notice there are some that are just 

black borders near the bottom. And you can actually apply any of those and change the color if 

you needed it to be a little different. Like this one, for example. I can apply this one and you can 

see it looks a little more professional. 

I’m going to go back to Page Border and I want you to notice one more thing. Currently, like I 

said, you’re applying this to the entire document but you do have the ability to apply this to this 

section. This section, just the first page or everything except the first page. We’re getting ready 

to talk about sections over in module 9 so just know that this is here when we get to that 

particular option. But that’s really all there is to applying borders. Borders really enhance the 

way your document looks. 

Let’s go ahead and wrap up this particular section and we’re going to talk about headers and 

footers over in section 5. So I will see you shortly. 
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Video: Headers & Footers 

Cindy: Hey there. Welcome back. We are working in Microsoft Word 2016 and we’re in 

module 8 where we’re talking about different ways to control the appearance of your page. 

We’re all the way down now to section 5 where we’re going to go through the Headers and 

Footers option that Microsoft Word has.  

Headers and footers actually are inserted into the top or bottom margins of your document. A lot 

of times a footer, for example, might say Page 1 or a header might have the company name, 

things like that. Headers and footers are going to be on every page. So you’ll see a couple 

different options we can work with when we’re inserting our headers and footers. So let me show 

you how this feature works. 

If you had a header and footer in your document you would see them in the margin areas on the 

top and bottom of your page and they would be in gray. The quickest way to open up the header 

and footer section is to double click in a header or footer just like this. And now you’re in the 

header and footers and you can see your Header and Footer tools contextual tab here. 

What you want to do is put in any text or pictures or anything you’d like to be in a header or 

footer and then you can go back and actually work with formatting and things like that. So I’m 

going to go ahead and put in a header here and I’ll put in the name of the company, Burke 

Properties, and I want you to notice that in a header or footer there’s a center tab automatically 

and there’s a right aligned tab automatically. So that way you don’t have to worry about 

centering something on the page and that sort of thing.  

Now let’s say that over here on the right I wanted to put in the current date and maybe even the 

time. I could type in the date and then every time you open this file it would have that date. If 

you’d like to use Word’s Date and Time feature then you’re going to actually use this button 

right here, Date & Time and it will quickly insert the date and time based on the format that you 

choose. So I can choose any format here and the key to this updating is notice this little checkbox 

at the bottom that says Update Automatically. If that’s checked then tomorrow this will say the 

18th, the next day it’ll say the 19th and so forth. You can see that when you click in there there’s 

some gray and also it says Update. So that’s how you know that it’s going to update tomorrow. 

Now I’m going to scroll down to my footer. Now instead of actually double clicking down here I 

could have actually used this button that says Go to Footer. And if you’re in a footer notice it 

says Go to Header. 

Let’s say that down here I would like to put in a page number. Now I could type in Page 1 of 5 

but then every page would say Page 1 of 5. So what you want to do is have Word automatically 

update the page and the page numbers for you. The quickest way to do this is you notice there’s a 

Page Number option right here and you can choose whether you’d like to see the page number at 

the top of the page, the bottom of the page and they give you several different formats. So you 

choose the particular one that you happen to like. So I’ll choose this one. What’ll now happen is 

the next page will say 2 and the next page will say 3 and so forth because Word is going to 

automatically update that for me.  
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Now I’m going to go ahead and tab over to the right and let’s say down here that I’d like to put 

in some information about the document itself. You’ll notice right here it says Document Info 

and there’s several different things you can put in here. You might put the author, the name of 

the file, the file name and path, you can see the document title, different things like that. I’ll put 

in the file name. And so it does say Page Appearance down here now.  

Now let me go look at what I’ve done. I’m going to close the header and footer. Now let me 

scroll up to the top and you should definitely see your header and footer there. You can see them. 

And if you look at the bottom of the page it says Page 1, Page Appearance. Okay that’s good. 

Now let me scroll to the bottom of page 2. Notice how the page has been updated. Or if I go to 

the bottom of page 3 you’ll notice it’s been updated there as well. So that’s how the page 

numbering options is going to work for you. So let me scroll back up to the top here. 

Now I’m going to double click in the header again and show you some of these other options that 

are available. 

Over here where it says Header and there’s a Footer button to the right of it, these are just some 

predesigned ones. If you liked any of these you could certainly just click on the one you like and 

then you’ll be able to actually edit the information that’s there. There’s also more headers if you 

go to Office.com. Down here at the bottom you’ll see that. And also a way to remove the header 

down here. The Edit is just like we’re doing currently where we’re typing in the information we 

want in the header.  

Now under the Footer Info it’s pretty much the same. You’re just going to have different options 

for things you may want in the footer.  

Page number. We talked about page numbers being at the top or bottom of the page but I also 

wanted you to notice that you can have page margins as far as your numbers go and you can also 

have the current position if you wanted to actually move these a little bit more to the left, right, 

different options you have there as well. Here’s where you format your page numbers. A few 

things in here I wanted to mention. I’m currently using 1, 2, 3 as my page numbering style but 

notice I could use ABCs if I’d like, Roman Numerals. You can see the list here. There’s different 

number formats you can use. If you’re working with chapters then you might set it up where you 

say every time you use a certain style or use a hyphen that you can use that as a chapter and page 

number and there are some examples of how you could set that up. 

Now the other thing is if you’re working with sections then you can say that you want this page 

number to start at a certain page number or continue from the previous section. Alright let me 

cancel that.  

We talked about Date & Time and Document Info a little bit. We’ll work with Quick Parts a 

little bit later and you’ll see how that works. Notice you could also put some pictures in here 

from your computer or if you have any online you’d be able to use those as well.  

Now come over here where you see these checkboxes because I want to show you what Different 

First Page means. If you have a document that has multiple pages you might not want your 

headers and footers to print on page 1. It just looks unprofessional. So if I check Different First 
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Page I want you to notice that when I close the header and footer there’s no header and footer on 

page 1 but there is on the other pages in my document. And notice it didn’t renumber these. This 

is still page 2. You just don’t see the header and footer on page 1. A little more professional that 

way. 

Now let me double click in here and show you one more thing. I want to show you the Different 

Odd & Even Pages. Currently you notice this says Page, First Page Header and it’ll say First 

Page Footer at the bottom and then it says Header and Footer at the bottom of the sequential 

pages. You have the ability to have something different on every odd and even page. Notice if I 

check the box that now it says First Page Header and when I come down it says Even Page 

Header and the next one will say Odd Page Header. So anything you type on the even page 

header will be on page 2, 4, 6, etcetera. And anything you type in the odd page header will be on 

all the odd pages in your document. So it could be something like this.  

Let’s say on the even pages you want to put the company name, Burke Properties, and let’s go 

down to an odd page and let’s say on the odd pages you want to get rid of Burke Properties that I 

have here and put in your name. So we can say Presented by your name. Now let me go ahead 

and close the headers and footers and see what it looks like. Page one will not have a header or 

footer because we had that option on to not show it on the first page. Now we said on our even 

pages we would want to have the company name. So page two had Burke Properties and look 

how the odd pages have your name. Even pages has the company name and the odd page has 

your name. So you can see how that works as well.  

Now I probably need to go in here and fix this. So I’m going to double click on this and what 

happened here is I actually put some extra tabs in. So all I have to do is if I say Name here and 

make sure I take out the spaces if I have extra ones or add them back in because this has a right 

margin here to line up perfectly. Then I’ll close the header and footer and now you’ll see it’s 

perfect.  

So that’s a quick overview of how headers and footers work. You can always use them in any 

document you’re working with.  

Well that’s going to go ahead and wrap up module 8. So what I’d like to do now is have you go 

over to the next section which is your practice exercise and I’ll show you a little bit about what I 

want you to do just to make sure you’re okay with everything we covered in module 8. 
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Video: Module 8 Practice Exercise 

Cindy: We’re working in module 8 now, Controlling Page Appearance, and we’re all the way 

down to the practice exercise. We talked a lot in this particular module about working with 

columns and we talked about working with page breaks, applying borders to your pages, headers 

and footers, things like that. So what I want to do now is just make sure you can do a lot of this 

on your own. So here’s what I want you to do for me. 

Go ahead and open a practice file called Practice Module 8. Add a page break before the heading 

that says Other Media. That way all of the paragraph there will stay together and it’ll be on page 

two. Go ahead and format this document to be two columns. Add a header that has your name on 

the left and the date on the right. And if you want to add a footer feel free to do that as well. You 

can put the page number in the center maybe. Go ahead and apply a page border. You can pick 

the one you like and then save and close the file for me. And that’s all I want you to do. 

Great job!  

So what I’m going to do now is have you go over to module 9 and we’ll talk a little bit about 

sectioning. 
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Module 9 – Sectioning  

Video: What is Sectioning?  

Cindy: Hey there. Welcome back. This is Cindy again. We are still working in Microsoft Word 

2016 and we’re all the way down now on module 9, Sectioning.  

This is the first section in this particular module and I wanted to take a minute and just tell you 

what sectioning actually is. Think about a document that has multiple pages and you’d like to 

have different margins in different parts of the document than in others. You can create sections 

to make that happen. That’s just one example. I’ve got something quick that I want to show you 

that will help you understand sectioning a little bit better and then when we get through that 

we’ll go through and actually section a document. 

Let’s say that you have this document that has three pages in it. The first thing I want you to 

notice in my little example here is that the first two pages are what we call Portrait where they go 

up and down and this bottom one is called Landscape. We’re going to put a picture here and we 

need to turn the paper long way so that the picture actually fits in there.  

A couple of other things to notice in my example. If you notice this is the first page and it’s like a 

cover page for a document. And let’s say that I’d like to put the title deadest in the center. There 

is an option in Word to do that but it would affect your entire document unless you create a 

section. So if you notice what I did is I put a section break in here and we’re going to be talking 

about the fact that there are different types of section breaks. This one is called a Next Page. 

Next Page means you’re actually putting a page break in at the same time so that anything below 

it goes onto the next page.  

Let’s look at this part here. This is another page but in this particular case I wanted to have like a 

little newsletter-type effect so I have a title across the top which is really one column and then I 

wanted two columns below like you see here. Well in order to create columns I can do that but it 

would affect again my whole document. So what I did is I put in a section break right here which 

is called Continuous. Continuous means you’re not going to force everything below it to the next 

page. You’re just going to stay on the same page but break that particular document at that spot. 

Notice now you’ve got section one and page one happen to be the same but notice section two 

and section three are on the same page. So keep in mind that pages and sections are not the same 

thing.  

One more quick example. Down here at the bottom we’d like to put a picture in and I need to 

turn the paper what they call landscape so the picture will fit in here. Again I can turn that option 

on but it’s going to affect the whole document unless I’ve sectioned it off. So that’s just a quick 

example of some different sections you might have in your document. 

What I’d like to do now is go ahead and flip over to a practice exercise and show you how to 

take a document and create these sections in your document. 
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Video: Sectioning a Document 

Cindy: Let’s take a quick look at this document before we start creating our sections.  

The first thing I want you to notice is that there are two pages in this particular document. The 

first page has a title and a subtitle, then there’s some text under the About Us section here. And 

then if you go down you’ll notice there’s a picture on page two which doesn’t fit right on the 

page. We’ll be fixing that so don’t worry about that. 

Now if I go up and look at both page one and two you’ll also see a header and footer. One of the 

things that I’d like to accomplish when I’m finished is I want to take the header and footer off of 

the first page just so that it looks a little more professional.  

Before we start putting sections in I want you to notice at the bottom left you’ll see it says 

Section 1. This tells you the actual section that you happen to be clicked in. If you don’t see 

Section down here just right click anywhere on that status bar and you’ll see Section is one of 

your choices as far as turning on or off the view for that. Now let’s go ahead and do a little bit to 

make this document look a little bit nicer. 

The first thing I’d like to do is I’d like to take the title here and this subtitle and put them on a 

page by themselves. Now I could put in a page break but just doing that won’t create sections. 

I’d like to actually create a section break and also have it break the page for me. Here’s how I’m 

going to do this. Notice I’m clicked after the exclamation point? I could also click in front of the 

A in About Us, either one would give me the same end result. To create sections you’re going to 

click on the Layout tab and then you’ll see Breaks. And here’s your Section Breaks down here. I 

want to put in a Next Page Section Break. And now you’ll notice that my title and my subtitle are 

on the same page. Now let me show you what a Next Page Section Break looks like if you have 

the non-printing characters turned on. It’s going to look just like this. It says Section Break Next 

Page. So next page means anything below the break is on another page. You actually have three 

pages now. If you look right down here it says Page 1 of 3.  

The next thing I’d like to do is in section 1 I’d like to actually take my title and my subtitle and I 

want to center them on the page. I’d also like to change this second line so it doesn’t word wrap. 

I’ll be changing the right and left margins to do that.  

I’m going to go back to the Layout tab and I’m going to go ahead and click on the arrow at the 

bottom right of the Page Setup grouping. First of all under the Margins tab here I’m going to 

change the left and the right to 0.25 each. I’m also going to this Layout tab and where it says 

Vertical Alignment I’m going to choose Center. That’s going to center it from top to bottom. I 

want you to star noticing this as well. It says Apply To and it defaults to this section because I 

have a section here. Notice my other choices are to apply these options from this point forward 

or the whole document. But I’m going to click OK and then we’ll look and see what we’ve got.  

So this is page one and I’m going to zoom out a little bit so you can see it a little bit better. But I 

want you to notice that page one over here actually have everything right in the middle of the 
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page from top to bottom and notice the second line doesn’t word wrap anymore because I 

changed the margins. That’s not true over in the second section here.  

One more thing I want to do is I want to take this header and footer off. So I’m going to double 

click in my header and remember that this Different First Page option allows you to take it off. 

So I’m going to close the header and footer and now you’ll see no header and footer on page one 

but I do have it on page two and page three when we go down there you’ll see that. 

Now if I click over here on the right you’re going to see that this is section two. Now let me go 

ahead and zoom back out a little bit. I can have one page here. Now what I’d like to do in section 

two is I want this to look like a newsletter. So I’m going to type a title right here. We’ll say 

Burke Properties. And notice I hit the Enter key because what I want to do is make Burke 

Properties a section all on its own so that it can be one column and I can center it. And then the 

About Us I’m going to put in another section so I can make it two columns. So what I’m going to 

do is right in front of the A in About Us I’m going to insert a continuous section break this time. 

And continuous basically means that I’m not going to create a new page when I do this but it 

does break the document. And you can see what a continuous section break looks like right here.  

Now I’m going to go ahead in section three. So you can see down here I’m in section three. I’m 

going to make this two columns. So I go into my columns and I’m going to say two columns. 

And you can see now that I have two columns but they’re not balanced at all. So what I’d like to 

do is put in my own column breaks so I can shift text to the right of it to the next column. And 

I’ll do that right in front of Our Philosophy and Affiliations right here. So I’m going back to 

Breaks and I’m going to put in a column break.  

Now let me go turn those non-printing characters off for just a moment. So I’ll go back to Home 

and just turn them off so you can see this a little bit easier.  

Now it still looks like everything on this page is in two columns but here’s the deal. Remember 

that Burke Properties is in its own section? And this section had one column. And the way I 

know that is I’m going to select it and I’m just going to center it on the page here and there you 

go.  

Now let me make this look a little bit nicer because I want it to be like the heading for my 

newsletter here. So I’m going to go ahead and apply a border and I’ll just pick this three 

dimensional, we’ll give it a nice little style and a color here. And then I’ll pick a shading to go in 

the background here. Now let me click OK. There you go. How about if I change the text color 

just a little bit? Maybe make it this blue and maybe make the font a little bit larger. Let me go 

look down the page here and see what else we need to do.  

Alright so the next thing I want to do is I’m going to take the Home Office and I’m actually 

going to put it on the same page with the picture here. So we’ve got a few things we need to do 

here. Let me go ahead and select the space in front of the Home Office and I’m going to put in a 

next page section break. So I’m going to go back to the Layout tab, Breaks, Next Page. 

We’re in section four now and you’ll notice that section four still has two columns because we 

had previously set up those two columns before we created this section. So let’s go ahead in this 
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section and make it one column and now you’ll see the picture fits back on the page. Now it still 

looks a little funny over on the right and the reason is because the picture is too large from left to 

right. So why don’t we turn the paper landscape? So again in the same section I’m going to go to 

the Orientation button and I’m going to click Landscape. Now what happened is because my top 

and bottom margins weren’t large enough it took the picture and put it on the next page but we’re 

going to fix that real quick by changing those top and bottom margins. So I’m going to go back 

to my Page Setup, back to Margins and I’m going to make my top and my bottom each 0.25 for 

this section. And now you’ll see it fits on the page. So all I have to do is go back to Home and 

center it if I’d like just to make it look a little bit nicer. 

So that gives you a quick overview of how sections work. You’ll notice we were able to do 

several different things in our document because we had different sections created. Now 

typically in a three page document like this you won’t have this many sections. But if you’re 

working on some really large documentation you will definitely want to have sections set up in 

your document so you can do different things. 

Let’s go ahead and talk over in the third section real quick about working with the odd and even 

sections. 
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Video: Odd & Even Sections 

Cindy: Welcome back. We’re still working in Microsoft Word 2016 and we’re working in 

module 9 where we’re talking about sectioning. We’re down to the third section in this module 

where I want to briefly tell you how to work with odd and even sections.  

We’ve already talked about the importance of creating sections in our document. Creating 

sections allows you to have something different happening in one part of your document than in 

another. We had seen that you could have different margins in different sections of your 

document. We saw that we could have different columns. So I wanted two columns in one 

section and one in another I could do that. But let’s take this even further and talk about the fact 

that when you’re looking at your section breaks you can put in different even or odd page section 

breaks. 

Now what these do is depending on which one you’ve clicked on it’s going to insert a section 

break there and start the new section on the next even number page or the next odd number page. 

A really good example of this would be chapters. You might have seen that when you’re looking 

through a book sometimes and there’s a new chapter that the left page will be blank and the right 

page is the beginning of that chapter. What Word will do is if a section break falls on an odd 

numbered page it leaves the intervening even number page blank. So let me show you what I’m 

talking about here. 

This is actually page two and I’m going to go back to the break and I’m going to put in an odd 

page section break. And I want you to notice that it moved everything to the right of the section 

break down so that actually I’m now on section three and it’s page three. And notice that page 

two is actually blank. Now you’d have to go and take this off but page two is blank because if 

you think about a book that’s the left hand page that’s blank and page three is actually the 

beginning of the new chapter. So that’s a great example of how that would actually work. So just 

kind of know that you can use those different breaks which we call odd and even page section 

breaks. 

That gives you a really good overview of how section breaks work. So what I’d like to do now is 

have you flip over to the exercise and I’m going to have you do a couple of quick things just to 

make sure you know how sections work and then we’ll move on. 
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Video: Module 9 Practice Exercise 

Cindy: Hey. Welcome back. We’re in module 9 and we’re all the way down to the practice 

exercise for this particular module. We talked a lot about sectioning in this module. We talked 

about the fact that there are different types of section breaks you can insert in a document. And 

the reason you want to do that, remember, is that you might want to do something different in 

one section than in another. So let’s see how much of this you remember. 

I want you to notice that when you first open the file called the Sections Practice there are 

actually two pages in the document. And the first thing you’re going to notice is there is a title 

and a subtitle. I want to end up with that title and subtitle on the first page and it’s going to be in 

the first section as well all by itself. So what you’ll do is you’ll create a next page section break 

after the subtitle. That way it will actually put the title and subtitle all on page one and all in 

section one. Then you might want to center the title and the subtitle vertically and horizontally 

on the page just so it looks more like the cover for a document. If you want to change the font 

size feel free. You can change it to size 22 for the title and the subtitle to size 18. 

The next thing you’re going to do is go down to section 2 and make section 2 two columns. It’s 

going to look a little funny at first because that table is going to wrap up to the right but that’s 

okay. You’re going to fix that.  

You’re going to insert a column break before the heading that says Burke Today. Now the reason 

that you’re going to do that is when you first made section 2 two columns you’ll notice that it 

looks kind of funny. So to more evenly break up the paragraphs in each column put in that 

column break before the heading Burke Today will actually make it look a little more balanced.  

Next you’re going to create a next page section break right before the heading Premium Listings 

and you’re going to do that so that we can have our premium listings and our table on the next 

page and it’ll be in its own section as well. 

Go ahead and make section 3 landscape. Also you’ll notice currently that section 3 has two 

columns still. So it’s going to look funny because your table is all the way on the left. If you go 

ahead and make section 3 one column and then center the title and the table on the page it’ll look 

a lot nicer. Go ahead and save and close the file and you’re done. 

Awesome job as usual! 

Well that’s going to wrap up module 9. Let’s go ahead now and go to module 10 and talk a little 

bit about graphics. 
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Module 10 – Graphics  

Video: Inserting Pictures 

Cindy: Hi there. It’s Cindy again. Welcome to module 10 of Microsoft Word 2016. We’re 

talking about graphics in this particular module and there are a lot of different types of graphics 

you can insert. You can put in pictures. You might put in some different shapes, some different 

graphics. But let’s start off in this first section talking about inserting pictures. 

When you’re inserting a picture into your Word document wherever you happen to be clicked 

that’s where it’s going to insert the picture. You’ve got a couple of different ways you can do 

this. You can actually put in a picture that you have searched for using Bing or you can actually 

go in and insert a picture that’s a file on your computer. So let me show you how to put one in 

that you’ve got on your computer already and then I’ll just show you real quick where to go if 

you want to pull something from the web. 

I’m going to click on Insert and here you see Pictures. What you’re going to do is search through 

your computer and find the particular picture that you like. So if I like this one, for example, I 

can select it and choose Insert and then that’s going to insert the picture into my document. Any 

time you have a picture and it comes in really large like this you have the ability to change the 

size of that picture. If you notice around the edges you have these circles. Those are called 

Control Handles. Some books call them Sizing Handles. And when you grab one of them you’ll 

notice that if you grab a corner, for example, you can move two borders at once. Or you if you 

grab a side you can pull in that side and make it a little taller, thinner, wider, whatever you want 

the picture to look like. If you need to center the picture on the page just go back to your Home 

tab and choose the centering option. That’s all you have to do. Now let me just show you real 

quick where to go if you’d like to put in a picture from the web. 

You’ll notice under the Insert tab you also have this Online Pictures option. You can actually just 

click there, type in your keywords like House, for example, and then you can actually pull in 

pictures that way as well. So just kind of know that’s an option. 

I want to go ahead and talk to you a little bit now about how to insert pictures into an existing 

document. So why don’t you head over to section 2 and I will meet you there and we’ll talk 

about it. 
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Video: Inserting Pictures in Existing Documents 

Cindy: Hey. Welcome back. We’re still in module 10 where we’re talking about graphics in 

Word 2016. We’ve already talked in section 1 about inserting pictures into a blank document. 

Let’s talk now in this second section about inserting pictures into existing documents. You’re 

going to have documents that already have text in them and you want to insert pictures. You can 

have the text wrap up around the picture, go behind the picture. You’ll see some of your different 

options when you’re inserting pictures where there’s already existing text. 

We’ve already seen how to put pictures into a blank document. So now let’s put on in this 

existing document. 

I’ve got this document that talks about Burke Properties and they’re talking about different real 

estate services they provide. If I scroll down here I believe it’s on the bottom of page two, there 

we go. Here’s a section about buying a home and it talks about mortgage rates and that sort of 

thing. But let’s say that right below this in this blank space we’d like to put a picture in. So 

basically wherever the mouse is clicked or where you see your insertion point or your cursor 

that’s where it’s going to insert the new picture. All I have to do here is go ahead and insert it 

and I’ll go ahead and use the Pictures option and pick from my computer. And now I have that 

picture. Remember I told you earlier that if the picture is too large to fit in the space you’d like it 

to be in you can always work with the size of the picture. So you can try to work with the control 

handles and see if you can make it a little bit smaller and that way you’ll be able to make it fit on 

the page if you’d like. 

Now something else you might want to consider doing is having the text wrap up around your 

picture. So one of the things you can do is if you have your picture selected you can actually go 

up and you’ll see there are some text wrapping options. Now before I do that I’m going to 

actually take this picture and I’m going to click and drag it up onto the previous page. Now 

remember there wasn’t enough space in this blank area so what I’m going to do is I’m going to 

drop it off in the middle of the text and see what the text looks like as far as wrapping around the 

object. So let’s say I drop it right here. There is my picture. Now notice the text is here and 

notice it’s down below. Now I can change those wrapping options like I just mentioned. Here’s 

your Wrap Text option and I’ve got several choices. I can say Square, Tight, Through, Behind, 

In Front Of and you can actually see a little preview as you move your mouse over the options. 

Now let me just scroll up a tad so we can see this. 

So here’s Square, for example. And notice what it did is the text wrapped up to the right of the 

picture. Now in this case there was a little bit that couldn’t fit on the page so there’s a couple of 

different things I can do to fix that. Maybe I drag this up a tad more, maybe I change the bottom 

margin. There’s several different things that I’ll be able to do here. Let’s say in this case I make 

the bottom margin just a tad smaller. There you go. Now notice if I want to get this to come over 

here I’ll just grab the bottom control handle and pull it down a little bit. And then that way it 

looks like it’s a little more even with the actual text itself. So again you just have to play with 

that. 
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We’re going to be looking at some more picture options in section 3. So why don’t you go ahead 

and join me and we’ll get some of the other options you have with your pictures as well.  
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Video: Picture Options 

Cindy: We are working our way down through Microsoft Word 2016. We’re now in module 10 

where we’re talking about graphics. 

Now we’ve already talked in section 1 about inserting pictures and we saw we could insert 

pictures from files on the computer or from the internet. We also talked in section 2 about taking 

those pictures and inserting them into existing documents that already have some text in them. 

Now let’s talk a little bit about some of the options you have when you’re working with pictures. 

I’m going to go back and insert one of the pictures we saw previously. So I’ll just go to Pictures 

and I’ll pick this strange house. Now let’s say that I wanted to do some things with this. Like 

let’s say for example I wanted to take the trees off of the background here. Or maybe put some 

artistic effects or borders, those sort of things. I have a lot of different picture tools I can work 

with. You’ll notice that if you have your picture selected you should have your Picture Tools 

contextual tab here.  

Now let’s start with these picture styles. Notice these are borders you can apply. Some of these 

have a shading or a shadow option. You’ll notice there’s a down arrow so don’t forget to scroll 

and look at all of these. Some of these that are round. Those are pretty cool. This one’s pretty 

cool. It’s got more of a square type effect with rounded corners. Then you’ve got some of these 

down here that just make it look like a neat little photograph. So any of these will actually give 

your picture a little more of an effect. So you can use any of these that you like. Now if you 

decide that you want to actually remove this just go back and pick the first one there and that’s 

going to give you a little border around the edges that way if you needed some effect but not 

anything dramatic. 

A couple of other things. As far as the border is concerned you’ll notice over here that you have 

Picture Border, Picture Effects and a Picture Layout. Here’s what the border does. These were 

nice effects you could apply but the border is going to allow you to put a line around your object. 

So notice that I’ve got different colors I can choose from. I also can choose the weight which is 

like a thickness. So normally it’s set on this a quarter point here and when you go ahead and pick 

a color, for example, you can barely see it. But if I change the weight you’ll notice that the larger 

the weight the more I’ll be able to actually see the color that I choose. Also notice you can have 

dash lines. If you don’t want a straight border around your object pick from one of these dashed 

options that you see here. 

The next option down is your Picture Effects. Your picture could have a shadow around it. 

Notice that with shadows you’ve got inner shadows, you’ve got outer shadows and what they 

call perspective where the shadow looks like it lays down on the ground a little bit. So you could 

just go through all these different options and see if there’s one that you like.  

The reflection option. Your picture can actually have a reflection. You can see if I choose this 

one, for example, and scroll down that’s the reflection that I’m talking about.  
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Also under Picture Effects your picture might have a soft glow around the edges. So maybe 

something like this. You might also have what they call Soft Edges where you can pick the point 

size you’d like the edges to be. Also you can have your picture have more of a beveled look if 

you like. And then the last one there is your 3-D rotation. So if you want the picture to be rotated 

at any of these angles you can kind of go through the list and pick from some of those 3-D 

rotation options. So I’m going to go back and say No Rotation there and that’ll actually take it 

off. 

Now the last thing down here is the Picture Layout. And just so you’ll know this has more to do 

with working with different processes. So if you had flow charts, for example, or if you had a 

hierarchy of employees in the company you can work with some of these different options that 

you see here.  

Now I wanted to show you some other things you have over on this side. One of them in 

particular is the option to remove the background. I’d like to show just the house and not the 

trees and anything in the background. So when you turn this feature on it has this pink 

background look. And what you want to do is make sure this box totally covers the actual picture 

itself. If you leave out a corner or you leave out the top, for example, then it’s going to look a 

little weird because that particular part of the picture will not be in the picture when you’re done. 

So let me do a couple more here like this. And it doesn’t matter that I’m getting the trees in there. 

I’m not cutting the entire background in this object. So let’s see if we got it all now. I think this 

is going to look good so I’m going to click out to the side and see what it looks like. And that’s 

what I’ve got now. Notice how it took the entire background off, even that little shed that you 

saw in the back there. Isn’t that cool?  

Alright. Let me go back to Picture Tools and just mention a few more.  

Sometimes you don’t want to make such a dramatic effect but you can work with the 

Corrections. You can see here if I wanted to make the picture a little bit lighter or a little bit 

darker I’ve got different correction as far as brightness and contrast I can pick from. Also you 

can change just the color sometimes. I might want this to have a gray effect or I might want this 

to have one of these blue effects like you see here. All of these are going to be options as well 

that I can choose as far as the color is concerned.  

Now I’m going to undo that. And then you have Artistic Effects. These are really cool but some 

of these have like a water effect or a bubble. And they each have a little name. So you can see 

this was Pencil Sketch that I was pointing to a second ago. One of these down here, for example, 

let’s see this one here happens to be what they call Plastic. So there’s different ones you can pick 

from. 

You can also come up and compress the picture. So this is really good if you have pictures that 

are really large and you have a lot of these in your document. You might want to compress the 

size of them a little bit so they don’t take quite as much space.  

You can also go through and change the picture. And this is going to let you actually make a few 

changes that actually keep the formatting and size of the current picture but make some 
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additional changes. And then if you’ve made all these changes you can reset the picture to its 

original size and picture if you want.  

So it’s a good idea to get in there and just play with all these options and see what’s available 

because you don’t have to stick with the just boring, original pictures that you insert. So that’s a 

good bit on how to work with some of your different picture options. Let’s go ahead and go over 

into section 4 and I’ll show you how to take some of these same options and apply it to shapes. 
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Video: Working with Shapes 

Cindy: Welcome back. We’re still working in Word 2016. We’re in module 10 where we’re 

talking about graphics. Now we’ve already taken a few moments and talked a little bit about 

pictures so let’s take a few moments and talk now about working with shapes. Shapes are going 

to help you enhance your pictures. Let me show you a little bit about how shapes work. 

You have the ability to actually insert shapes into your document as well as the pictures we 

talked about. Sometimes you can use those shapes to help enhance some of your existing 

pictures. So I want to do that with this one here in a little bit once we kind of go through the 

shape options.  

So I’m going to go down to under my picture here and I’m just going to put a page break in. I’ll 

do Control-Enter. That’s a quick way to do it. Now I’m going to use page 2 here just to kind of 

play with some of these shapes. Here’s where you find the Shapes option. If you’re under the 

Insert tab here’s Shapes.  

Now you’ll notice that these shapes are listed by category. They’ve got your most recently used 

ones here at the top. But then you’ll notice they have different kinds of lines you can draw, 

there’s rectangles, basic shapes, block arrows, and then you can see flowcharts, banners, callouts, 

things like that. So let’s start with something super basic. I’ll show you how to draw just a line. 

I’m going to click the Line button and I’m not actually going to hold any keys on the keyboard 

or anything like that. I’m just going to click and drag to draw the line. Now if it goes at an angle 

like this, notice your control handles on either end. You can actually work with those just like we 

talked about with your pictures. You have all kinds of options for each of the shapes you draw as 

well. Without spending a lot of time on this notice if I have a shape selected I now have the 

Drawing Tools contextual tab. So in this case, for example, I can change the shape style, I might 

choose to use some effects. Notice the Insert Shapes button is now here as well. So if I wanted to 

keep this selected I could or if I click away from it which will deselect it now I can go back to 

Insert this way and put in a shape again.  

Now I want you to notice that your shapes can actually layer on top of each other. So you’ll 

notice that if I go and draw, for example, let’s say I go and get this one. If I just click and drag 

notice that I’ve drawn a new shape and it’s on top of that line that I drew earlier. If you have a 

shape you want to move just click right in the middle of it and drag it somewhere like this. And 

if you want to delete a shape select it and just hit Delete on the keyboard.  

Let me draw a couple of other shapes here. So I’ll go back to the Insert Shape option just to stay 

with consistency. One that a lot of people like is the smiley face so I’ll draw that one. Some of 

your shapes will have this yellow circle. Now if you had a previous version it was a yellow 

diamond. You can always click the circle and drag up, down, left, or right and see how it changes 

what that shape looks like. In this case he frowns. Let me draw a couple of other ones here. How 

about a star? I’ll draw this 16 point star that you see right here. I’ll just scroll down a minute and 

draw that. So what you’re going to notice is that again I’m drawing this shape. This one has a 

yellow circle on the top. Notice if I drag it towards the center I get more of a spike star, 
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depending on how far down I drag it. So you get the idea that you’ve got all of these different 

types of shapes that you can draw and you just practice with these and you’ll get really good at it.  

One thing some people do is they’ll actually pick a shape and when they come over here they 

click. Well sometimes the shape is so small that you can’t even see it to enlarge it. So you don’t 

want to just click. You want to click and drag to draw the shape. Now I’m going to go back up 

and show you a couple of quick things.  

You can put a shape on top of another like we saw earlier. So if you decided for some reason to 

put this on top of this one you can do something like this. And I’ll show you in a few minutes 

how to change colors and things like that to come up with your own creation. 

A couple of things about selecting shapes. As long as you’re holding the Shift key you can select 

as many shapes as you like. If you have more than one selected whatever you do will affect all of 

the ones in your selection.  

To copy an object, some people do Control-C or they’ll come up here and use cut, copy and 

paste. That works. But I want to show you a neat little trick that looks really good with this star. I 

have it selected and I’m going to hold down the Control key and hit the letter D for Duplicate. 

I’m just going to hit D six, seven, eight times and now you have this neat little cascading effect. 

So now if I wanted to do things like line these up left to right or do some other things I could.  

Now I’m just going to scroll up and make sure I have this object selected because I want to show 

you how to change the color inside, which is called the Fill by the way and some different things 

like this.  

First of all because I have it selected I’m on my Drawing Tools contextual tab. I do have some 

shape styles I can choose from. Notice these have to do with background colors and font colors. 

But play with the Shape Fill, which is what’s inside of the object. Play with the Shape Outline, 

which is the line around the object. And play with your Shape Effect. So if you want those soft 

edges or a glow, reflection, shadows. We talked about some of those earlier. You can play with 

some of those. 

Also notice that you can draw a text box. And this one is very handy if you want to have some 

generic text. So it could be that I click right here and I type some text like “Way to go team!” 

And of course I can change this because this is just an object like you saw earlier. 

So let me show you how you might use some of these in conjunction with some of your actual 

pictures. 

I’ve got this picture back up here of this house and let’s say that I want to use a textbox to make 

some notes about this. I would go back to the Insert Shapes again and I’ll put in a textbox. And 

let’s just say I stick it right up here. And you can always change the size before you type but it’s 

kind of up to you. I’m going to go ahead and say “Wow! What a house!” Now if some of your 

text doesn’t show up it’s because the textbox isn’t big enough. So you can always change it like 

this. Now I might do something like draw an arrow that points from my textbox to my house. 

http://www.simonsezit.com/


Learn Word 2016 

© Copyright 2008-2017 Simon Sez IT, LLC. All Rights Reserved. 
 

And of course because an arrow is just a line I can go in and move it. You saw we had different 

styles we could use earlier.  

I might also decide to circle something. So what if I grabbed the circle here and I circled the 

door? You’ll notice when you draw an object over the door like I just did that it has a color 

inside, which is a fill. The way you make it look like you circled it is go back to your Shape Fill 

and tell it you want no fill and now you just have a line. So now that you have the outline you 

can go and make it a different color, you might make it a little thicker by changing the weight. 

There’s all kinds of different things you can do to enhance your picture. 

We could go on and on and on for days. There’s so many options here when you’re talking about 

working with shapes. If you’ve ever used PowerPoint then all of this stuff you’ll see in 

PowerPoint because these are really options that affect things you draw. 

So we’re going to go ahead and kind of stop there. I’ll let you play with some of the others on 

your own. I do want to take a few moments and go into section 5 and talk to you about some of 

the other graphic options that you have in Word before we move on. 
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Video: Other Graphic Options 

Cindy: Okay we’re working in module 10 of Microsoft Word 2016 and we’ve been talking 

about graphics.  

We’ve already gone through how to insert pictures and we talked a little bit about some of the 

picture options. We talked a little bit about working with shapes. But I wanted to tell you that 

there are some other types of graphic options that you have when you’re working in Microsoft 

Word. So let me show you a few of those just so you’ll be familiar with them. 

I’m at the Home tab so I’ll just click on the Insert tab and you’ll see here this is where we 

inserted some pictures and shapes but there’s a few more things you can insert over this way. So 

let’s start with SmartArt.  

Basically what SmartArt is is if you’d like to relay your information in a graphical format you 

can use SmartArt to do that. Instead of having a bulleted list of the employees in my company if 

I wanted to show the hierarchy of those employees I could actually create a SmartArt object and 

use what we call an organizational chart. Another example might be maybe you have a flow 

process at your office and you want to show that flowchart in a visual representation. You’ll be 

able to do that using SmartArt. So let me show you some of the options here when I choose 

SmartArt. 

Here are the SmartArt graphics and you’ll notice that I’m currently on the All list and this is 

going to show me all of my SmartArt graphics. They’re listed underneath that by category. So 

you’ve got a category called List, a category called Hierarchy, all the way down. So you can 

choose yours from any of these. So as an example let’s say that I choose Hierarchy and I choose 

this very first one which is an Organizational Chart. I’ll just click OK and now you’ll see it in my 

document. Now you’ll notice that what it did was it gave me these blank boxes that I can type in. 

So I’ll just put some text in here. We’re going to say this first one is the President. We’ll say this 

is the Assistant. We’ll say this one is the VP of Sales. Here we’ll have the VP of Marketing. And 

over here let’s have the VP of Operations. So you can see it’s pretty easy just to set up your 

hierarchy this way.  

Now you do have a couple of options. If you have your object selected you’ll notice that you 

have a SmartArt Tools contextual tab. The very first thing I’ll want to show you are your 

SmartArt Styles right here. So if you wanted one of these different styles you could certainly just 

click on the particular one that you wanted. The other thing is notice you’ve got different layouts. 

So if you didn’t like the boxes, for example, you might have these circles, for example. And 

these are really nice to put in pictures of the different people in your organization. But I’ll just 

stick with the basic one for now. 

Over here is where you can work with the shapes. So if you had an additional VP you wanted to 

add, for example, then you could add a shape. Now what’ll happen is the shape you’re clicked on 

if you don’t specify that you want to put the shape to the right or the left it’s going to put it 

underneath like you see this one did. So I’m just going to undo that and this time instead of 

clicking on Add Shape I’m going to click the down arrow and I want to add my shape after. So 
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notice it’s going to go to the right of the VP of Operations. So now I can add my new VP. So I’ll 

say this person is the VP of Accounting.  

Now notice a couple of other things. If you wanted to rearrange these you could. I can actually 

go to the Promote or Demote to move them up or down in the hierarchy or if I wanted to move 

them right or left I could do this. So if I click on the VP of Sales, for example, and I say move it 

to the right notice that it moved it over to the right on my list here. You do have some options as 

well for changing the colors. So you’ll notice there’s different color schemes you can pick from 

here. They call these Themes. So if there’s one you like you just click on it.  

And you’re going to have a lot of these same options for any object that you insert. So that’s a 

quick overview of an organizational chart. So let me do this. I’m going to enter a few times down 

here and let me show you how to put in a regular chart.  

I’ll go back to Insert and notice Chart is next. If you’ve done charting in Excel then you’ll notice 

these are the same options you’re familiar with. You have the ability on the left here to put in 

different types of charts. You’ve got Pie Chart, you’ve got what they call Area Charts, Surface 

Charts, there’s a Combo at the bottom. So you can put any of these in that you like. Of each one 

of these different types there are several subtypes you’ll see over to the right. So if I liked this 

column chart but I wanted more of a three dimensional effect I’d choose this one here and then I 

go ahead and click OK. And now you’ll see that I have a chart.  

A chart is always defined by the data that you put in this data sheet here. What happens in Word 

is you’re going to get this default data and you take it out and put your own data in. Data sheets 

and charts are linked. So as soon as I change this data it’s going to change the chart. So let me 

give you an example. 

I’ll just go ahead and hide this. And basically what I did is I didn’t want to show the series three 

in my chart so I took this arrow on the bottom right where this blue area is and I just moved it. 

So I can actually change this. I’ll say this is January, February, I’ll do March, April. And across 

the top I’ll say 2015 and I’ll say 2016. And so you can see that my data is actually changing 

down here. Now let me put a couple numbers in here. I’ll say 52, 62, 68, and 74. See the chart 

changing? Over here I’ll say 25, 35, 95, and 41. And there again you can see that my chart has 

been updated. 

So if go ahead and close this and I click inside the chart, which is my actual object, you can now 

see there’s a Chart Tools contextual tab. And when I click on that I’ve got a lot of the same 

options that we talked about over with the SmartArt. Here’s my Chart Styles. So if I liked one of 

these I could certainly choose that particular style. I can change the colors. We just talked about 

that a few moments ago. The Quick Layouts, these are just some quick ways to choose a layout 

that might have an option that you don’t currently have in your chart. And then you can add 

Chart Elements. So those are things that may or may not be in your chart currently. Like Data 

Labels, for example. If I want to add a callout data label I can. That would be these right here. 

That’s just a quick overview of your charts. Now one more quick thing with your charts. If 

you’re not seeing the data sheet and you’d like to edit the data here’s your option right here to 

edit the data. You just choose Edit Data and it brings up your chart sheet again and you can 
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change whatever you need to right in there. So that’s a quick overview of how that works. Now 

let me go back to Insert for a moment and just mention one other thing. 

You can also use the Screenshot option. What this will do is if I did click on this it would show a 

picture of all the windows I have open I my computer and it would let me just click on one of 

those to take a screenshot. And then it would be on my clipboard and I could paste it in. So I just 

wanted you to know those are some additional things that you can add to your Word document 

that have to do with graphics. 

What I’d like to do now is go ahead and wrap up this particular module. And let’s go ahead and 

go over into the practice exercise and I’ll give you a couple of things to do just to make sure 

you’re okay with all the graphics options we talked about. 
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Video: Module 10 Practice Exercise 

Cindy: Okay we’re actually working in module 10 and we’ve been talking about graphics in this 

particular module. We’ve gone through and talked about how to insert pictures. We talked about 

how to insert shapes. We also looked at a lot of different options when you’re working with your 

graphics. What I’d like to do now is take a few moments and make sure you’re okay with how to 

work with some of these graphics that we talked about in this particular module. 

What I want you to do for me is go ahead and open the file called Module 10 Practice. Using 

clipart I want you to insert a picture of an office building and put it in front of the first letter in 

the document. Go ahead and use the word wrap option to have the text wrap up around the 

object. When you get through with that go to the bottom of the document and insert a picture of a 

different office building. Try to remove the background this time and just see if you can make it 

look nice and neat as just an office building with no background. And then go ahead and just 

save and close the file. That’s all I want you to do for me. 

Great job as always!  

Let’s go ahead and move over now into module 11 and talk about envelopes and labels. 
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Module 11 – Envelopes & Labels 

Video: Working with Envelopes 

Cindy: Hi. It’s Cindy again. We are down to module 11 where we’re talking about Microsoft 

Word 2016, the Envelopes & Labels feature. This is section 1 where I want to show you real 

quick how to work with envelopes in Microsoft Word. 

You have the ability in Microsoft Word to print any size envelope that you would like. You’re 

going to go to the Mailings tab and you’re going to click the first button, Envelopes. 

The first thing it asks you to do is to type in the delivery address and then you can type in your 

return address. So we’ll just make something up here. We’ve got Carol Smith 245 Oak Street in 

Columbus, Ohio. If you ever want to omit the return address just check this little box here and it 

won’t print. That would be really good if you have envelopes that have pre-printed return 

addresses on them already. Also just notice this little Add Electronic Postage. If you’ve ever 

gotten something in the mail with a little barcode right above your name the post office actually 

uses that so they know how to route the mail. I will tell you that I’ve had people in my class that 

work at the post office and they’ve told me they don’t like you to use that because the zip codes 

change all the time. Therefore a lot of times they’re not correct. 

Right here is going to be a preview of your envelope, what it’s going to look like, and this tells 

you how to feed it into your printer. Notice in this case it looks like the flap is down and it looks 

like you’re going to put it where the bottom goes into the printer there. 

You have a couple of options here as well if you click on Options. Normally it prints a size 10 

envelope, which is a standard size. You could actually change this if you like. You can actually 

measure your envelope and change the size. You can also change the font for the delivery 

address. So if you’d like to have a particular font, style, color, all of this stuff you can have that. 

And the same thing for the return address if you like.  

Over here where it says Printing Options you can actually tell it how you’d like to feed the 

envelope into your printer if you don’t like the particular one that it chooses or that doesn’t work 

with your printer. You can also choose a clockwise rotation option if you want. And also which 

tray in your printer you’d to feed from. I’m going to go ahead and cancel out of that. 

And then you have two options at the bottom I wanted to point out. First of all you can go ahead 

and print this and it would go ahead and print for you. Now just a little tip. If you print this and it 

pulls in crooked or maybe you didn’t have the envelope in the printer correctly you’re going to 

have to come back in here and type the delivery address again. A little trick that I use is I always 

put the delivery address right out here and that way if I have to come back into this window it’ll 

pull this automatically from my document.  

You can also just add this to your document. I’ll just click on that to show you how it’s going to 

work. Notice it asks me before it does that, Do I want to save the return address, which is this 

one here? So that way I don’t have to type it every single time I come in here. I’m just going to 
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say Yes for now. And now I have an envelope in my document. Let me zoom back out a little bit 

so you can see it here. What you’ll notice is the envelopes at the top and I can actually print my 

document, envelope and document at the same time. So if I wanted my document to be down 

here I could print it all. 

That’s how you’re actually going to work with envelopes. What I’d like to do now is go over 

into section 2 and show you how to work with labels. 
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Video: Working with Labels 

Cindy: Hey there. Welcome back. It’s Cindy again. We are still working in module 11 where 

we’re talking about Envelopes & Labels. We’ve already discussed how to create envelopes so 

now we’re in section 2 and I want to show you how to work with labels. 

You have the ability to print labels in Word and there are different size labels that you can 

purchase. And where we’re talking about labels we’re talking about they look like a sheet of 

paper and you peel off the individual labels. Typically what you’re going to find is there is a 

number that corresponds with the actual size of the labels. And that number is usually printed on 

the box or sometimes they print them on the actual sheet itself.  

You’re actually going to go to the Mailings tab just like we did with the envelopes but go over to 

the Labels option this time. Again what’s going to happen is you’re going to pop in the address 

here. I’m going to say this is Tim Scott P.O. Box 123 in Columbus, Ohio 77458. You have the 

option to print a full page of the same label or a single label. If you were going to print a single 

label then you would have to tell it which row and which column to print in because sometimes 

you might have used a couple of the labels already. If you’re printing a full page this would be 

good for something like if you wanted to have a couple of sheets of pre-printed labels that have 

your company name and address already on them in your drawer. It’s great for something like 

that. 

You also have the ability to change the size of the labels. So where it says Options down here at 

the bottom. Most labels are going to be on this list here. Now the standard labels that most 

people are familiar with are the Avery U.S. Letter. So I’d probably start with that vendor. And 

you can see when you go down the list there’s the numbers I mentioned that correspond with the 

size of the labels. Also it tells you what type of label it is over here. See how if you click on one 

it tells you the height and width and so forth over on this side? The generic labels most people 

use are the 5160 series or the 8160 series. The 8160 is the one that has three across and I believe 

ten down, but you’d have to check that for yourself. So I’m just going to find the 8160s because 

I’m familiar with those and then you’re going to see that once I find these that there’s going to be 

three columns and ten rows. There it is right there. These are called Easy Peel Address Labels. 

I’m going to go ahead and click OK and it tells you right there which size I’ve chosen. 

I could go ahead and print these if I wanted but I can also add this to a new document. Let me 

show you what this looks like. There you go. So now you can see I’ve got each label and I have 

the same name and address in each one. And that’s because I chose the option for the full page.  

So the logical question here is how do I get different names and addresses into the different 

labels? Well that’s where a mail merge comes in. So we are going to go ahead and wrap up this 

module. There’s not really a practice for this or anything. Let’s go ahead and move over into 

module 12 and we are going to work with mail merges. 
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Module 12 – Mail Merges 

Video: What is Mail Merge? 

Cindy: Hey. Welcome back. This is Cindy again. We are all the way down to module 12 now 

where we’re going to spend time in this module talking a little bit about mail merges. I wanted to 

spend time in this first section and just tell you very quickly what a mail merge actually is so that 

when we start creating our mail merge you’ll know exactly what we’re trying to accomplish. 

Here you’re going to see the three steps in creating a mail merge. Let’s say that you send 

collection letters every Friday and the letter is pretty much the same but let’s say the information 

in the letter changes. It might pertain to different customers. They each owe a different amount, 

they have different invoice numbers. That’s a really good example of a mail merge. Another 

example might be what if your company has a particular product you’re trying to promote and 

you want to send out information through email or through a letter? Then you could have one 

letter and have each individual customer’s information sprinkled throughout that particular 

document.  

Main documents can be one of five different things. They can be a letter like we’ve just 

discussed. Once you get that letter and you print it out if you’re going to stick it in the mail then 

you probably want to either create an envelope or a label. Most people don’t create envelopes 

because they have to babysit the printer but you do have that capability. Labels are just much 

easier because you can print a sheet or two and then peel them off and put them on those 

envelopes. It could be that you want your mail merge to be via email. So if you have a particular 

email you send frequently why retype it every time? You can actually create it once and save it 

and then it can be a main document that you merge in with your data. Also a directory, and I’ll 

show you what a directory is a little bit later, but it’s basically a listing over and over and over of 

the same information. So what if on one sheet of paper you wanted each customer’s name, 

address, phone number, name, address, phone number, name, address, phone number? That’s a 

good example of a directory.  

Once you have the main document created then you’re going to want to find the data source. The 

data source would be the actual information you’re going to merge into that main document. This 

would be the customer’s actual name, their address, their invoice they owe you for, maybe the 

amount of money. Once you get the two set up then you can merge them together and create 

what’s called a merged document. So what you’ll see in Word is that once we merge a document 

we will have a separate page in that document per record. Meaning a separate page per customer 

as an example. 

So these are the three steps that we’re going to have to go through in order to create our mail 

merge. A lot of programs also have some of this preset up. For example, if you’re familiar with 

QuickBooks, they have a lot of main document letters already created and you can use theirs or 

create your own. Also the data source can be pulled from multiple places. I might pull it from 

Excel. I might it pull it from some other software that I have. So we’ll kind of talk about that as 

we go through and create our mail merge. 
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So what I’d like to do now is let’s go ahead and go over into section 2 and we’ll get started and 

I’ll show you how to create a mail merge. 
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Video: Creating a Mail Merge Document – Part 1 

Cindy: Okay welcome back. It’s Cindy again. We’re in module 12 and we’re talking about mail 

merges. We’ve already gone through section 1 where we actually talked about what a mail merge 

actually is and you got some instructions there on basically the steps that we’re going to be going 

through. So now we’re on section 2 and I want to show you how to go ahead and get started 

creating that mail merge document. 

When you’re creating a mail merge there are three steps that you’ll want to follow. The first 

thing is you’ll want to create what’s called a main document. A good example would be 

collection letters. If you send them out every Friday then you want to go ahead and set that letter 

up as a one-time thing and save it so that you can use that same letter every single week and you 

don’t have to keep recreating it. Main documents can be one of five different things. They can be 

a letter, like the collection letter I just mentioned. When you’re finished you’ll probably want 

also envelopes or labels. So if you wanted to put envelopes in your printer and have it merge in 

all the names and addresses you could do that. Or you can print out labels and peel them off and 

put them on the envelopes. You can also merge emails. So if you wanted to send an email out to 

someone and you wanted to pull in again their pertinent information then you’d be able to do that 

by merging emails. You can also do a directory and I’ll talk to you a little bit later about what a 

directory is. 

Once you have your main document created then you want to go ahead and find your data 

source. Now the data source is the actual information you’re going to pull into the main 

document. So again as my example if it’s collection letters you want to pull in each person’s 

name and their address, their invoice number, how much they owe, things like that. Your data 

can come from a lot of different places. You might have the data in Excel already. You might 

have some sort of program that has the data and you pull that data. But you can pull that data 

from pretty much anywhere you like. Once you have the main document setup and you’ve got 

your data source then you can merge the two and you get what’s called a merged document. A 

merged document will have one page per record. So that means if you send out 500 collection 

letters to 500 different people this one Word document will have 500 pages. So you probably do 

want to save your main document so you don’t have to recreate it every time. Data sources 

usually save somewhere already and the merged documents kind of up to you if you want to save 

it. So we’re going to actually go ahead and walk through the steps for creating the mail merge 

here. So we’re going to start on a new blank document to do this. So I’ll just click on File and 

come down to New and I’ll use a blank document.  

To start the mail merge you’ll want to go to the Mailings tab and you’ll see here it says Start 

Mail Merge. Here are the five things that I told you a main document can represent but we’re 

going to use the step by step Mail Merge Wizard. It’s much easier to go step by step this way so 

you don’t forget one of the steps. 

We have not set up our main document yet and that’s why we’re starting on a new blank 

document. But if you had already created yours and saved it previously you could open that up to 

start the process and it would automatically put you on step three of the wizard. If you’ll notice 
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down here at the bottom it tells you which step you’re on and you can always go to the next step 

or the previous step here. 

Now this is step one and the first thing it asks is what is it you’re working on. Is it a letter, an 

email, an envelope, a label, or a directory? We’re going to create our letter first. Notice also 

whichever option you choose it’ll give you a little definition down here of what that option 

actually represents. 

So I’m going to click Next and it’s going to say, How do you want to set up your letters? Do you 

want to use the current document? Which we will. But you could also start from a template or an 

existing document like I mentioned earlier. I’m going to go ahead and click on Next which will 

put me on step three and it says Select Recipients. Now I’ve always thought this was a little 

backwards. So you’re thinking I’m going to tell it that I want to create a letter. I’m going to set 

up the letter and then go get the data. But no, what it wants you to do is go get your data and then 

come back and set up the document. So that’s where we are now. We’re going to tell it where 

our data actually is. 

Here we can use an existing we already have somewhere, in Excel for example. We could select 

from Outlook or type a new list. We’re going to say at this point that we don’t have a list. So 

we’re going to type a new list. And then it says here to create. 

When you’re creating a new list the first thing you need to do is set up the fields, or the columns 

as you may see it, of information that you want to keep. What they give you here is a generic list 

and you can edit this list. So you can see this list goes Title, First Name, Last Name. If I come 

down here where it says Customize Columns here’s the list. I’m going to go down the list and 

take a few of these out. Let’s say that I don’t want Address Line 2. So I’ll go ahead and delete 

that. And any time you delete a field it will actually ask you are you sure you want to do this 

because if you already have data in there then you delete that data as well. I’m also going to take 

out everything from country or region down in this case. And by the way you’ll always get these 

generic fields. You can actually go through like I’m doing and delete them or take out ones you 

don’t want and add new ones. Now I want to add one more. I’m going to click Add here. And I 

want this field to say Date Last Called and I’ll click OK.  

You have the ability to move your fields up or down in the list because you want them in a really 

good typing order. If you had zip code above city, for example, you’d probably always type the 

wrong information in that field. I’m going to go ahead and click OK and now you can see the list 

has been changed a little bit. If I scroll over to the right you’ll see. Actually let me make this 

bigger here. And there you can see are the fields that we created. You can see also if you need a 

field to be wider just grab the border between the two columns like this and you can change the 

width of that particular field. Any time you want to change that you go back to Customize 

Columns down at the bottom and you’ll be able to change those. 

Right now I’m going to go ahead and click OK and you always have to save you data source, 

always. I’m going to go ahead in Documents and I’m going to call it My Data for now. And now 

you’ll see that it’s showing you a list of what they call the mail merge recipients. So here’s all 
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my fields but we don’t have any data in there yet. So we’re actually going to put some data in 

there. 

I’m going to make this a little bit bigger and then we’re going to type some data in here. What 

you’ll want to do is go down to the bottom where it says My Data because that’s showing you 

the data source. And when you click Edit then it will let you type in here like this. There you go. 

So I’m just going to put three in here. I’m going to say Mr. Tom Allen. And by the way, if they 

don’t have information, like if Tom didn’t have a company you can skip right over it. That’s not 

going to leave a blank row in your letter you’re creating. So I’ll go ahead and make Address a 

little bit bigger because we need some more space there. So we’ll say his address is a P.O. Box 

and we’re going to say it’s in Charlotte, North Carolina 29589. And the date we last called, I’m 

going to go ahead and put an actual date in here. I will say May 13, 2015. 

Now you’ll see when you tab that now you can put in a second one. I’m going to say this is 

Arlene Morris and she works for Morris Sokol. And we’re going to give her an address of 4576 

Rivers Avenue. And we’ll say that she is in New York, New York. Now you’ll see that I put 

New York, New York in the same field because I want to show you in a few minutes if you 

make mistakes you can always come back in here and change this. 78563. And we’ll say 

December 24, 2015. And let’s put in one more. This time I’m not going to have a title. I’m just 

going to say this is Horaxce Mills. He works for Bed & Breakfast, Incorporated. And his address 

is 89 Spring Street Springdale, Massachusetts and we’ll say the last time that we spoke with him 

was on March 2, 2015. I’m going to go ahead and click OK and then it takes me back to the Mail 

Merge Recipients. I’m just going to click OK past that and now I’m back where I can go to step 

four and write the letter. So it’s actually taken us back now to our main document so we can go 

ahead and get that set up. 

What I’d like to do now is there is another part to this particular section. So I want to go ahead 

and go over to part 2 so we can go ahead and talk about setting up that main document. I’ll see 

you over in the next section. 
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Video: Creating a Mail Merge Document – Part 2 

Cindy: Hey there. So I’m glad you’re back. We’re still talking about creating a mail merge 

document and this is part 2. We want to go ahead and continue where we left off in part 1. So let 

me go ahead and flip over to our main document and we will go ahead and get it set up. 

We’re going to go ahead and set up the basics of this letter. Let’s say that the first thing that we 

want to put in here is the date. So I’ll go ahead and put in here May 14, 2016 and we’ll drop 

down a couple lines. And here what we want to do is actually pull in some merge fields. What 

I’d like to have is the person’s first and last name, their company, maybe the street address, 

things like that.  

We have a couple of options as far as this is concerned. First of all I want you to notice over here 

that we can put in an address block. So let me show you what the choices are if you do this. 

Here we can actually put in the person’s name and they give you several different choices of how 

you want the name to appear. You can check or uncheck whether you want the company name in 

here and also their address. Over here is a preview of what it’s going to look like. If that’s all you 

want you can certainly click OK and here’s what the merge field would look like. Now what it 

doesn’t give you the choice to do here is to put Attention so-and-so, maybe rearrange the 

company and have it first. So I’m going to go ahead and backspace over that and delete it. And 

let me show you how you have a little more control over the fields and how it looks by using 

what we call the Insert Merge Field option right up here. 

If you click the down arrow you’ll notice here are all of your merge fields. What you’re going to 

do is you’re going to click on these the way you’d like them to appear. So let’s say I want 

Company Name first. Now I’m going to hit the Enter key and now what I’d like to do is have the 

person’s title, I put a space in there because if you don’t put a space it’ll just run altogether there. 

I’ll put in their first name, space and their last name. Now let’s say I’d really like it to say 

Attention. Now notice I’m just typing the Attention right in front of it. Now I’m going to go 

ahead and go to the end of that line and hit the Enter key. I’m going to put in the next merge field 

which is their Address. The next one I’ll do City. And again you have to put in the commas and 

spaces or it’s all going to run together. Here’s State and here’s Zip Code. So now I have a lot 

more control over how I want the fields to appear. So whichever one works for you is certainly 

okay.  

Now let’s say the next line is going to say Dear and we’re going to put in the person’s title and 

their last name. So what I’m going to do here is I’m going to add the Title and put a space and 

I’ll put in their last name. And of course if you want a comma or any of that you can certainly do 

that. Now you’re going to put the letter in.  

Now just to save a little bit of time and also show you a trick that works in Word. It’s not just in 

mail merges. I want to show you how to insert one document into another. I’m going to go to the 

Insert tab and notice way over here where it says Object there’s a dropdown arrow. And I’m 

going to insert text from a whole different file here. So I’m going to go out and actually find the 

file I’d like to insert the text from and I’ll use this one called Merge here. And look what it did. It 
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just brought all the text in from that particular document. So that’ll help you a lot instead of you 

having to open the other file and copy and paste. And we’ve got a little duplicate line here so I’ll 

go ahead and delete some of that. Perfect.  

Now a couple of more merge fields I want to put in here. Notice it says, Since we last spoke on. 

Remember that field that we actually created called Date Last Called? Now it’s going to put in 

that date. Also to add a little more personal touch to this you can always go ahead and insert 

fields where you’d like. So I’m going to say Our technical folks, comma, and then I’ll put in 

their first name. So the more merge fields you put in a document the more personal it will sound. 

And you can just go through your document and put in as many as you like. So that gives you the 

basics of a main document. 

Now I am going to save this because I’d like to use it in the future. So I’ll just do a Save As and 

I’m just going to stick mine, and we’ll go here to Browse. I’ll go here to My Documents and I’ve 

got this one with all our files in it called My Practice Documents. And I’m going to call it My 

Main Document. And I’m going to click Save. Now remember if you were never going to use 

this again you really don’t have to save it but I’d like to use it frequently so that’s why I’m 

saving it. Now I can preview what I’ve done. So notice the next step says Preview Your Letters.  

A couple of ways to preview these. First of all remember we have three recipients. So you can 

see now it says Attention Mr. Tom Allen. And notice I can hit these arrows over here to go to 

recipient two and recipient three. And we’re back the other way. Now I’m not going to want this 

to say Attention Tom Allen so we’ll change that a little bit later. The only reason I did that is he 

didn’t have a company there. I can also if I wanted to go back and forth between my different 

recipients I can use these arrows here. This will take me to the first or last, next, or previous. And 

I can always do that. If you see a change in the letter just turn off this preview results, fix it and 

then you go ahead and preview the results again.  

If you see a mistake in the data you’re going to go over to Edit the Recipient List, you’re going 

to click you Data Source and you’re going to Edit and then you can fix that. So remember this 

one here I told you about earlier? I’m going to go ahead and take that out, click OK and we’re 

going to save that and click OK and we’re done. I see one quick thing I want to change. We need 

to add the word You in here. And it looks like this is a different font maybe down here so I’ll just 

use Format Painter real quick and change this. Perfect.  

Now when I’m going to go ahead and complete the merge. So I’m going to click on step five, 

Complete the Merge, and you do get a choice to print or edit individual letters. You probably 

want to edit individual letters because this way you can actually make changes to each letter 

individually before you print it. I’ll go ahead and merge them all but notice I could merge the 

current record, meaning just the one I’m on or from one to two if that’s what I wanted to do. But 

I’ll click OK here and now you have a merged document. A couple of ways you know this. 

In Word regular documents are called Document 1, Document 2 and so forth until you save 

them. When you’re in a merged document look what it calls them. Letters 1, Letters 2, until you 

save them. Also I told you that you would have one page per record. So notice that I have three 

pages down here, whereas my main document will always only have one page because that’s all 
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the actual letter has. If you just really screw this up all you have to do is close this and not save 

it. You have not gotten rid of your main documents behind this actually. If I go ahead and just hit 

this for just a second notice there’s your main document right back there. So see how I can close 

the merged one and it doesn’t really affect anything?  

But I did want to show you a couple things. I told you we would fix Mr. Tom Allen. So the way I 

would do this is I’d come in this one letter only and get rid of the Attention there. Notice that 

does not affect the other letters in this particular merged document. So you can have any changes 

like that you want. If you’d like to go and add a P.S. to any of these feel free. You can certainly 

do that. And that is the essence of how a main document is merged and you end up with a 

merged document or how mail merge works. 

Now that you know how to merge a document I want to actually talk to you a little bit about how 

to merge a document with an existing data source you may already have. Like maybe you have 

something in Excel already. So let’s go ahead and go over to section 3 and we’ll talk about 

merging a document with an existing data source. 
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Video: Merging a Document with an Existing Data Source 

Cindy: Okay we’re still in module 12 and we’re talking about mail merges in this module. 

We’re all the way down to section 3 where I want to show you how to merge a document with an 

existing data source. Earlier when we created our own main document we merged it with a data 

source that we created in Word because we didn’t have one already. So now I want to show you 

how to find one that’s a file in your computer somewhere and actually pull that in. 

I’ve opened up my main document and you can see that this file is very similar to the one we 

created over in section 2 when we created our own main document. But what I’d like to do now 

is I’m going to go ahead and go to the Mailings tab and start the mail merge and I’ll go back to 

the wizard.  

What I wanted you to notice this time is it automatically put me on step three because it doesn’t 

need to know steps one and two since I had an existing document I went ahead and opened. 

What you’ll see here is the last file that was merged into this main document will be listed here. 

And if you want to change it you select a different list. Now before I do this I wanted to flip over 

and show you that what I want to do this time is merge an Excel file and pull that data into this 

main document. So let me flip over to the Excel file and just show it to you real quick. 

Here’s the Excel file and I want you to notice that I have a header row at the top. These headers 

have to correspond with the actual field names over in Word. If it sees that first name is actually 

F Name over in the main document then it won’t know they’re a match and you’ll have to do 

some manual matching. So it’s best to have the field names here match the field names in Word 

and then you don’t have a problem. But you can see I just have all the data below each of the 

columns here and that’s really all it is. And this is all over on Sheet 1 here. 

You can merge this data whether the file is open or not. I just opened it to show you what it looks 

like. So let me flip back to Word. 

If I did want to select a different list as it’s called over here I click on Select a Different List and 

you navigate and find your new data file and now you’ll see that it asks you since this one’s 

coming from Excel it’s asking me which sheet in the Excel file do you want to pull from. I’m 

going to click OK because there’s only one sheet there. And now what you’ll notice is that it’s 

showing me all of my mail merge recipients.  

So I’ll just click OK here and now let’s go ahead and go to the next step where it says Write 

Your Letter. Now we don’t have to do that because ours is already written. So I’ll go ahead and 

click Next again and here’s where I can preview my letters. So I can go through the recipients 

one at a time this way. Again if I wanted to change the letter itself I’m going to click on Preview 

Results and I can change the letter and then turn it back on. And if I need to change the data I’m 

going to go to the Edit Recipient List over here. But I’m going to go ahead and click Next and 

complete the merge. And then you would go ahead and say Edit the Individual Letters like we 

did before and it would do the mail merge for you. So pretty easy to actually pull in external 

data. 
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What I want to do now is talk to you a little bit about when you’re merging this data how you 

can actually do some sorting and filtering as you’re having it do the merge.  
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Video: Sorting and Filtering Images 

Cindy: Okay. We’re still working in Word 2016 and we’re in module 12 where we’re going 

down the list and talking about different mail merge options. We left off in section 3 where we 

actually took a document and merged it with some existing data. So now what I’d like to do is 

show you how to take those merges you’ve created and use the Sort and Filter feature to sort or 

filter the different items that are merged into your main documents. 

I’ve pulled up our main document and what I’d like to do is go to step 3 of the wizard and I want 

to see which data source it was last merged with. And it looks like New Merge Data. Here I can 

edit the recipient list and then I can see that there are 33 I believe in this list. And if you notice 

when you’re looking at this that it looks like they might be sorted by state but I could sort these 

by any of these fields that I’d like.  

The easiest way to do a single level sort is click on the field name from the top of that column 

and you’ll see it sort that column for you. You can see now that it looks like the states are 

alphabetical and they’re in ascending order. And I could do this with any of these fields that I 

like.  

Now if I’d like to add another level to my sort I’m going to have to use the sort option right 

down here. Here you’ll see that you can sort by three different levels. I have state in here already. 

So on the middle line I’ll choose Then by and I’ll sort them by city and I’ll click OK. In order for 

a second field to be sorted there must be duplicates in the previous field. So when you look at the 

states notice there are three Connecticut’s. Of the three Connecticut’s the cities are alphabetical. 

Now that would be true if I needed to add a third level to this. What if I decide to add company 

as that third level? It really wouldn’t look like there was any sorting going on because there are 

no duplicate cities in order to sort the companies. Sometimes just rearranging the order in which 

you want to sort your fields will allow you to see the information you would like. 

I’m going to go click on Sort again and I want you to notice that I was also sorting these 

ascending. I could have chosen descending if I wanted to. Notice the Clear All. That’s how 

you’re going to clear all the sorts if you wanted. While we’re in here notice there is a Filter 

Records tab right over here. Now if I wasn’t in this window I would have to come here to filter 

to get into this particular window.  

Filtering means that I only want to merge certain criteria and have it hide everything else. What 

if you just wanted to merge anyone who lived in the state of New York? Then what you would 

do is from the field dropdown list you would choose the state equal to NY which is New York. 

Keep in mind that when you enter the data to begin with if you had N.Y. in some of the fields 

then it wouldn’t pull because it’s looking for an equal match to NY in this case. So I’m going to 

click OK and you can see that there are five recipients that meet my criteria here. So when I 

actually went through and completed the merge these are the only five that it would actually 

merge and print out. 

Let me go back down to Filter here and let’s say we want to add another filter to this. Let’s say 

that I’ve got the state equal to New York and I also want it to filter anyone in the city of 
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Rochester. Now as long as you’ve spelled it right here. Now I’m going to click OK and now 

you’ll see only one individual met our criteria here.  

I’m going to go back to Filter for a moment. I wanted you to also notice under Comparison that 

we chose Equal To, meaning it had to find an exact match. But my other choices here would be 

Not Equal To. Not equal to would filter anyone who did not live in the state of New York. But 

notice also there’s Less Than, Greater Than, Less Than or Equal To, Greater Than or Equal To. 

That would be more like if you had a number field and you’re trying to find something greater 

than a certain number. I could fill out any that are blank or any that contained something specific 

I type over here. So I do have all these comparison options that I can work with as well. 

Remember if you want to clear everything you can either use the Sort option here and clear and 

you can go to the Filter Records this way and clear as well and then when you click OK you’re 

seeing everyone again. That’s how sorting and filtering are going to work here.  

What I want to do now is let’s go ahead and move over into section 5 and I want to show you 

how to merge envelopes and labels. 
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Video: Merging Envelopes and Labels 

Cindy: Hey it’s Cindy again. We are still working in module 12 of Microsoft Word 2016 and 

we’re all the way down to section 5 where I’m going to talk to you a little bit about merging 

envelopes and labels.  

So you’re already merged all of your letters or your main documents and you want to go ahead 

and send those out. Now you could actually merge envelopes and stick the envelopes in the 

printer but most people don’t do that because they don’t have time to babysit the printer. So 

we’re going to look at merging labels. 

When you’re merging your labels you’ll want to start on a new blank document. From there 

you’re going to go to the Mailings tab and back to the Mail Merge Wizard. On step one of the 

wizard it asks what document type are you trying to create and before we had worked on letters. 

Make sure you’re on Labels this time and then click Next at the bottom to go to step two. 

Here at the top it asks you, Would you like to change the document layout or start from an 

existing document? If you change the document layout you can choose the Label Options here. 

These are the same label options we saw when we were working on envelopes and labels in a 

previous module.  

The next thing you want to do is make sure you’ve chosen the particular product number that 

matches the labels that you have. Now typically on the outside of the box they will say 

something like Corresponds with Avery U.S. Letter 8160. But you can also look sometimes at 

the bottom of the actual page of labels and it will say the number down there as well. So you just 

have to look for that.  

I’m going to click OK here and now you’ll see my actual labels. Now I’m going to click Next to 

select my recipients. And I’m going to hit Browse and here’s where I’m going to look for my 

data source. Now I’m going to pick this Excel file called New Merge Data and when I click 

Open it’s going to ask me which sheet in the Excel file do you want to pull from. I only have one 

in this exercise so I’ll click OK and now you’ll see all of my recipients here. Since I’m just going 

to merge them all I’ll just click OK at the bottom and now we can go to the next step and arrange 

the labels. So here’s where we will be pulling in all of our merge fields. When you do this pull 

them onto the first label because once you do that then we can update all of the labels over here. 

So I’m going to go ahead and pull in some merge fields. I’m going to pull in the person’s first 

and last name. I’ll pull in their company. I’ll go ahead and pull in their address and then I’ll pull 

in their city, state and zip. State and zip. Now if you notice mines a little large and it doesn’t fit 

right in there. So what I’m going to do is go ahead and select these and I’m just going to make 

the font a tad smaller and it fits right in there.  

Now remember once you’ve got the very first one set up go ahead and Update All Labels over on 

the right and that’s when you see it copies all of those fields, so all the other labels. Just like 

when we merged the main documents we could have put in the address block, if we needed a 

greeting line, all of those options are the exact same here. If you ever need to make a change go 
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ahead and fix it on the first one. So let’s say I do something like this. I take out company and 

let’s say that I push this down and make company my very first one. I’ll just paste that in there. 

And let’s say in front of first name I do something like Attention like that. Again I’ve edited the 

first label so I’ll want to Update All Labels before I move forward. 

Next is to preview the labels. Now you’ll see when I do this that it’s going to show me each 

individual recipient’s label here. There’s still only one page. It’s just showing me a preview. So 

if I wanted to actually see all of the labels I would have to complete the merge. And if I wanted 

to edit the individual labels I could do that and merge all of the records. So that’s all there is to 

actually merging envelopes and labels. 

We’ve got one more thing that we want to talk about merging and that is I want to show you how 

to merge a directory. So I will see you over in section 6. 
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Video: Merging a Directory 

Cindy: Okay we’re going to go ahead and wrap up module 12, Mail Merges, with talking about 

how to merge a directory. 

Now a directory is basically a listing over and over and over of the same information. So, for 

example, on one piece of paper let’s say all I wanted was each recipient’s first and last name, 

their company and the date I last called them and that’s all I want. I can actually set that up and 

when I’m finished that’s what’s called a Directory. So let me show you how to create our 

directory. 

When I start the directory I’m going to start on a new blank document. I’m going to the Mailings 

tab. I’m going to start the Mail Merge and use the step by step wizard.  

On step one when it asks what type of document am I working on I’m going to choose Directory 

this time and then click Next at the bottom. Step two asks do I want to use the current document, 

which I do, or I might want to start from a template or an existing document. I’ll click Next to 

select my recipients. Here I’m going to browse and find my data file. So I’m going to choose this 

New Merge Data and click Open. And I’m going to pull from Sheet 1 in that Excel file. Here’s 

all of my recipients. So I’m going to merge them all so I’ll just click OK here. And now I’ll go 

ahead and go to the next step and arrange the directory.  

So here’s what I said I wanted to have. I wanted to have the person’s first name, put a space in 

there and then I’ll put their last name in. The next thing I want to have here is the company. And 

on the last line I’m going to say Date Last Called with a little colon like this and then I’ll insert 

the merge field Called Last. Now you want to have two spaces underneath. So you can hit the 

Enter key twice. If you don’t they’re going to run up against each other and be really hard to 

read. This is all I’m looking for. I really didn’t have to type this but it would just be a date there 

if I didn’t and I really wouldn’t know what it represented, especially if I share this file with 

someone. 

So now I’m going to go ahead and preview my directory. And you can’t see the full directory 

unless you complete the merge. So I’m going to complete the whole thing and merge it to a new 

document here. I will merge all the records and now this is a directory. You can see it’s a listing 

over and over and over of the same information about each one of my recipients.  

That’s all a directory is guys. So I’m going to go ahead and wrap this section up. We’re going to 

go ahead and do a quick exercise over in section 7. So if you want to go on over there I will meet 

you shortly and tell you exactly what I’m going to have you do. 
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Video: Module 12 Practice Exercise 

Cindy: Welcome back. We’ve been working in module 12 and this is where we’ve been going 

through the mail merge feature that Microsoft Word has. Now we did a lot in this particular 

module. We talked all about mail merges, what they are, how to create one. We even went into 

sorting and filtering as you’re doing your merges. What I want to do now is have you go through 

a quick little practice exercise just to make sure you can get through one on your own and then 

we’ll move on to the next module. So let me show you what I’d like you to do for me. 

You’ve got a practice file here called Module 12 Practice. I’d like you to open it because this is 

the example you’re going to be working from. 

Starting off you’re going to create a new blank document and then you’re going to start the step 

by step Mail Merge Wizard. We’re going to create a letter using the current document. That’s 

going to take you all the way through steps one and two of the wizard. So the next thing is on 

step three you’re going to type a new list. These are the fields that I’m going to have you type in 

so that you can actually do your merge. You can see them listed here at the bottom of number 

four.  

Next you’re going to create three rows of data using the data source fields you just created. We 

just need some data in here so that we can complete the merge. Now you’re going to save the 

data source and call it My Data Source. Now using that Module 12 Practice as your example 

again create the main document. I want you to type that whole thing in. Insert the merge fields 

just as you see in the example here and then go ahead and complete the merge. Once you’ve 

finished and you see that it works I want you to save your main document and call it My Main 

Document. You don’t need to save the merged document. And then we’ll be done. 

So great job! I just wanted you to know I’m very proud of you. When you’re ready let’s move 

over to module 13 and we’re going to talk about Quick Parts. 
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Module 13 – Quick Parts 

Video: Building Blocks 

Cindy: Hi. It’s Cindy again. Welcome back. We are all the way down now in module 13 of 

Word 2016 and this particular module is called Quick Parts. There are a lot of different things 

that will help you build your document, first of all starting with what we call Building Blocks, 

which we’re going to talk about here in section 1. Let me show you what building blocks are and 

how they work. 

Building blocks just allow you to add items to your document to help build the document as they 

call it. We’ve actually already seen a lot of these as we’ve gone along but we didn’t really use 

that terminology. Let me just show you a few things here. 

I’m under the Insert tab and if you wanted to put in a cover page as an example over here you 

could click on Cover Page and these are what they call Building Blocks. They’re just 

predesigned cover pages in this case. If you wanted to use one of these you would just choose 

that particular one and then you could edit it any way you like. Notice how it already has my 

company name in there. It would also have any other information about the company if I had it 

in my document already. So that’s one example of a building block. Let me show you another 

good example. 

Page numbers. We have actually talked about page numbers a little bit when we did our headers 

and footers but I’m going to come over here and click on Page Number and I can put a page 

number at the top, the bottom. Here you’ll notice different options for putting in the page 

number. So let’s say that I scroll down this list and I happen to like Accent Bar 1 here. Now it’s 

put that particular page number in my header. If I wanted to go ahead and put this in the center I 

just come back to Home and put it in the center. But that’s another example of a building block. 

It’s helping me to build my document. 

Let me go back to Insert here and mention a few more. We had actually talked a little bit about 

textboxes as well. Here are some more building blocks as they’re called. There’s different ones 

that I can insert in my document. Let’s say I like this one. And notice it puts it over on the 

sidebar. So again I can edit that if I like. So these are all examples of what we call building 

blocks. 

If I go back to my Insert tab again and I go over to the Text grouping there’s this option called 

Quick Parts. And in Quick Parts you’re going to see there are several things like an AutoText, 

for example. If you wanted a selection to be something you can automatically insert in your 

document without having to type it over and over then you can save it to your AutoText Gallery. 

We’ve got Document Properties. So if I wanted to add any of this information to my document I 

could. This might be the company information, maybe the manager, some keywords, things like 

that. I can add fields to my document. But I want you to see the Building Blocks Organizer right 

here.  
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What this does is gives you a list of all the building blocks that are in Word. They’re just in one 

big list here instead of having to look for them all over the place. Now you’ll notice when you 

look at these there’s this column called Gallery here. I’ll make this a little bit wider. And you’ll 

notice that all the bibliographies are at the top, then all the cover pages. And the way they’re 

organized is by name. So if you look at the bibliographies the names are in alphabetical order. So 

if scroll down the list here, we were looking at footers. We’ve seen some headers. If I go down 

and find page numbers, for example, I’ll see here’s several that we saw in our list a few moments 

ago. So if I wanted to use one of those from this list I could. Here’s Accent Bar 1. That’s the 

exact one we used. This is where you’re going to find all your building blocks. 

What I’d like to do now is talk to you a little bit about creating or editing your building blocks in 

case you wanted to add some to this list or edit something that’s already here. So let’s go over 

into section 2 and I’ll show you how to work more with your building blocks. 
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Video: Creating and Editing Building Blocks 

Cindy: Okay we’re working in module 13 of Microsoft Word 2016 and this is the module where 

we’re going through and talking about Quick Parts. We’ve already talked a little bit about one of 

the quick parts called Building Blocks in section 1. So what I’d like to do now is go into section 

2 here and show you a little bit about how to actually create some of those building blocks or edit 

some of the existing ones.  

Let’s go back real quick to the Quick Parts. I’m going to click on Insert, Quick Parts. I want to 

show you real quick in the Building Blocks Organizer what we’re going to have to tell it when 

we set up our new building block. 

We’re going to have to name it. We’re also going to have to tell it which gallery we’d like to 

save it in and also which category. Also I want you to just notice something here that sometimes 

might confuse you. It says Insert right here and a lot of times students think that’s where you set 

up a new one. That’s not. That’s basically the one you’re clicked on it’s going to insert that one. 

So let me go ahead and close this and let’s use this as our example.  

I’ve got a title here and I’d like to go ahead and format this title and I’ll just go ahead and put a 

border around it and then we’ll put some shading and we’ll put some other things in here. We’ll 

add a color for our shading. Alright let’s say that I would like to insert this often and instead of 

actually typing this and then applying the border and the shading I can set it up as a building 

block. And notice I’ve got it selected. Going back to Insert, back to Quick Parts and I’m going to 

Save Selection to Quick Part Gallery. Here’s where I’m going to create that new building block 

and I’ve got to tell it what I’d like to name this. I’m going to name it Burke Properties Logo. 

Notice the gallery. I’m going to save it in Quick Parts but notice I could put it in any of these 

galleries that I see here. Also the category. There’s really only one called General right now but 

if you had several different logos you may set up a category called Logos and save it in there. 

You can add a description. You do want to save it in Building Blocks. Your only other choice is 

in the normal template but you don’t really want to do that. And then notice the options. You’ve 

got Insert content only which is what I want because I want to be able to click anywhere and be 

able to insert this. But notice I could insert the content in its own paragraph or in its own page. 

I’m going to click OK and now it’s setup. Let me go ahead and delete this and then let’s see how 

this works. 

I’d like to insert this and this is going to be for any document, not just this document. Okay? I’ll 

go back to Quick Parts and look what I have. So I’m just going to click on it and now it’s 

inserted my title there. 

Now I’m going to go back to Quick Parts because I want to show you that if I go to the Building 

Blocks Organizer down here at the bottom we put it in Quick Parts. So if I go down and look 

under the page numbers where the Q’s are there it is right there. There’s the one we just added. 

So at any time if we wanted to edit the properties we could do that. If I click on Edit Properties 

these are the properties of that building block. I’m going to go ahead and click OK and if you do 

it will ask you basically if you want to save this. That’s what this means. I’m going to go ahead 
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and say Yes and then I’ll close out of it. So now you know how to create a new building block 

and edit the properties if you need to. 

Why don’t we go ahead now and go over to section 3 and I’ll show you real quick how AutoText 

works. 
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Video: AutoText 

Cindy: We are working in module 13 of Microsoft Word 2016 and we’re talking in this module 

about Quick Parts. We’ve already talked about building blocks. So we know how to create those. 

So let’s talk a little bit now about another Quick Part called AutoText.  

There might be times when you have some groups of text that you want to insert automatically in 

your document so that you don’t have to type them over and over and over. Well you can set it 

up so when you type the first four characters of that particular text it’ll actually pop it in for you. 

So let me show you a little bit about how AutoText works. 

If you have a lot of text that you insert regularly into multiple documents you can actually set it 

up so that you don’t have to type all that text. Word will actually insert it for you. Using this 

About Us as a good example. What if we put in this paragraph quite often? All I have to do is if I 

have it selected I can go back to Quick Parts and I can choose AutoText. And notice it says Save 

Selection to AutoText Gallery. Here’s where I’m going to tell it what the properties are. So I can 

name it anything I like. I’m going to leave it About Us. I’m going to save it in the AutoText 

Gallery and we’ll leave it in the General category. I can also put in a description and I do want to 

save it in the normal.dotm. And then notice also the options. I can insert the content only or I can 

insert the content in its own paragraph or own page. I’ll say in its own paragraph and click OK. 

Now let me delete this and see if it’s going to work. 

When I want to use this I can go back to Quick Parts, point to AutoText and there it is. All I’ve 

got to do is click on it and it’ll insert the entire thing for me. Notice it’s in it’s own paragraph like 

we had told it we wanted it to be.  

Now I want to show you one more quick thing that’s kind of neat. I’m going to go ahead and 

select this. You might have noticed with a date, for example, if you type the first four characters 

of the month, of the current month actually, it’ll pop open a little yellow box so you can pop it all 

in there. The same thing is going to work here. If I type A-B-O-U notice the little box that 

popped up right above it. If that’s what I want I’m going to hit the Enter key and the entire thing 

pops in there. Isn’t that cool? Now if you didn’t want this you would just keep typing. It would 

go away. So that’s how your Quick Parts actually works. 
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Video: Module 13 Practice Exercise 

Cindy: We are working in module 13 and we’ve been talking in this module about Quick Parts. 

We went through several different features of Quick Parts. We went through the building blocks 

and talked about how to create and edit building blocks. We also went through AutoText and 

talked about how to create AutoText entries and maybe edit those. So let’s take a minute and just 

go back through that and make sure you’re okay with everything we discussed. 

The first thing I want you to do is open a practice file called Module 13 Practice. And insert a 

cover page at the very top of the document there. Once you’ve done that on page two I want you 

to select the heading that says What is Books and Beyond and the following paragraph as well. 

And then I want you to save the selection to the Quick Parts gallery as an AutoText entry. That 

way if you need to use it in the future you don’t have to type that whole paragraph back in. 

Next in the Building Blocks Organizer delete the cover page called Motion. Back in the Building 

Blocks Organizer again I want you to edit the properties of the cover page called Austin to the 

name Austin 2 and just save and close the file and that’s really all you need to do. 

As always you did a great job. Let’s go ahead now and move over to module 14 and talk about 

working with an index and a table of contents. 
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Module 14 – Indexing and Table of Contents 

Video: Creating an Index 

Cindy: Hey there. Welcome back. We have made it all the way down now to module 14 where 

we’re going to talk about creating an index and a table of contents. So this is section 1 where 

we’re going to start off talking about how do you create an index. Now just in case you don’t 

know what an index is you’ve probably seen in the back of a book where it will reference which 

page numbers certain words in your document happen to appear and that’s what we’re going to 

do. So let me show you how to create an index. 

If you notice under the References tab here’s the Index options and we’re basically going to be 

looking at these two buttons, Mark Entry and Insert the Index. The way this works is you’re 

going to go through the document and any time you want a word to appear in the index you’re 

going to mark that word or that group of words. Once you’re finished marking all those words 

you can tell Word to insert the index for you. So here’s some examples.  

Let’s say that this group of words here, Driving directions to Burke, I would like to put in my 

index. So I’m going to select it and mark the entry. Now I can name the entry anything I want 

but I’ll just leave what it pulled in. I want it on the current page and I probably want this bold 

and I’ll go ahead and just hit Mark. And when you mark an entry it automatically turns on your 

non-printing characters for you and inserts these little brackets like you see. So just leave those 

there. 

Let’s say that another word that I’d like to mark is the word Burke and that’s going to appear 

several times. So instead of just selecting the one word I want to make all the entries because 

Burke might be on page 13, it might be on page 11 and I want it to tell me all the pages that it 

happens to appear on. So instead of just selecting that individually what I’m going to do is this. 

I’m going back to the Home tab because here’s where the Find option is. I’m going to have 

Word find all the instances of the word Burke. So you’ll see it’s over here and now they’re all 

selected. See all the yellow ones? So now what I can do is go back to the References tab. I’ll go 

back to Mark Entry. I’m going to leave it Burke. I’ll put it on the current page and I won’t bold it 

this time. I’ll just say Mark and it’s going to mark those for me.  

So again I’m going to close. So now let’s see if there’s one more we can mark. Let’s go ahead 

and mark, I’ll mark each of these, Coming from the North. We’ll mark that one. We’ll mark 

Coming from the South. We’ll mark Coming from the East and we’ll mark the last one, Coming 

from the West.  

So now that I’ve gone through the document and picked all the words that I want to mark and 

obviously in a real life document you’d have a lot more than just these few we did. But when I’m 

finished I want to insert the index. Now typically an index you want it to be on a page all by 

itself and it’s usually the end of your document. So what I’m going to do here is this is the last 

thing in my document. I’m going to come down and create a page break. I’ll do Control-Enter. 

And now on this blank page I’ll insert my index. Here’s a preview of what yours is going to look 
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like based on the choices you choose on this screen. I’m going to right align the page number so 

it just looks a little bit nicer. Here’s the tab leaders. Leaders lead up to a tab. So your choices are 

dots, dashes or a straight line. Typically you’ll see the dots. You can have different formats. 

They have Classic, Fancy, Modern. I’ll just leave from template. And also you want one column 

probably. It tends to default to two columns. So all you have to do when you make your changes 

is click OK and there’s your index. Notice it tells you what page each of these happens to be on. 

It happens to be they’re all on page three. And just notice something else. It put in a continuous 

section break automatically right about the index. So in a real life document, like I said, you 

would want to go through and mark all the words that you’re wanting to pull. So it might take 

you a little bit of time to do that but once you do it’ll pull it perfectly. So that’s how an index 

actually works. 

Why don’t we go ahead now and wrap up this particular section and go over to section 2 and talk 

a little bit about creating a table of contents? 
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Video: Creating a Table of Contents 

Cindy: Welcome back. We’re working in module 14 of Word 2016 and this is where we’re 

talking about creating an index and a table of contents. Now we’ve already talked about creating 

an index. We did that in section 1. Now we’re in section 2 where I want to show you how to 

create a table of contents. 

You can see in this document that these are the driving directions to Burke but it doesn’t really 

stand out as far as the fact that this is a title. There’s also Coming from the North, Coming from 

the South. Again nothing stands out from each other so I can’t really read this very well. So one 

of the things I can do is I can create levels of importance within my document using the Styles. 

I’ll go ahead and select the title and I’m going to use Heading 1. Coming from the North should 

be underneath Heading 1 as a sub item so I’ll use Heading 2 for that one. And I’ll use Heading 2 

for each of these. Coming from the South, I’ve got Coming from the East, Coming from the 

West and notice also there’s a paragraph at the bottom that says Once You’re Nearby. I want that 

to go back and be Heading 1. Now in addition to just being able to read this a little bit better 

based on these styles Word is going to create a table of contents for us.  

Before I create the table of contents I want to go ahead and make this look a little bit nicer. I’m 

going to add a cover page. So I’m going to click on the Insert tab, Cover Page and I’ll just 

choose this one. And of course I can edit the subtitle or anything I’d like here but I’ll leave it for 

now.  

Now I want to put the table of contents on its own page. So what I’m going to do here is I’m 

going to click in front of Driving Directions to Burke and I’m going to go ahead and insert a 

page break. So now you can see that there’s a blank page there. And if you needed to see 

multiple pages at the same time you can click on the View tab and look at Multiple Pages. So see 

how there’s my cover page, page two is blank right now and then page three is my driving 

directions to Burke.  

So I’m going to click on page two here and now we’re going to insert our table of contents. 

You’re going to do this by going to the References tab and choosing Table of Contents. You can 

pick any of these different formats that you like. Remember these are actually called Building 

Blocks. I’ll use Automatic Table 1. And now you’ll see there is my table of contents. 

You can see that all of my information is on page 2. Now notice when I click in here I can 

always update the table. So let’s say that I move something to page three. We’ll move Once 

You’re Nearby. So I’ll come down here to the bottom and I’m going to click in front of Once 

You’re Nearby and I’m going to put a page break in. I’ll use Control-Enter this time. But you can 

see now that it’s on the fourth page. So let’s go up and look at this and see what it says. Now see 

how it isn’t automatically updated? That’s because I need to update the table. When you update 

the table you can update just the page numbers or the entire table because sometimes you might 

change the text or maybe change the style you used. I’ll update the page numbers and now you’ll 

see it’s on page three. Now the only reason that it looks like it’s on page four here is because 

page one is a cover page and there’s no formatting for that particular page as far as the page 
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numbers go. And it did that automatically because there is a section break in there. But you can 

see how you can always update your page numbers just by updating the table. 

Notice over here there’s a down arrow and here’s where again you can change the style if you 

want. So if I decided I’d rather have this one then it just changes it automatically. So that’s a 

quick overview of how a table of contents work. 

You do not have to put it on a separate page like I did but it does look a lot nicer. And usually 

it’s the second page if you have a cover page. So just kind of know that. 

What I want to do now is go ahead and have you go over to the third section here which is the 

practice exercise and I’m going to see if you can put in a table of contents and an index for me. 

I’ll see you shortly. 
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Video: Module 14 Practice Exercise 

Cindy: We’re all the way down now to the practice exercise for module 14. We’ve been talking 

in this particular module about creating a table of contents and also an index and I want to just 

make sure that you’re okay with how to put one of each in your document. 

Here’s what I want you to do for me. Go ahead and open the practice file called Module 14 

Practice. And to start with insert a cover page at the very top of the document. It’s going to have 

a default title in there, just type over it, and use the title Books and Beyond.  

Next I want you to use the Styles to go ahead and create the levels of importance within your 

document so that when we actually pull the table of contents it knows what’s the title and what’s 

the subheading and so forth. So using Styles make the title style called Heading 1 and all the 

others Heading 2. 

The next thing I want you to do is add page numbers to the bottom of each page. I want you to 

center the page number and don’t show the page number on page one. Remember it looks not as 

professional as it should if you have a page number on page one.  

The next thing we’re going to do is create a table of contents and we’re going to put that on page 

two. Remember that when you put the table of contents on a page you want it on a page all by 

itself. So you may have to insert a page break once you get that table of contents in to make that 

happen. When you put it in go ahead and right align the numbers and again make sure it’s on a 

page all by itself. 

Next we’re going to go ahead and mark some of our words so that we can pull an index. I want 

you to find all the instances of the words Books & Beyond and then mark all the instances of the 

words CD’s and Tapes. In this case use the word And. Then go ahead and create your index at 

the end of the document. Make sure to right align the page numbers and use one column. When 

you’re done go ahead and save and close the file for me. 

You did an awesome job, as usual, again. Let’s go ahead now and move over into module 15 

where we’re going to talk about reviewing and printing your document. 
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Module 15 – Review and Printing 

Video: Using the Thesaurus 

Cindy: Okay. Welcome back. We are starting module 15 of Microsoft Word 2016 and this is 

where we’re actually going to talk a lot about reviewing our document and making some changes 

before we actually go through and print. Now this is the first section where I want to show you 

real quick how to use the built in thesaurus that Microsoft Word has. 

If you’re not familiar with what a thesaurus is, basically a thesaurus will actually look up 

synonyms for words that you have selected. A good example is this word Customized here. I’ll 

just double click it. Now I can right click in the highlighted area and notice that Synonyms is on 

the list. So if I wanted one of these words I could certainly just choose it and it would change 

Customized to this word. But here’s the thesaurus down here at the bottom. 

Notice it appears over on the right hand side. And again it has synonyms for the word that I have 

selected. Let’s say I want to use this word Tailored. What I’ll do is click the arrow to the right 

and Insert and notice it replaced Customized with the word Tailored. And that’s pretty much all 

there is to the thesaurus. Now if you didn’t right click to get to it just know that you could also 

go up under the tab that says Review and it’s right next to Spell Check right here. And it’ll bring 

up this window right over here. So that’s how the thesaurus works.  

The next thing I want to do is go through spell check with you. So let’s go on over to section 2 

and we’ll check our document for spelling errors. 
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Video: Spell Check 

Cindy: We’re working in Word 2016. We’re on module 15 now where we’re reviewing and 

printing our document. We’re on section 2 now where I want to go through this Spell Check 

feature with you. Now we’ve briefly been looking at spell check all throughout these videos. If 

we see a word that’s underlined then it thinks it’s misspelled and we can right click on the word 

and pick the proper spelling. But I want to walk through the whole procedure with you because 

you’ll see there’s a few more things it’ll do other than just that. So hold on a second and let’s flip 

over to our exercise. 

You can see in this document that we have quite a few words that are underlined in red and that 

means there is a spelling error. Now remember that if a word is not in the dictionary then Word 

will tell you it’s misspelled. And sometimes it’s something like a name where it’s really not 

misspelled so you can just ignore those if you want or you’ll have some choices to actually hide 

that. I want to show you how to run through the entire spell check procedure where it will check 

for duplicate words, misspellings, it’ll check for grammar errors, things like that. 

You’re going to start at the very beginning of your document and you want to go to the Review 

tab at the top. Under the Review tab the very first button says Spelling & Grammar and it’s 

going to pop up on the right hand side like you see here. Now what it’s going to do is each time 

it thinks there’s an error it’s going to stop and give you a choice to ignore that error, ignore all or 

add. Be careful about adding all of the words you misspell to the dictionary. So if it’s something 

you misspell all the time the same way you might want to add it but if it’s a one-time thing don’t 

add it to the dictionary.  

This is a list of words it thinks that I might be trying to spell. And if I want that word I would 

choose it and choose Change. Now on this particular case it found the word Leeham and this is 

obviously Gina’s last name so we’re going to ignore that. And notice that it came up with 

Leeham again. So I’m going to ignore it again or I could say Ignore All and it won’t stop on 

Leeham again. The next thing that came up is a duplicate word. So you’ll see the word The is in 

there two times. I can actually come over here and just delete it. Now I see the word Customized. 

It is spelled wrong so I see that the correct suggestion is here. I’ll choose that and hit Change. 

Next is the word Strive. Same thing. I’ll select it and I’ll hit Change. And now it’s on LaPierre 

which is someone’s name so I’m going to go ahead and ignore that.  

Now the next thing that came up is Enc. It doesn’t like that. It considers it a spelling error. It 

might also consider it a grammar error in some cases. You can do a couple different things. If 

you wanted the period after Enc, notice you can click out in your document and you can actually 

change it and then you can resume your spell check right over here. And when you’re finished it 

will tell you that spelling and grammar check is complete.  

That’s really all there is to spell check. But make sure you run it even if you think you’ve gone 

through and manually right clicked on all the words that are misspelled. You still want to run this 

so it gets all the grammar errors and it gets duplicate words and things like that. 
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So let’s go ahead and go now over into section 3 and I’ll show you how to use comments in 

Microsoft Word. 
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Video: Comments 

Cindy: Hey. Welcome back. We’re still working in module 15 of Microsoft Word 2016. We’re 

actually all the way down now to section 3 where we’re going to talk briefly about comments. 

Comments are used mainly for collaboration purposes. So if you share this document with 

someone else, maybe you need to make some notes in certain areas of the document and that way 

someone else can actually see the notes and comment back and that sort of thing. So let me show 

you how this works. 

The first thing you want to do when you want to insert a comment is go ahead and select the text 

that you want to comment on. Now the easiest way to insert a comment is go to the Insert tab and 

you’ll see Comments right over here. And basically when I click on Comment it opens up this 

area on the right so that I can actually put a comment in. So I may say something in this case 

like, This section should talk about our services. Now all I have to do when I’m finished is go 

ahead and hit the Enter key or click away from it and that comment is now here. Now when I’m 

sharing this with someone if they see the comment then they can click Reply right here and then 

they can put a reply down here at the bottom like this.  

Now let me show you where to go if you want to edit the comment and that sort of thing. The 

Insert tab only has the option to insert a comment. If you go to the Review tab you have a whole 

Comment section like this. Here’s another way to put in a new comment and here’s a way to 

delete that comment. So I can either choose delete here or notice if I right click over here I can 

actually choose Delete from the list here as well. See how you can delete the comment? 

Now also I have the ability to go to the next or previous comment. So if I have multiple 

comments in here I can do that. And also I can Ink the comment. So what that basically means 

here is notice that it opened up this area that looks like it has some lines on it for me to type on? 

Well actually I can use my mouse and write something if I want like this. They call that Inking. 

It takes a little practice there. Okay?  

So I can also resolve the comment. So when I’m finished I’ll just click Resolve at the bottom 

there and that means that I’m finished with that comment. Now if I need to reopen this comment 

for some reason I can click Reopen and you can see it opens it back up and I can reply or 

whatever I’d like to do with it. So that’s pretty much how comments work. 

You do have the ability if you want to get out of this to turn off the Show Comments option here 

and that way you don’t see the actual comments but you do see the comment indicator over on 

the right. And you can actually click there if you want and see the comments. And if you don’t 

want them you can close it with the X. So comments are pretty useful when you’re collaborating 

with others on a document. 

Let’s go ahead and wrap up this particular section and let’s go over to section 4 and talk about 

margins. 
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Video: Margins 

Cindy: Okay we’re working in module 15 where we’re reviewing our document before we go 

through and print it. And I wanted to talk here in section 4 about working with margins. Now 

we’ve touched a little bit on margins throughout these videos but I wanted to go ahead and just 

walk through each of the margin options with you so you’ll know what’s available. 

Normally when you’re working in Microsoft Word you’ve got some preset margins. They are 

one inch top and bottom and one inch left and right. Now you’ll know that because when you 

look at the ruler it will go to 6-1/2 inches. The only reason this one goes to 6 is because this is 

another exercise where the margins have been previously changed, but normally it’s 6-1/2 

because you have paper that’s 8-1/2 inches across and the one inch allows for the margin on each 

side there. 

Now a quick way if you wanted to change a top or bottom margin would be if you noticed the 

ruler on the left and you can see the one that lines up directly and even with the top of the page 

there. I can actually put my mouse where the gray and white meet on the ruler and then I can 

drag up or down to change that margin. That’s a really good way if you have one line or two 

lines that print on the second page and you’re trying to fit it all on one page you can get it to fit 

that way. Remember that you’re changing that margin for all the pages in the document. So if 

you don’t want to do that make sure you section it. 

Now what if you wanted to manually change the margins? You have a preset number in mind 

you want to change them to. Here’s where you’re going to find the margin options. You’re going 

to go to the Layout tab and first notice there’s a Margin option here. They have some 

predesigned margins setup for you. So if you decided you wanted any of these then you can 

certainly just choose the one you like. When you go down to the Custom Margins and you click 

this very bottom option here it actually takes you into what we call the Page Setup. You would 

have gotten to the same place if you’d clicked this arrow on the bottom right of the Page Setup 

grouping.  

Here’s where it shows you your current margins. You have top, bottom, left, right, and a header 

and footer. Header and footer margins they happen to have moved these to the Layout tab and 

you’ll see those right here. Now every page has six margins. You have top, bottom, left, right, 

and header and footer. Header and footer margins should be less than top and bottom. If they’re 

more they’ll print in the printed page.  

Now I’m going to go back to the Margins here because I wanted to point out also this gutter area 

and the gutter position. Whenever you have books that have a spiral binder in the middle or even 

if they’re just bound in the middle you want to actually have the margin start from the edge of 

the binding instead of the edge of the page. So when you buy those spiral binders at your office 

supply store they come in different sizes, ½ inch, ¼ inch and that’s what you would put here and 

then the margin would start let’s say ¼ of an inch over. The gutter can be on the left or it can be 

on the top because sometimes books flip up.  
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So here’s where you just change the margins to whatever numbers you want and then your gutter 

areas like we just mentioned. And that’s really all there is to margins. I’m going to go ahead and 

click OK here and I want to go ahead and finish talking about those page setup options we just 

saw. So let’s go over to section 5 and we’ll finish going through those. 
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Video: Page Setup Options 

Cindy: We are working in Microsoft Word 2016. We’re in module 15 where we’re reviewing 

our document before we go down to the print option. Now I want to talk real quick about the 

Page Setup options because there’s some different things you can do to make it fit on one page 

and things like that. So I want to show you what all those options are real quick. 

Before you print your document you’ll want to run through the Page Setup options and see if 

there’s anything in there that you missed. We’ve seen a lot of these already when we talked 

about margins and a couple of other things but let’s run through all of these.  

You’re going to find the Page Setup options under the Layout tab and there’s a grouping called 

Page Setup. Now we’ve already talked about margins. So this is where you can change the 

margins. Here’s your Orientation, Portrait or Landscape. Here’s your Paper Size. So normally 

it’s set at 8-1/2 x 11 but if you have some legal size paper or some odd size paper you can pick it 

from the list or you can go to More Paper Sizes and see if it’s in that list as well. We’ve talked a 

little bit about Columns. So you know this is where you set your columns. We’ve talked a little 

bit about page breaks. We’ve talked about section breaks. All those breaks are right there. And 

then line numbers. We haven’t mentioned these but you have the ability, if you want, to go ahead 

and number your lines. Also the hyphenation. So we talked about the fact that when you have a 

word that is too long to fit on a line Word will move it to the next line for you automatically. 

You can have it hyphenate your words if you’d like. 

Now I’m going to click the arrow on the bottom right of the Page Setup grouping and the first 

thing we see are the margins. So you’re familiar with the margins. We’ve gone through that 

already. Here’s your Portrait and Landscape. And here where it says Pages, normally it’s set on 

the word Normal but you can have what they call Mirror Margins. Mirror margins means that if 

the left side of the page has 2 inches on the left and 1 inch on the right then the right side will 

actually have the opposite. You can also have two pages per sheet or what they call Book Fold. 

Under the Paper tab you’re going to see this is again where you can change the paper size if 

you’d like. And you can also if you happen to be working with multiple trays you can see that if 

they were available you’d have them listed here.  

And then the Layout tab, this lets you start a new section. Now if you’re in a section that has a 

new page section break then it’ll say New Page. But here are the different section breaks that we 

talked about. There’s the continuous one, for example.  

Here’s your headers and footers. So you have different odd and even, we talked about that. Also 

you can have a different first page. And that’s where it takes the header and footer off of the first 

page. Here’s your header and footer margin options that we talked about.  

And here’s your vertical alignment. So typically you type from the top of the paper down. This 

would let you start dead set in the center, what they call Justify or down at the bottom if you’d 

like. And that’s a quick overview of all your page setup options. 
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Anything you choose in here if you do set as default then you’ll automatically have those settings 

when you create a new blank document.  

So I’m going to click OK and that was a quick rundown of your page setup options. Let’s go 

ahead and talk about printing over in section 6 and then we’ll wrap up module 15. 
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Video: Printing 

Cindy: Okay so we’re all the way down to the bottom of module 15. We’ve been talking about 

reviewing our document and then printing it. So now we’re getting ready to print it. So this is 

section 6 where we’re talking about printing. 

The quick way to print your document if you just need one copy, no questions asked is to go 

ahead and use this Print icon that’s right here on your Quick Access Toolbar. Now remember if 

you don’t have that go over to these arrows here and remember you can customize it and you’ll 

be choosing Quick Print. Also notice there is a Print Preview and Print option here as well.  

Now if you needed some options when you’re printing like multiple copies or you want to tell it 

which printer to print to then you’re going to want to use the File tab and go down to the Print 

option here. So let’s start from the bottom and work our way up. 

First of all on the right I want you to notice that this is your Print Preview and you’ll see on the 

very bottom you can go back and forth between the pages by using these arrows. Here it says 

One page per sheet. My choices would be to print all the way up to 16 pages per sheet. I also can 

set the margins here and we’ve talked about this. So if I don’t like any of the default margins I 

choose Custom Margins and choose my own. Here’s my portrait or landscape. Now here’s 

something new, Collated. And collated basically means if you have multiple pages in your 

document and you want to print multiple copies it will print all of the pages for copy one, all the 

pages for copy two and so forth.  

I’m also going to print all the pages right now. My choices from the down arrow are to print just 

the selection if I had something selected. I could print the current page or a custom print where I 

type specific pages. Now what that means is right here if I wanted to say pages one and three I 

would type 1, comma, 3 like this. If I wanted one through three I would type 1, hyphen, 3 like 

that. But I can specify the pages. 

Here is where you tell it which printer you’d like to print to. Here is where you tell it how many 

copies you’d like. And then all you have to do when you’re done is hit Print and it should print 

out, no questions. 

So that’s really all you have to do when you’re printing. You decide if you need one copy or you 

need to come in and look at all the different options. 

So I’m going to hit the Back arrow and go back to my document and that’s going to wrap up 

module 15, Review and Printing. Now I do have a quick little practice exercise I’m going to have 

you do. It’s not hard at all. So if you go ahead and go over to section 7 then we’ll go ahead and 

get you started. 
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Video: Module 15 Practice Exercise 

Cindy: Welcome back. We’re working in module 15 where we’ve been talking in this module 

about how to review and then some print options for your document. So we actually talked in 

this particular module a little bit about spell check, about how to change your margins, some of 

your page setup options, and actually printing. So let’s go back and review a few of those and 

make sure you’re okay with everything we talked about. 

The first thing I want you to do is open the file called Module 15 Practice. And go ahead and run 

your spell check just to make sure you caught all the spelling and grammar errors. Next we’re 

going to change the margins on the left and right to 0.25 each. In the Page Setup options change 

the bottom margin to 0.5. And then go ahead and preview the document to make sure it looks 

okay.  

Make sure to check all of the options in the Print window to make sure they’re set correctly for 

you and then go ahead and print the document. If you can’t print that’s okay. As long as you 

know how to do it then that’s all we’re looking for here. And then go ahead and save and close 

the file and you are done. 

So good job again. You’re really good. We’re going to move on down to module 16 now and 

talk about some other features that Word has. 
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Module 16 – Other Word Features 

Video: Word Options 

Cindy: We’ve made it all the way down to module 16 now where we’re going to talk about 

some of the other features that Word has. Now this is the first section where I want to go through 

the Word options and just point a few out to you that you probably should just be somewhat 

familiar with. 

The way we’re going to get to the Options in Word is we’re going to click on the File tab and 

then we’re going to come down to Options. Now I’m not going to go through every single one of 

these categories on the left. You can go through some of those on your own, but let me just point 

out some of the ones that you’ll probably be most interested in.  

We’re under the General category here on the left and I want to point out the Show Mini Toolbar 

on Selection. You might have noticed that as we went through if we selected something a mini 

toolbar appeared right above our selection. It had a lot of the same options that our Ribbon had. 

You can turn that off if you don’t like it. It’s just there so you don’t have to take your mouse and 

move all the way to the top of the screen if you want to choose one of those options. 

Also just notice the Enable Live Preview. If you remember a good example is when we decided 

to change our fonts. We could actually just move the mouse over the font option without clicking 

on it and it would show us what it would look like if we made that choice. That’s called Live 

Preview. 

Let me go over to Display here and a couple things here just to be aware of.  

We talked a lot about working with the non-printing characters. So if you had the Tab key or the 

Enter key or a paragraph marker you could see those if you turned on the non-printing 

characters. But you’ll notice here that if you always want to see one of these then you just turn it 

on here.  

Going over to the Proofing option. A couple things I want you just to notice. Here’s your 

AutoCorrect option. So we had talked a little bit about that in a previous module. And also I want 

you to notice here are the spelling options in Word. So when you get through and you run your 

spell check then a lot of these will apply as you go through.  

Under the Save option here, notice that it’s going to save my Word files as a .docx and you 

probably want to leave it there but you could pick one of these other options if you want to. Also 

it’s going to auto recover your information every one minute. So if you don’t want it every one 

minute you might change it to every ten minutes.  

Some other things to notice. If I go down to the Advanced option here there’s several things you 

can look at as you’re going through this way. You can see that Word will actually select an entire 

word when you click in there. You can see a lot of different options here as well.  
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And then you can customize the Ribbon. And I wanted to just point this out real quick. There is 

an option for everything in Word. There’s a button for it. But you obviously couldn’t put all that 

on the screen at once because you would have nowhere to type. So if there’s a particular 

command you want to use look for it over here on the left. Currently it’s showing the popular 

commands. Notice I can show all the commands. And if I’m doing that you’ll see they’re all 

listed in alphabetical order. So if you see one you’d like to add all you have to do is select it over 

on the left and then whatever tab you happen to be clicked on here and see the plus sign, that’s 

going to show you all of the groups on that tab. Whichever one you’re clicked on you can add 

this button to that particular tab and grouping. That’s all that is. 

So go ahead and just look through those options on your own and just see if there’s some that 

you might want to change after you get more familiar with Word. I just wanted you to know 

where the options were. I’m going to click OK here now and let’s go ahead and go over into the 

next section and talk briefly about how to protect your document. 
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Video: Protecting a Document 

Cindy: Hey there. Welcome back. We’re in module 16 and we’re talking about the other 

features that Word has. We’re all the way down to section 2 now and we’re going to talk about 

how to protect a document. 

It might be that you share a document with others. You might want others to be able to open it 

but maybe not make any changes to the document. So let me show you how to go ahead and set 

up a document so that you have a password and you can protect the document. 

To get to the protection option you’re going to go to the File tab and you’re going to click on the 

Save As option and you’ll want to Browse. Now what you want to do is make sure that you have 

the document that you’re wanting to create a password for and down at the bottom here you’ll 

see Tools. One of your options says General Options. Here you can set a password to open and a 

password to modify. The top password is good if you want to actually send this to someone 

they’re not going to be able to open the file or even see what’s in it until they type the password 

in. The second one for file sharing, I can share this with someone and they can see it but they 

can’t open it and edit it without using the password. So I’m going to go ahead and click OK here 

and it does prompt you to reenter your password. Now I’m going to go ahead and save it.  

So let me go ahead and close the file and I’ll show you how this works. I’ll go ahead and click on 

the File tab. I’ll go back to Open, go ahead and browse and find my file here. It was this one, 

Protecting Documents. And now you see it asks for the password. So I’ll go ahead and type that 

in, I’ll click OK and then it’ll prompt me again to type in the password and I’ll click OK and 

there it is. So that’s all you have to do if you want to protect your document. Just make sure you 

have a password and remember what the password is, especially if you share it with someone 

else. 

Let’s go ahead and move over now to section 3 and talk very quickly about macros before we 

wrap everything up. 
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Video: Macros 

Cindy: We’re working in module 16 and we’re talking in this module about other features that 

Word has. This is section 3 where we’re going to briefly talk about macros.  

You know macro is a term that’s used often by people. Everyone wants to know how to create a 

macro but they really don’t know what a macro is. And just to explain it very simply, if you have 

some sort of repetitive task that you need to do you can actually turn on a recorder, give your 

macro a name and it will record all of your keystrokes. It will not record the time it takes to do 

something. So basically you go through and you actually do whatever that function is and when 

you’re finished you turn off the recorder and you have a macro. So let me show you how to 

actually create one. 

Let’s say that there’s a particular header and footer that you like to put in very frequently on 

different documents. Instead of actually going through the whole process of typing all the header 

and footer information in you can set it up as a macro and use it whenever you like. Here’s how 

you’re going to do that. Remember you have to go through the process once and it’s going to 

record it. 

What you’re going to do is go to the tab that says View and here’s where the macros are. I 

wanted to show you real quick that if you just click on View the Macros here this is going to list 

all of your macros. And if you wanted to run one of these you would click on it and choose Run. 

But we don’t have one set up yet so. What we’re going to do is go to Macros and Record Macro. 

Now when you record a macro you have to give it a name. I’m going to call it 

MyHeaderandFooter. No spaces in macro names. You can assign a button or a keyboard shortcut 

and you can also store these in all documents or just in what we call the standard styles of 

normal. We’ll just put it in all documents. You have a description if you want but what you’re 

going to do now is you’re going to click OK and now it’s going to start recording. Now it’s not 

going to record the time it takes you to do something, only what you actually do. So let’s go 

through the process of putting in a very quick header and footer. 

We’re going to go to the Insert tab, we’re going to come over to Header and let’s go and put in 

this one. Just put a blank one in. So we’ll put in the company name and then what we’ll do is 

we’ll say over on the right that we want to put in today’s date. So what we’ll do here is we’ll go 

to the Date & Time option and we’ll pick the current date and make sure it says Update 

Automatically and click OK. Now let’s go down to the footer and let’s say that we want to put in 

the page number at the bottom of the page and we’ll just pick this one. And let’s just say that’s 

all we want to do. 

Now one thing to remember is when you’re totally finished you want to make sure if you’re 

doing a header and footer that you close the header and footer because often what happens if 

people think they’re done and they turn off the macro at this point and that’s where it’s going to 

stop when you insert it. So I’m going to close the header and footer. And you actually did put it 

in but it also recorded it. 
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So if I go down to the bottom and look you’ll notice there’s this little square down here and it 

tells you that a macro is currently recording, click to stop. That’s how you’re going to stop it. 

And now there it is. Now let me show you where that macro is now. 

If we go back to View, go to Macros and view the macros there’s your macro. So whenever you 

want to run it you’re just going to click Run over on the right and it’s going to insert it. Now it 

put it in twice because I already had it in here but you saw how quick it did it. So let me go ahead 

and undo that. I want to take those headers and footers out that I just put in there. I’ll just actually 

do this and I’ll go down to close that and let me see if we can take the footer out. Go down to the 

bottom and remove that. Boom. Okay. So now there’s no header or footer. 

So let’s say I’m in a document and I want to insert them. I’m going to actually go up to the View 

tab, Macros, look at a list of my macros, that’s under View, click the one I want and I’m going to 

run. And you can see how quick it did it. Just like that. Now obviously I’d want to take that out 

when I actually create my macro but you can see that, you get the idea. 

Now you can create as many macros as you need to. And one thing that you’ll learn about in a 

really advanced feature of Word is that in addition to picking your macro from this list you can 

actually create a button on one of your ribbons that you create and it can say Macros and you can 

click on it and run your macro that way. 

So that’s a quick overview of how your macros work. 

Well that’s going to wrap up these Microsoft Word videos. I do want you to go over to module 

17 real quick. I have a quick wrap up video where I want to thank you for just spending your 

time with me. And I will see you shortly. 
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Module 17 – Wrap Up 

Video: Closing Video 

Cindy: Well you made it all the way to the end of these Microsoft Word videos for Word 2016. 

You know you have to go back and practice some of this stuff because if you don’t practice you 

will forget it. And I know we don’t have a lot of time for that but if you need to go back through 

any of these videos feel free to do that. If you need to ask us anything feel free to shoot us an 

email. We’re always here to help.  

This is Cindy and I’m going to go ahead and wrap everything up now. Thank you so much for 

joining me and I will see you again on another set of videos. 

http://www.simonsezit.com/

